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Using the Edit Page
In this chapter, you’ll learn how to use and configure the Edit page user interface to prepare for 
editing projects in DaVinci Resolve. For more information on how to use the Edit page to import 
and conform projects edited in other applications for color correction and finishing in DaVinci 
Resolve, see Chapter 34, “Conforming and Relinking Clips.”

This chapter covers the following topics:

The Edit Page User Interface	 271

The Interface Toolbar	 271

The Media Pool	 272

Importing Media Into the Media Pool on the Edit Page	 272

Bins, Power Bins, and Smart Bins	 273

Showing Bins in Separate Windows	 273

Filtering Bins Using Color Tags	 274

Sorting the Bin List	 275

Searching for Content in the Media Pool	 276

Taking Advantage of the Media Pool’s Usage Column	 276

More About Timelines and Grading	 276

Timelines, Grades, and Versions	 276

Enabling the Use of a Master Timeline	 277

Using the Effects Library	 278

The Toolbox	 279

OpenFX	 279

AudioFX	 279

Effects Library Favorites	 280

Edit Index	 280

Navigating The Timeline Using the Edit Index	 281

Edit Index Columns	 281

Filtering the Edit Index	 282

Exporting the Edit Index	 283

Source and Timeline Viewers	 283

How Each Clip’s Grade Looks in Each Viewer	 284

Source and Timeline Viewers vs. Single Viewer Mode	 284

Viewer Controls	 284

Simultaneous Audio Waveform Display in the Source Viewer	 287

Cinema Viewer Mode	 287

Viewer Indicators	 287

Other Viewer Options	 288

Opening Clips in the Source Viewer	 288

Timeline Viewer Edit Overlays	 289
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Inspector	 291

Timeline	 291

Timeline Options	 293

Switching Among Multiple Timelines	 295

Toolbar	 295

Toolbar Audio Monitoring Controls	 297

The Clip and Track Mixer	 297

Using Video Scopes	 298

Navigating the Edit Page Using the Keyboard	 299

Dual Monitor Layout	 299

Customizing the Edit Page	 300

Undo and Redo in the Edit Page	 301



271

U
si

ng
 t

he
 E

d
it 

P
ag

e
 

P
ar

t 
3 

–
 1

4

The Edit Page User Interface
The Edit page has evolved into a source-record style NLE that contains nearly every editorial 
tool you need for creative editing through finishing. The Edit page is divided into three main 
regions: the browsers found at the left, the Viewers at the top, and the Timeline at the bottom, 
all of which work together to let you import, edit, and trim timelines with a flexible variety of 
tools and methods.

The Edit Page in its entirety

The Interface Toolbar
At the very top of the Edit page is a toolbar with buttons that let you show and hide different 
parts of the user interface. These buttons are as follows, from left to right:

The Interface toolbar

�� Media Pool/Effects Library/Edit Index height button: Lets you set the area used by the 
Media Pool, Effects Library, and/or Edit Index to take up the full height of your display 
(you can display two at a time), giving you more area for browsing at the expense of a 
narrower timeline. At half height, the Media Pool/Effects Library/Edit Index are restricted 
to the top of the UI (you can only show one at a time), and the timeline takes up the full 
width of your display.

�� Effects Library: Opens or hides the repository of all transitions, generators, OpenFX, 
and audio filters available to use in the Edit page.

�� Edit Index: Opens or hides the list of all edit events in enabled tracks of the Timeline.

�� Metadata: Hides or shows the Metadata Editor.

�� Inspector: Shows or hides the Inspector, which shows you the transform and 
compositing effects of selected clips, or the editable options of selected effects such 
as transitions or generators.
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The Media Pool
In the Edit page, the Media Pool contains all of the media you’ve imported for editing into the 
project at hand, as well as all of the timelines that you’re going to be editing into. The Media 
Pool is also mirrored on the Media and Fairlight pages, so you can access any clip or timeline 
from any page where they can be used. 

The Bin list at the left shows a hierarchical list of bins used for organizing your media, which is 
also used to organize your timelines. By default, the Media Pool consists of a single bin, named 
“Master,” but you can add more bins as necessary to organize timelines and clips by right-
clicking anywhere in the empty area of the Media Pool and choosing Add Bin. You can rename 
any custom bin by double-clicking on its name and typing a new one, or by right-clicking a bin’s 
name and choosing Rename Bin. The Bin list can be hidden or shown via the button at the 
upper left-hand corner of the Edit page toolbar.

The Media Pool in Thumbnail mode, shown in half-height mode

The browser area to the right shows the contents of the currently selected folder. Every timeline 
you create, and every AAF, XML, or EDL file you import, appears here. You can create or import 
as many timelines as you need within a single project.

As in the Media page, the Media Pool can be displayed in either Icon or List view. In List view, 
you can sort the contents by any one of a subset of the total metadata that’s available in the 
Metadata Editor of the Media page. Of particular interest to editors are columns for Name, Reel 
Name, different timecode streams, Description, Comments, Keyword, Shot, Scene, Take, Angle, 
Circled, Start KeyKode, Flags, Usage, Resolution, and Frames Per Second.

For more information on using the myriad features of the Media Pool, see Chapter 8, “Adding 
and Organizing Media with the Media Pool.” In the sections that follow, some key features of the 
Media Pool are summarized for your convenience.

Importing Media Into the Media Pool on the Edit Page
While adding clips to the Media Pool in the Media page provides the most organizational 
flexibility and features, if you find yourself in the Edit or Fairlight page and you need to quickly 
import a few clips for immediate use, you can do so in a couple of different ways.
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To add media by dragging one or more clips from the Finder to the Edit page Media Pool 
(macOS only):

1	 Select one or more clips in the Finder.

2	 Drag those clips into the Media Pool of DaVinci Resolve or to a bin in the Bin list.

Those clips are added to the Media Pool of your project.

To use the Import Media command in the Edit page Media Pool:

1	 With the Edit page open, right-click anywhere in the Media Pool, and choose 
Import Media.

2	 Use the Import dialog to select one or more clips to import, and click Open.

Those clips are added to the Media Pool of your project.

For more information on using the myriad features of the Media Pool, see Chapter 8, “Adding 
and Organizing Media with the Media Pool.” Below, some key features of the Media Pool are 
summarized for your convenience.

Bins, Power Bins, and Smart Bins
There are actually three kinds of bins in the Media Pool, and each appears in its own section of 
the Bin list. The Power Bin and Smart Bin areas of the Bin list can be shown or hidden using 
commands in the View menu (View > Show Smart Bins, View > Show Power Bins). Here are the 
differences between the different kinds of bins:

�� Bins: Simple, manually populated bins. Drag and drop anything you like into a bin, 
and that’s where it lives, until you decide to move it to another bin. Bins may be 
hierarchically organized, so you can create a Russian dolls nest of bins if you like. 
Creating new bins is as easy as right-clicking within the bin list and choosing Add Bin 
from the contextual menu.

�� Power Bins: Hidden by default. These are also manually populated bins, but these 
bins are shared among all of the projects in your current database, making them ideal 
for shared title generators, graphics movies and stills, sound effects library files, music 
files, and other media that you want to be able to quickly and easily access from any 
project. To create a new Power Bin, show the Power Bins area of the Bin list, then right-
click within it and choose Add Bin.

�� Smart Bins: These are procedurally populated bins, meaning that custom rules 
employing metadata are used to dynamically filter the contents of the Media Pool 
whenever you select a Smart Bin. This makes Smart Bins fast ways of organizing the 
contents of projects for which you (or an assistant) has taken the time to add metadata 
to your clips using the Metadata Editor, adding Scene, Shot, and Take information, 
keywords, comments and description text, and myriad other pieces of information to 
make it faster to find what you’re looking for when you need it. To create a new Smart 
Bin, show the Smart Bin area of the Bin list (if necessary), then right-click within it and 
choose Add Smart Bin. A dialog appears in which you can edit the name of that bin and 
the rules it uses to filter clips, and click Create Smart Bin.

Showing Bins in Separate Windows
If you right-click a bin in the Bin List, you can choose “Open As New Window” to open that bin 
into its own window. Each window is its own Media Pool, complete with its own Bin List, Power 
Bins and Smart Bins lists, and display controls. 

This is most useful when you have two displays connected to your workstation, as you can drag 
these separate bins to the second display while DaVinci Resolve is in single screen mode. If you 
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hide the Bin list, not only do you get more room for clips, but you also prevent accidentally 
switching bins if you really want to only view a particular bin’s contents in that window. You can 
as many additional Bin windows open as you care to, in addition to the main Media Pool that’s 
docked in the primary window interface.

Media Pool bins opened as new windows

Filtering Bins Using Color Tags
If you’re working on a project that has a lot of bins, you can apply color tags to identify particular 
bins with one of eight colors. Tagging bins is as easy as right-clicking any bin and choosing the 
color you want from the Color Tag submenu.

For example, you can identify the bins that have clips you’re using most frequently with a red 
tag. A bin’s color tag then appears as a colored background behind that bin’s name.

Using Color Tags to identify bins
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Once you’ve tagged one or more Media Pool bins, you can use the Color Tag Filter pop-up 
menu (the pop-up control to the right of the Bin List button) to filter out all but a single 
color of bin.

Using Color Tag filtering to isolate the red bins

To go back to seeing all available bins, choose Show All from the Color Tag Filter pop-up.

Sorting the Bin List
The Bin list (and Smart Bin list) of the Media Pool can be sorted by Bin Name, Date Created, or 
Date Modified, in either ascending or descending order. Simply right-click anywhere within the 
Bin list and choose the options you want from the Sort by submenu of the contextual menu.

You can also choose User Sort from the same contextual menu, which lets you manually drag all 
bins in the Bin list to be in whatever order you like. As you drag bins in this mode, an orange line 
indicates the new position that bin will occupy when dropped.

Dragging a bin to a new position 
in the Bin list in User Sort mode
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If you use User Sort in the Bin list to rearrange your bins manually, you can switch back and 
forth between any of the other sorting methods (Name, Date Created, Date Modified) and User 
Sort and your manual User Sort order will be remembered, making it easy to use whatever 
method of bin sorting is most useful at the time, without losing your customized bin 
organization.

Searching for Content in the Media Pool
An optional Search field can be opened at the top of the Media Pool that lets you quickly find 
clips by name, partial name, or any of a wide variety of Media Pool metadata. 

To search for a clip by name:

1	 Select which bin or bins you want to search.

2	 Click the magnifying glass button at the upper right-hand corner of the Media Pool.

3	 Choose the particular column of information you want to search (or All Fields to search 
all columns) using the Filter by pop-up menu. Only selected bins will be searched.

4	 Type your search string into the Search field that appears. A few letters should be 
enough to isolate only those clips that have that character string within their name. 
To show all clips again, click the cancel button at the right of the search field.

Taking Advantage of the Media Pool’s Usage Column
In List view, the Usage column does not automatically update to show how many times a 
particular clip has been used. However, you can manually update this metadata by right-clicking 
within the Media Pool and choosing Update Usage Data from the contextual menu that 
appears. Afterwards, each clip will display how many times it’s been used in this column. Clips 
that have not been used yet display an x.

More About Timelines and Grading
DaVinci Resolve projects contain one or more edited timelines (sometimes called a sequence in 
other applications) which are also organized in the Media Pool, and displayed in the Timeline 
Editor (referred to as “the Timeline”). Timelines contain clips, the source media of which is kept 
in the Media Pool, and which also appear as edit events in the Edit Index that can be shown at 
the right of the Timeline.

Timelines, Grades, and Versions
Within any given timeline, grades are associated with the timecode of the source clip they’re 
applied to. That means that as you alter the timeline, each clip’s grade moves along with it, 
making it extremely easy to move back and forth between editing and grading as your needs 
require. By default, each timeline in a project has independent sets of grades using Local 
versions; this is true even if your timelines are duplicates. That means each clip within every 
timeline has a completely independent grade.

TIP: Smart Bins are essentially multi-criteria search operations that scope the entire 
project at once and are saved for future use.
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However, if you switch the clips in one or more timelines to use Remote versions, a clip’s grades 
are shared by every instance of that clip in all timelines with clips that also use Remote versions. 
If you import a new timeline that rearranges clips into a different order and switch it to using 
Remote versions, then grades will automatically follow the clips, so that the clips within each 
new timeline inherits the grades applied to those same clips in other timelines.

You can switch a timeline between using Local and Remote grades at any time. For more 
information on using Local versus Remote versions, see Chapter 48, “Grade Management.” You 
can also copy grades from one timeline to another using the ColorTrace feature. For more 
information about ColorTrace, see Chapter 54, “Copying and Importing Grades Using 
ColorTrace.”

Enabling the Use of a Master Timeline
Previous versions of DaVinci Resolve had a Master Timeline, which consisted of one long 
timeline containing every clip in the Media Pool, arranged by default in ascending order by 
timecode. While the Master Timeline was useful for a variety of tasks, architectural 
improvements have rendered it unnecessary, and by default the Master Timeline does not 
appear in new projects created by DaVinci Resolve version 10 or later.

However, if you want a Master Timeline in order to have a single timeline that always contains 
all clips currently in the Media Pool, there’s a way you can create one. You need to do it 
immediately upon creating a new project, before adding any media to the Media Pool. Once 
you’ve added one or more clips to the Media Pool, the option you need to do so will 
be disabled.

To create a new Master Timeline:

1	 Create a new project, open the General Options panel of the Project Settings, and turn 
on the “Automatically match master timeline with media pool” checkbox. If you also 
want all clips to use Remote versions as you grade by default as in previous versions of 
DaVinci Resolve, you can turn off the “Store grade with local version by default.”

The option to use a Master Timeline is in the Color section of the 
General Options panel of the Project Settings

2	 Click Save to close the Project Settings window.

3	 Open the Edit page, and choose File > New Timeline (Command-N).

4	 When the New Timeline Properties window appears, turn the Empty Timeline checkbox 
off, and click Create New Timeline.

Now, in addition to the new timeline, a Master Timeline appears in the Timeline list.

TIP: If you want to make sure that you always have a Master Timeline when 
you create new projects, you can alter the Project Setting preset for your user 
account to reflect these settings, or you can create a new Project Setting 
preset with these settings that you can easily switch to.
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Creating a Master Timeline

The Master Timeline consists of one long sequence of every clip in the Media Pool, arranged in 
ascending order by timecode. Each clip in the Master Timeline appears at its full duration, 
regardless of the duration of corresponding clips in an EDL-, AAF-, or XML-imported timeline. 
Whenever you add more clips to the Media Pool, they’re automatically added to the Master 
Timeline. 

The Master Timeline is useful for organizing media for which no editing has yet been done, such 
as when grading digital dailies. The Master Timeline is also useful for identifying a range of 
similar clips, based on their similar ranges of timecode. For example, you could find all the 
talking head shots from a particular section of tape clustered together in the Master Timeline.

Using the Effects Library
All effects that you can add to your edit, including filters, transitions, titles, and generators, are 
found in the Effects Library, which is split into two parts. To the left is a bin list that shows a 
hierarchical list of all of the different Transitions, Title Effects, Generators, and Filters that are 
available, sorted by category. To the right is a browsing area in which you can see the contents 
of whichever bins are selected.

The Effects Library

Similar to the Media Pool, the Effects Library’s bin list can be opened or closed using a button 
at the top left, while a menu just to the right of this button lets you sort the list into 
different categories.



279

U
si

ng
 t

he
 E

d
it 

P
ag

e
 

P
ar

t 
3 

–
 1

4

The Toolbox
All of the video and audio transitions, titles, and generators that ship along with DaVinci Resolve 
appear in the Toolbox category of the Effects Library.

�� Toolbox: Exposes all Transitions, Titles, Generators, and Effects at once.

Video Transitions: Contains all of the built-in transitions that are available from DaVinci 
Resolve. You can drag any video transition to any edit point in the Timeline that has 
overlapping clip handles to add it to your edit; you have the option to drag the transition 
so that it ends on, is centered on, or starts on the edit point. 

For more information, see Chapter 24, “Using Transitions.”

Audio Transitions: Contains audio transitions for creating crossfades.

Titles: Titles can be edited into the Timeline like any other clip. Once edited into the 
Timeline, you can edit the title text and position directly in the Timeline Viewer, or you 
can access its controls in the Inspector for further customization.

Generators: Generators can also be edited into the Timeline like any other clip. 
Selecting a generator and opening the Inspector lets you access its controls for further 
customization. You can also choose a standard duration for generators to appear with 
in the Editing panel of the User Preferences.

OpenFX
DaVinci Resolve supports the use of third-party OpenFX filters, transitions, and generators in 
the Edit page. Once you install these effects on your workstation, they appear in this section of 
the Effects Library, organized by type and group depending on the metadata within each effect.

�� OpenFX: Exposes all ResolveFX and third-party OpenFX installed on your 
workstation at once.

Filters: Contains the ResolveFX filters that ship with DaVinci Resolve, as well as any 
third-party OFX plug-ins you’ve installed on your workstation. Filters can be dragged 
onto video clips to apply an effect to that clip. Once applied, filters can be edited and 
customized by opening the OpenFX panel of the Inspector.

Transitions: Contains any third party OFX transitions you have installed on your 
workstation. OFX transitions can be used similarly to any other transition, but they also 
expose an OpenFX panel next to the Transition panel in the Inspector, where you can 
customize settings that are unique to that transition.

Generators: Contains any third party OFX generators you have installed on your 
workstation. Can be edited into the Timeline just like the native Generators that ship 
with DaVinci Resolve, but they also expose an OpenFX panel next to the Transition 
panel in the Inspector, where you can customize settings that are unique to that 
transition.

AudioFX
On OS X and Windows, DaVinci Resolve supports the use of third-party VST audio plug-ins. 
On OS X, DaVinci Resolve supports Audio Unit (AU) audio plug-ins. Once you install these 
effects on your workstation, they appear in this panel of the Effects Library. Audio plug-ins let 
you apply effects to audio clips or an entire track’s worth of audio to add creative qualities such 
as echo or reverb, or to take care of mastering issues using noise reduction, 
compression, or EQ.
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Effects Library Favorites
You can click on the far right of any transition, title, or generator to flag that effect with a star as 
a favorite effect. When you do so, the favorited effects appear in a separate Favorites area at 
the bottom of the Effects Library Bin list.

Stars indicate a flagged favorite effect; all 
favorites are currently filtered

Edit Index
Clicking the Edit Index button opens the Edit Index. By default, this shows an EDL-style list view 
of all the edit events in the current timeline. Whichever timeline is selected in the Timeline list 
displays its events here. However, the contents of the Edit Index can be filtered using 
commands found in the Option pop-up, described later in this section.

Edit Index List shown open
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Each clip and transition is shown as an individual event, each of which contains multiple 
columns of information. If you re-edit a timeline, your changes are also reflected in this list. The 
Edit Index is useful for creative editors that are looking for specific effects that are used in the 
current timeline, or for finishing editors that need more information about a specific clip, or who 
might need to filter the entire edit by specific criteria in order to troubleshoot various issues.

Navigating The Timeline Using the Edit Index
Whenever you move the Timeline playhead to intersect a clip, the Edit Index updates to show 
only the clips on the video track the intersecting clip is on, and that clip’s event is highlighted in 
the Edit Index. This makes it easy to see the correspondence between a clip in the Timeline 
and its event, which is helpful when troubleshooting problems. There are also commands 
available in the Option menu to display only clips on enabled tracks, only video clips, and only 
audio clips.

Edit Index Columns
Each event populates several columns of information. These columns can be rearranged by 
dragging them to the left or right, depending on what information is most important to you.

The available columns of information are:

�� #: The event number (which corresponds to the clip number shown in the Thumbnail 
timeline of the Color page).

�� Reel: The reel name of the corresponding clip.

�� Match: Flags clips that have clip conflicts, which display a question mark in this column. 
Once the clip conflict has been resolved, this flag disappears.

�� V: Video event.

�� C: The event type (C for cut, D for dissolve or transition).

�� Dur: A number showing the duration of a transition in frames. 

�� Source In/Source Out: The Source In and Source Out timecode indicating the range of 
timecode referenced by that clip; corresponds to the timecode locations of each clip’s 
In and Out point relative to the source media it comes from.

�� Record In/Record Out: Record In and Record Out timecode indicating that clip’s 
position in the Timeline.

�� Name: The name of the clip.

�� Comments: Whatever comments were present in the EDL that was imported. For 
example, clip names exported from the original NLE to be used as reel names in RED 
workflows using EDL import.

�� Source Start/ Source End: The very first and last frame of media available in the 
Source Media for that clip.

�� Source Duration: The duration, in timecode, of the total source media available in 
that clip.

�� Codec: The codec of the corresponding clip.

�� Source FPS: The frame rate of the corresponding clip.

�� Resolution: The frame size of the corresponding clip.

�� Color: The color of flags or markers applied to that clip.

�� Notes: Notes entered inside of markers applied to clips or the Timeline.

The columns in the Edit Index can be customized to prioritize the information that’s 
important to you.
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Methods of customizing metadata columns in the Edit Index:

�� To show or hide columns: Right-click at the top of any column in the Edit Index and 
select an item in the contextual menu list to check or uncheck a particular column. 
Unchecked columns cannot be seen.

�� To rearrange column order: Drag any column header to the left or right to rearrange 
the column order.

�� To resize any column: Drag the border between any two columns to the right or left to 
narrow or widen that column.

You can also customize column layouts in the Edit Index. Once you’ve customized a column 
layout that works for your particular purpose, you can save it for future recall. 

Methods of saving and using custom column layout:

�� To create a column layout: Show, hide, resize, and rearrange the columns you need 
for a particular task, then right-click any column header in the Media Pool and choose 
Create Column Layout. Enter a name in the Create Column Layout dialog, and click OK.

�� To recall a column layout: Right-click any column header in the Media Pool and choose 
the name of the column layout you want to use. All custom column layouts are at the 
top of the list.

�� To delete a column layout: Right-click any column header in the Media Pool and 
choose the name of the column layout you want to delete from the Delete Column 
Layout submenu.

Filtering the Edit Index
You can use options found in the Edit Index’s option menu to filter specific things that you want 
to check out, whether to go through all of the marked clips to see if there are any notes you 
need to address, or to isolate all offline clips, or to go through edits to see if there’s anything 
you need to fix. You can filter the Edit Index in the following ways:

�� Show All: Shows all entries in the list. Choose this option after using any of the other 
options to go back to seeing the entire timeline.

�� Show Active Track Items: Filters out all clips that appear on tracks above or below 
tracks identified with a Destination Control. For example, if you have three video tracks 
and the Destination Control is on track V2, then all clips on tracks V1 and V3 will be 
hidden from the Edit Index.

�� Show Video Track Items: Filters out all audio clips so only video clips appear in the list.

�� Show Audio Track Items: Filters out all video clips so only audio clips appear in the list.

�� Show Flags: Isolates clips with flags in the list. A submenu lets you choose to show all 
clips with flags or only clips with a particular color of flag.

�� Show Markers: Isolates all clips with markers in the list. A submenu lets you choose to 
show all clips with markers or only clips with a particular color of marker.

�� Show Clip Colors: Isolates all clips that have been labelled with clip colors in the list. A 
submenu lets you choose to show all clips that are labelled using any clip color or only 
clips labelled with a particular color.

�� Show Through Edits: Filters only clips that have through edits, or cuts where 
continuous timecode appears from the outgoing to the incoming half of the edit, that 
you may or may not want to remove, depending on why they’re there.

�� Show Offline Clips: Isolates all offline clips (clips that have become unlinked from the 
corresponding source media on disk) in the Timeline, so you can quickly navigate to 
each one and troubleshoot the issue.
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�� Show Clip Conflicts: Filters all clips with clip conflict warning badges (indicating there is 
reel, name, and timecode metadata that overlap that of another clip) in the Timeline, so 
you can quickly navigate to each one and check whether they’re using the correct clip.

�� Show Clips With Speed Effects: Filters all clips with linear or variable Speed Effects in 
the Timeline.

�� Show Clips With Composite Effects: Filters all clips with Composite mode or Opacity 
settings other than the default (Normal, 100).

�� Show Clips With Transform Effects: Filters all clips with altered Transform settings.

�� Show Clips With Filters: Filters all clips with ResolveFX or OFX filters applied to them.

�� Show Stills and Freeze Frames: Filters all clips that are stills or that have freeze frame 
speed effects applied to them.

�� Show Compound Clips and Nested Timelines: Filters all compound clips and nested 
timelines in the Timeline.

�� Show Fusion Connect Clips: Filters all Fusion Connect Clips.

Exporting the Edit Index
If you’ve filtered a series of edits in the Edit Index that you’d like to share with someone else, 
this is easy to do. For example, you might filter the Edit Index to show a list of all the offline clips 
in the current timeline, and then export a list as either a .csv or .txt file to give to your assistant 
editor so they can chase down the necessary media. Both types of files are widely compatible 
with spreadsheet and database software in the event you want to import the data into another 
application.

To export the Edit Index:

1	 Right-click the currently open timeline in the Media Pool, and choose Timelines > 
Export > Edit Index… from the contextual menu.

2	 Use the Export Edit Index window to choose a location to save the exported file, and 
choose a format from the pop-up menu at the bottom. You can export either a Comma 
Separated Values (.csv) file, or a Tab Delimited Values (.txt) file.

3	 Click Save.

Source and Timeline Viewers
By default, the Edit page presents a traditional source/record style editing experience. The 
Source Viewer lets you view individual clips from the Media Pool to prepare them for editing. 
Meanwhile, the Timeline Viewer lets you play through your program, showing you the frame at 
the position of the playhead in the Timeline. 

Source and Timeline Viewers



284

U
si

ng
 t

he
 E

d
it 

P
ag

e
 

P
ar

t 
3 

–
 1

4

You can select either viewer by clicking with the pointer, or by pressing Q (Source/Timeline 
Viewer), and the name of the viewer that currently has focus appears in orange.

How Each Clip’s Grade Looks in Each Viewer
The Color Viewer Lookup Table options in the Color Management panel of the Project Settings 
only affect the GUI Viewer in the Color page. They do not affect the viewers in the Edit page.

Source and Timeline Viewers vs. Single Viewer Mode
If you want to change the Edit Page layout to hide the Source Viewer, you can choose View > 
Single Viewer Mode to instead use just a single viewer to contextually display either a selected 
Source Clip or the current frame of the Timeline.

Single Viewer mode turned on

In Single Viewer mode, whatever you select in the Media Pool or Timeline determines which 
controls appear in the Viewer, which lets you do nearly everything you can do with two 
simultaneously open viewers.

Viewer Controls
Both viewers share the following onscreen controls:

�� Zoom pop-up menu: Choosing Fit fits the currently visible frame to the available size 
of the viewer. Choosing a percentage zooms the visible frame to that size. You can also 
use the scroll wheel functionality of your mouse, trackpad, or tablet to zoom in and out 
of the viewer.

�� Duration field: At the top left-hand side of the Source Viewer, this displays the 
total duration of the clip, or the duration from the In to the Out point, if these have 
been placed. In the Timeline tab, this displays the total duration of the currently 
selected timeline.

�� GPU Status Display: Every viewer in DaVinci Resolve exposes a a GPU status indicator 
and a frame-per-second (FPS) meter, which appears in the viewer’s title bar, which 
shows you your workstation’s performance whenever playback is initiated. Since 
DaVinci Resolve uses one or more GPUs (graphics processing units) to handle all image 
processing and effects, the GPU status display shows you how much processing power 
is being used by whichever clip is playing.
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�� Clip Name: The clip name is displayed at the center of the Source Viewer title bar. 
The Timeline Viewer displays the timeline name and is also a pop-up menu that lets 
you switch among other timelines in the current project. The clip/timeline name is 
highlighted orange when either the Source or Timeline Viewer has focus.

�� Source/Timeline Timecode/Frame/Keykode Display: At the top right-hand side of 
the Source Viewer, this field shows the timecode of the current frame at the position 
of the playhead in the Source Viewer’s jog bar, and can be switched between 
source timecode, source frame, and keykode by right-clicking and choosing from the 
contextual menu. In the Timeline Viewer, this field shows the record timecode of the 
current frame at the position of the playhead in the Timeline, and can be switched 
between source and record timecode, source and record frames, and keykode by right-
clicking and choosing from the contextual menu. 

�� Source Viewer Option menu: Contains the following commands:

Gang Viewers: With Gang Viewers enabled, the movement of the Source and Timeline 
Viewer playheads is locked together, so that they move in unison. This is useful when 
you’re matching the timing of part of a clip in the Source Viewer to match an event in 
the Timeline.

Live Media Preview: Enabled by default, makes it possible for thumbnails that you’re 
skimming in the Media Pool to show the skimmed frame in the Viewer. When skimming 
with Live Media Preview enabled, the playhead that appears in the thumbnail is locked 
to the playhead displayed in the Viewer’s jog bar.

Show All Video Frames: When available processing power is insufficient to play the 
clip or clips at the position of the playhead due to the grade, transforms, or effects that 
are applied at that moment in the Timeline, you have the ability to choose exactly how 
performance in DaVinci Resolve degrades. When off, DaVinci Resolve prioritizes audio 
playback at the expense of dropping video frames when processing power is tight, 
resulting in a more conventional playback experience. When on, audio quality is 
compromised while every frame of video plays in slower-than-real time to 
maintain playback.

Show Zoomed Audio Waveform: When enabled, shows an audio waveform overlay at 
the bottom of the Source Viewer with a zoomed in section of the audio surrounding the 
current position of the playhead.

Show Full Clip Audio Waveform: When enabled, shows an audio waveform overlay at 
the bottom of the Source Viewer that displays the audio over the entire duration 
of the clip.

Show Marker Overlays: Enabled by default, markers that intercept the playhead when 
playback is paused appear superimposed in the Viewer.

Markers submenu: When one or more markers are applied to the clip in the Source 
Viewer, they appear in this list in chronological order, listed by Name and Note. 
Choosing a marker from this menu jumps the playhead to that marker in the 
Source Viewer.

�� Timeline Viewer Option menu: Contains the following commands:

Gang Viewers: With Gang Viewers enabled, the movement of the Source and Timeline 
Viewer playheads is locked together, so that they move in unison. This is useful when 
you’re matching the timing of part of a clip in the Source Viewer to match an event in 
the Timeline.

Show All Video Frames: When available processing power is insufficient to play the 
clip or clips at the position of the playhead due to the grade, transforms, or effects that 
are applied at that moment in the Timeline, you have the ability to choose exactly how 
performance in DaVinci Resolve degrades. When off, DaVinci Resolve prioritizes audio 
playback at the expense of dropping video frames when processing power is tight, 
resulting in a more conventional playback experience. When on, audio quality is 
compromised while every frame of video plays in slower-than-real time to 
maintain playback.
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Show Marker Overlays: Enabled by default, markers that intercept the playhead when 
playback is paused appear superimposed in the Viewer.

Markers submenu: When one or more markers are applied to a Timeline, they appear 
in this list in chronological order, listed by Name and Note. Choosing a marker from this 
menu jumps the playhead to that marker in the Timeline.

�� Source Viewer Mode pop-up (Source Viewer only): This pop-up menu lets you set the 
Source Viewer to display different views of the clips you’re working on, depending on 
what you need to do.

Offline Reference Movie button: If you’ve assigned an offline reference movie to the 
currently selected timeline, clicking the Offline Mode button lets you display the offline 
movie so you can compare it with the currently open timeline. In this mode, Source and 
Timeline playback are synched; an Offset field replaces the duration field, letting you 
re-sync the offline reference movie, if necessary.

Video button: Shows the video of the currently open clip in the Source Viewer.

Audio button: Shows the audio waveforms corresponding to all channels of the 
currently open clip in the Source Viewer. The top of this audio-only view shows the 
waveform for the entire duration of the clip, while the main region of the viewer shows a 
zoomed in section of the audio waveform. The level of zoom displayed is controlled by 
the zoom pop-up at the upper left-hand corner of the Source Viewer.

Multicam: Shows you the multi-angle Multicam Viewer that you can use to switch 
among different angles of video and audio while multicam editing a clip in the Timeline. 
For more information on multicam editing, see Chapter 21, “Multicam Editing.”

�� Transform Mode pop-up (Timeline Viewer Only): This functions as both a toggle 
switch and a pop-up menu. Clicking the button control to the left enables or disables 
onscreen controls that you can use to transform the clip right in the viewer. Clicking the 
pop-up control to the right lets you switch between two modes of transforms:

Transform: Exposes controls for Pan (X) and Tilt (Y), Scale X and Y, and Rotation.

Crop: Exposes controls to crop from the top, bottom, left, and right.

�� Jog control: Clicking the Jog control and dragging left and right lets you move slowly 
through a clip or the Timeline a frame at a time.

�� Transport controls: These controls include, from left to right, Jump to First Frame, Play 
Reverse, Stop, Play Forward, Jump to Last Frame.

�� Loop Playback: Enables or disables looped playback. Looping is also controllable via 
the Playback > Loop/Unloop command (Command-/). When enabled, each playback 
command loops back to the beginning when the end of that command’s range is 
reached. In and Out points in the Source or Timeline Viewers do not trigger looping. 
For example, when enabled, the Play command will play through the entire clip or 
timeline, and then loop back to the beginning when the end is reached and start 
playing automatically. The Play Around command, on the other hand, will start at the 
beginning of pre-roll, play through the post-roll, and then immediately loop back around 
to the beginning of pre-roll, continuing playback in this manner until you stop it.

�� Match Frame: In the Source Viewer, Match Frame attempts to move the playhead in 
the Timeline to match the current frame of the clip in the Source Viewer. In the Record 
Viewer, Match Frame opens the Media Pool clip corresponding to the clip at the current 
position of the playhead into the Source Viewer, setting In and Out points and the 
playhead position to match those of the clip in the Timeline.

�� In/Out buttons: Places In and Out points with which to define a range of the clip, or of 
the Timeline, in preparation for making different kinds of edits.

�� Jog bar: In the Source Viewer, drag within the jog bar to reposition the Source 
playhead, scrubbing through the clip. In the Timeline tab, drag to reposition the 
playhead throughout the entire program.
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Simultaneous Audio Waveform Display in the Source Viewer
When the Source Viewer is set to Source, two options in the Option Menu let you see a 
superimposed audio waveform running along the bottom of the viewer, over the video of the 
currently selected clip.

�� Show Current Frame Audio Waveform: Shows a zoomed-in section of audio that 
scrolls as you play the clip. Useful for seeing dialog and music cues as you play 
through a clip.

�� Show Full Clip Audio Waveform: Shows the audio waveform for the entire source 
media of that clip. The section of audio from the In to Out points you’ve set in the 
Source Viewer are highlighted. Useful for using the audio waveform to navigate 
throughout that clip using the waveform as a reference.

The Source Viewer with “Show Current Frame Audio Waveform” enabled

Cinema Viewer Mode
You can also put either the Source or Timeline Viewers into Cinema Viewer mode by choosing 
Workspace > Viewer Mode > Cinema Viewer (Command-F), causing whichever viewer is 
currently selected to fill the entire screen, which is good for doing a test viewing of your edit 
without the distractions of the DaVinci Resolve Edit Page UI. This command toggles Cinema 
Viewer mode on and off.

Viewer Indicators
Certain frames trigger visible indicators in either the Source or Timeline viewers. For example, 
if the playhead is at the very first or last frame of media available to a particular clip, indicators 
appear in the lower-left or right corner of the frame to let you know there’s no more media in 
that direction.

The first and last frame clip indicators
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If the playhead in the Timeline is on the first frame of black immediately after the last video clip 
in the Timeline, an end of sequence indicator appears in the Timeline Viewer to let you know 
that you’re viewing the last frame of the current sequence of clips, even though the playhead is 
actually on a frame of black. This makes it easy to see what you’re doing while you’re first 
assembling clips together.

The end-of-sequence indicator

Other Viewer Options
There are additional overlays and options you can use to customize how the viewer appears, 
available in the View menu.

�� Safe Area: Choosing View > Safe Area > On lets you turn on Safe Area overlays 
showing you Title Safe, Action Safe, among other available overlays. If you want to 
choose the aspect ratio with which these overlays are represented, you can do so from 
the View > Select Aspect Ratio submenu.

�� Use Gray Background: Choosing View > Use Gray Background in Viewers sets the 
empty area of the viewer (if there is any) to a lighter gray, making it easier to see which 
parts of the viewer are black because of blanking, and which parts are simply empty 
because of the way the image is zoomed or panned.

Opening Clips in the Source Viewer
There are two methods of opening clips into the Source Viewer. Which is enabled depends on 
the “Live Media Preview” setting found in the Viewer options menu (the three-dots menu found 
at the upper right-hand corner of the Viewer).

�� When Live Media Preview is enabled (by default), skimming a thumbnail in the Media 
Pool also shows the skimmed frame in the Source Viewer, effectively opening each 
clip you skim in the Media Pool into the Source Viewer. As you skim, the playhead 
that appears in the thumbnail is locked to the playhead that’s displayed in the 
Viewer’s jog bar.

�� When Live Media Preview is disabled, you must either double-click a clip in the Media 
Pool to open it into the Source Viewer, or you can select a clip in the Media Pool and 
press the Return key to open it into the Source Viewer. 

Which method is best is purely a matter of preference.
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Timeline Viewer Edit Overlays
Dragging a clip from the Media Pool or Source Viewer onto the Timeline Viewer also exposes 
edit overlays that let you choose what kind of edit you want to make by choosing which overlay 
to drop the clip onto.

The overlay that appears when you drag a clip onto the Timeline 
Viewer lets you choose from a variety of edits

This overlay exposes every type of edit that’s available in DaVinci Resolve, including the Insert, 
Overwrite, Replace, Fit to Fill, Place On Top, Ripple Overwrite, and Append at End edits, all of 
which are also available from the Edit menu. It’s a useful method of making three-point edits if 
you like drag and drop editing, but it also provides a nice reminder of what types of edits are 
available, given all the different options that are available.

By default, the larger empty area to the left of these overlays defaults to the highlighted 
Overwrite overlay, while all the smaller buttons let you perform each of the other edit types that 
are available. 

However, the “Timeline overlay retains the last performed action” checkbox in the Editing panel 
of the User Preferences can be turned on if you want DaVinci Resolve to always remember the 
last edit type you used, and highlight it on this Overlay whenever you drag another clip over the 
Timeline Viewer to let you know that the last edit you performed is the new default edit if you 
drop clips to the left of the overlay. For example, with this option enabled, if you perform a Place 
On Top edit, then the next time you drop a clip into the empty area to the left of the overlays, 
the result will be another Place On Top edit. This option is off by default.

Metadata Editor
Both the Media and Edit pages have a Metadata Editor. In the Edit page, the Metadata Editor 
opens in the same place as the Inspector, to the right of the Source and Timeline Viewers. 
When you select a clip in the Media Pool or Timeline, its metadata is displayed within the 
Metadata Editor, and the title bar indicates whether you’re evaluating a clip in the Timeline or 
Media Pool. If you select multiple clips, only the last clip’s information appears. The Metadata 
Editor’s header contains uneditable information about the selected clip, including the file name, 
directory, duration, frame rate, resolution, and codec.
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Because there are so very many metadata fields available, two pop-up menus at the top let you 
change which set of metadata is displayed in the Metadata Editor.

�� Metadata Presets (to the left): If you’ve used the Metadata panel of the User 
Preferences to create your own custom sets of metadata, you can use this pop-up to 
choose which one to expose. Surprisingly enough, this is set to “Default” by default.

�� Metadata Groups (to the right): This pop-up menu lets you switch among the various 
groups of metadata that are available, grouped for specific tasks or workflows.

The heart of the Metadata Editor is a series of editable fields underneath the header that let 
you review and edit the different metadata criteria that are available. For more information on 
editing clip metadata, and on creating custom metadata presets, see Chapter 9, “Using 
Clip Metadata.”

Clip Metadata Editor showing the Clip Details 
panel for a clip in the Timeline
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Inspector
The Inspector can be opened to let you customize compositing, transform, and cropping 
parameters for clips, as well as clip-specific retime and scaling options. Furthermore, the 
Inspector lets you edit the parameters of transitions, titles, and generators used in the Timeline, 
in order to customize their effect.

The Inspector, opened and showing a clip’s parameters

When the Inspector is open, the Source and Timeline viewers move to the left, to sit alongside the 
Inspector showing the selected clip’s parameters. However, if your computer display’s resolution 
is not high enough, opening the Inspector may result in the Source Viewer being hidden.

Methods of showing parameters in the Inspector:

�� To open a video or audio clip’s transform settings when the Inspector is closed: 
Select that clip, and then click the Inspector button at the far right of the Edit 
page toolbar.

�� If the Inspector is already open: You need only select a clip or effect to reveal its 
controls in the Inspector. 

�� If the Inspector is closed: Double-clicking any Transition will automatically open it. 

The Inspector shows different buttons at the top that let you switch among different pages of 
parameters. For example, when you select a clip with both audio and video components, the 
Inspector shows Video and Audio buttons at the top that let you switch among each set of 
controls. If you select a Generator effect, the Inspector only shows the controls corresponding 
to that generator.

Timeline
The Timeline shows whichever timeline you’ve double-clicked in the Timelines browser. It’s 
where you either edit programs together from scratch, or import sequences from other 
applications. For imported programs, the Timeline provides a visual representation of the edited 
program that’s helpful for verifying that the project was imported correctly, checking the media 
corresponding to each clip in the program, and performing whatever editorial tasks are 
necessary to prepare a project for grading (such as replacing or adding clips, superimposing 
composites, and modifying composite modes or transitions).

An edited timeline
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�� Timeline Ruler: The Timeline Ruler shows the program’s timecode, and the playhead 
indicates the current frame of the current clip. Whichever clip intersects the playhead is 
the one that you’ll be working on in the Color page. Dragging within the Timeline Ruler 
moves the playhead. When you add markers to the timeline, these markers appear 
within the Timeline Ruler, as well.

�� Playhead: The playhead automatically syncs with the Timeline Viewer’s jog bar 
playhead, the playheads in the Mini-Timeline and Thumbnail timeline of the Color 
page, and the playhead on the Deliver page. Furthermore, the Edit Index event that 
corresponds to the clip intersecting the playhead is automatically highlighted.

�� Timecode field: Shows the current timecode value corresponding to the position of 
the playhead.

�� Video Tracks: DaVinci Resolve supports multiple video tracks. At the left of each track 
is a header area that contains a number of controls.

�� Track Header: The Track Header contains different controls for selecting, locking/
unlocking, and enabling/disabling tracks. Each track header also lists how many clips 
appear on that track. The Track Header contains the following five controls, from 
left to right:

Track Header area showing the controls 
for each track that are located within

�� Track Color: Each track can be color-coded with one of 16 different colors. These color 
codes correspond to the Edit page Mixer, and to the Fairlight page Mixer and Audio 
Meters. You can choose a new color for any track by right-clicking the track header and 
choosing from the Change Track Color submenu.

�� Destination control and Track Number: These controls are highlighted orange when 
that track is selected for editing, dark gray when that track is not selected, and flat gray 
if that track is disabled for editing. The Destination buttons dictate into which tracks 
audio and video media in the Source Viewer will be placed when an edit is executed. 
Ordinarily, there is one video destination control (V1) and one audio destination control 
(A1). If you add additional tracks, you can see that each destination control is numbered 
according to its track position. The bottom track is “V1,” and subsequently numbered 
tracks appear higher in the Timeline. Click any track’s number to select that track for 
different editing functions; the selected track is highlighted black.

�� Track Name: Each track has a name that defaults to the type of track and the track 
number, such as Video 1, Audio 1. However, you can click any track’s name and edit it to 
be whatever you like. For example, you can rename each audio track with the type of 
audio you’re editing onto it, such as Production, Ambience, SFX, or Music. These track 
names are also used to identify each track’s channel in the Edit page Mixer and in the 
Fairlight page Mixer.
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�� Enable Track/Mute button: A slash indicates when a track is disabled. This control lets 
you turn tracks on and off. Clips on tracks that are turned off aren’t visible in the viewer, 
don’t show up in the Color page, and aren’t available for rendering or output. For Audio 
tracks this is the Mute button.

�� Lock Track button: Light gray when turned on, dark gray when turned off. When a track 
is locked, clips can’t be replaced, moved, or otherwise edited, although clips on locked 
tracks can be graded.

�� Auto Select button: On by default. Light gray when that track is selected, dark 
gray when that track is not selected. When this control is on, clips on that track are 
automatically included in operations that affect all clips that intersect the position of 
the playhead, or that intersect a region defined by the Timeline In and Out points. 
When this control is off, clips on that track are ignored by those same operations. 
Furthermore, rippling is suspended on tracks with Auto Select turned off for operations 
that would otherwise ripple the Timeline. Note, manual selections made in the Timeline 
that highlight specific clips take precedence over the Auto Select controls, so if Auto 
Select is turned off on track 1, but you’ve selected a clip on track 1, the selected clip will 
be still be affected by whatever operation you’re about to perform.

�� Audio Channel Type indicator: Audio tracks also show which channel configuration 
that track uses, listing the number of channels for mono, stereo, 5.1, 7.1, and adaptive.

�� Number of clips: The number of clips on that particular track of the Timeline is listed, 
but only if the track is tall enough to have room for them.

�� Vertical and horizontal scroll bars: If your project is longer than the current width of the 
Timeline, or the number of video tracks is taller than the current height of the Timeline, 
these scroll bars let you drag to navigate around your program.

�� Individual Timeline track resizing: Any track in the Timeline can be individually resized 
by dragging its top divider in the Track Header area.

Resizing an individual timeline track by dragging 
its top border in the Track Header

Timeline Options
Specific elements and behaviors within the Timeline can be customized in various ways.

Show Playhead Shadow
Ordinarily, the playhead is shown in the Timeline as a single line that indicates the beginning of 
the frame that you’re viewing in the Timeline Viewer. However, you can choose View > Show 
Playhead Shadow to display an orange-ish background surrounding the playhead.
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(Left) The playhead’s default look, (Right) The playhead showing the optional Playhead Shadow

This shadow can make it easier to see the playhead’s position, and it can also serve as a 
measuring tool for projects where you have an interest in visualizing a specific offset, in frames, 
both before and after the current position of the playhead. This offset can be adjusted by 
changing the Pre- and Post-Playhead Shadow Length parameters in the Editing panel of the 
User Preferences, which let you specify the number of frames to shadow both before and after 
the playhead. The default length of the Playhead Shadow is 5 frames.

Enabling and Disabling Audio Scrubbing
Audio scrubbing is enabled by default, meaning that you’ll hear audio when dragging the 
playhead with the mouse back and forth. While this can be useful when you’re searching for 
audio cues, it can also be distracting if you’re just focused on the picture.

To enable or disable audio scrubbing:

Choose Timeline > Audio Scrubbing (Shift-S)

TIP: You can set the “Pre-playhead shadow length” to 0, and the “Post-playhead 
shadow length” to 1 if you want to display a “Media Composer-style” playhead that 
shows the duration of the current frame.
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Playback Post-Roll
Enables the playhead to continue playing past the last clip in the Timeline for a duration equal 
to the “Post-roll time” Project Setting in the Editing panel. This is good for editors that want to 
experience a few moments of  playback after cutting or fading to black after the last frame of 
audio and video in the Timeline.

To enable or disable Playback Post-Roll:

Choose Timeline > Playback post-roll

Switching Among Multiple Timelines
Timelines can be organized like any other clip in the Media Pool. To open or switch among 
timelines, use the following procedures.

To switch timelines, do one of the following:

�� In the Edit page Media Pool, double-click a timeline.

�� In the Edit page Timeline Viewer, choose a timeline from the Timelines pop-up menu at 
the top of the viewer.

�� In the Color page, choose a timeline from the Timelines pop-up menu at the top of 
the viewer.

�� In the Audio page, choose a timeline from the Timelines pop-up menu to the left of the 
transport controls.

Toolbar
At the center of the toolbar that sits above the Timeline, eleven buttons let you choose different 
tools and options for performing various editing functions.

Buttons in the Toolbar

�� Selection Mode: The default mode in which you can move and resize clips in the 
Timeline, roll edits, and do other basic editing tasks.

�� Trim Edit Mode: In this mode, the Trim tool lets you make slip, slide, ripple and roll edits 
by dragging different parts of clips in the Timeline, or by making specific selections 
and using the “nudge” keyboard shortcuts of comma and period to move the selection 
left or right.

�� Razor Edit Mode: Lets you add cuts to the Timeline by clicking.

�� Insert Edit: Performs an insert edit to the Timeline with whatever clip is in the 
Source Viewer.

�� Overwrite Edit: Performs an overwrite edit to the Timeline with whatever clip is in the 
Source Viewer.

�� Replace Edit: Performs a replace edit to the Timeline with whatever clip is in the 
Source Viewer.

�� Snapping: Enables or disables clip snapping. When turned on, clip In and Out points, 
markers, and the playhead all snap to one another for reference while you’re editing.
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�� Link Audio/Video: Enables or disables Audio/Video linking. When turned on, clicking a 
video clip in the Timeline automatically selects the corresponding audio clip if they’re 
linked together. When turned off, clicking a video clip won’t select its audio. Clip linking 
can be toggled while you work by pressing the Option key while clicking to make 
selections in the Timeline.

�� Flag Clip/Flag Colors pop-up menu: Flags identify clips, and indicate all clips that 
correspond to the same item of media in the Media Pool. Clips can have multiple flags. 
Clicking the Flag button automatically adds a flag to whichever clip is currently selected 
in the Timeline. A pop-up menu to the right lets you choose differently colored flags, 
and clear all flags from the currently selected clip.

�� Add Marker/Marker Colors pop-up menu: Markers identify specific frames of individual 
clips. Clicking the Add Marker button adds a marker of the currently displayed color 
to the clip at the position of the playhead in the Timeline. A pop-up menu to the right 
lets you choose differently colored markers, and clear all markers from the currently 
selected clip.

�� Customize Timeline pop-up menu: Three controls at the top let you customize the look 
of the clips on the tracks (filmstrip, thumbnail, or minimized), whether or not to display 
audio waveforms, whether or not to display flags and markers, and the adjustable 
height of the video and audio tracks.

Selecting the Timeline View options

�� Zoom slider: Lets you zoom into or out of the clips in the Timeline. Use the scroll wheel 
of your mouse to horizontally zoom into and out of the Timeline. Scrolling up zooms 
in, while scrolling down zooms out. You can also use Command-Plus to zoom in, and 
Command-Minus to zoom out, and Shift-Z to fit every clip in your program into the 
available width of the Timeline.

�� Show Audio Meters/Audio Mixer button and pop-up: Opens and closes the Edit 
page audio meters or Audio Mixer, which you can switch between. The Audio Mixer 
also contains the audio mute button. If you have a display with 2560x1440 resolution 
you can see all 16 audio meters, but on lower resolution displays only 8 audio 
meters appear. 

These functions are described in greater detail in the following sections of this chapter.
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Toolbar Audio Monitoring Controls
At the far right of the toolbar, a set of three monitoring controls lets you quickly control the 
output volume of your mix. An audio Enable/Disable button lets you turn audio playback on and 
off, while a slider lets you change the volume, and a DIM button lets you temporarily duck the 
monitored volume being output in order to have a quick chat with your client about sports or 
the state of the world while keeping half an ear on the mix.

The monitoring controls in the Edit page

The Clip and Track Mixer
The Audio Mixer provides a set of graphical controls you can use to assign track channels to 
output channels, set levels, pan stereo audio, and mute and solo tracks, all while you 
continue to edit.

To open the Audio Mixer, do one of the following:

�� Choose Workspace > Audio Mixer.

�� Click the Mixer button on the Interface toolbar.

The Audio Mixer exposes a set of channel strips with controls that correspond to the tracks in 
the Timeline, one for each track, plus a Main 1 bus by default that lets you adjust the overall 
level of the mix.

The Audio Mixer, with four channel strips 
corresponding to the four tracks in the Timeline
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For more information about the use of the Mixer in the Edit page, see Chapter 25, “Working 
With Audio in the Edit Page.” For more information about using the Mixer in the Fairlight page, 
see Chapter 68, “Track Level Mixing.”

Using Video Scopes
DaVinci Resolve has a set of four real-time video scopes that you can use to monitor the internal 
data levels of clips in your project as you work. Each scope provides an unambiguous graphical 
analysis of the various characteristics of the video signal, showing you the relative strength and 
range of individual color components including luma, chroma, saturation, hue, and the red, 
green, and blue channels that, together, comprise the color and contrast of the images in 
your program.

To open video scopes from the Media, Color, or Deliver pages, do one of the following:

Choose Workspace > Video Scopes > On/Off (Command-Shift-W) to open video 
scopes into a floating window.

Choose Workspace > Dual Screen > On to open video scopes as part of a dual 
screen layout.

Video scopes in a floating window

The video scopes aren’t just available in the Color page. They’re also available in the Media and 
Deliver pages for whenever you need to evaluate the video signal more objectively, such as 
when you’re setting up to capture from tape or scan from film, or when you’re setting up 
for output.

For more information on using the Video Scopes, see Chapter 40, “Using the Color Page.”
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Navigating the Edit Page 
Using the Keyboard
The following keyboard shortcuts can be used to give focus to different parts of the Edit page 
in order to select bins, clips, the Source and Timeline Viewers, the Timeline, the Effects Library, 
Edit Index, and Inspector.

Key Function

Q Toggle between Source and Timeline Viewers.

Command-1 Source Viewer

Command-2 Timeline Viewer

Command-3 Timeline

Command-4 Bin List

Command-5 Media Pool

Command-6 Effects Library

Command-7 Edit Index

Command-8 n/a

Command-9 Inspector

Dual Monitor Layout
The Edit page has a dual monitor layout that provides maximum space for the Timeline and 
Viewers on the primary monitor, and an enlarged Media Pool, simultaneously displayed 
Timelines browser, Edit Index, Effects Library, and Metadata Editor on the secondary monitor.

To enter dual screen mode:

Choose Workspace > Dual Screen > On.
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The Edit page in dual-screen mode

To switch which UI elements appear on which monitors:

Choose Workspace > Primary Display > Display 1 or Display 2, which reverses the 
contents of both monitors in dual screen mode.

Customizing the Edit Page
The default layout is quite efficient for a number of tasks on most displays. You can always 
return to the default layout by choosing Workspace > Reset UI Layout. However, the Edit page 
can be customized to create more room for specific areas of the interface to accommodate 
different tasks.

To resize any area of the Edit page:  
Drag the vertical or horizontal border between any two panels to enlarge one and 
shrink the other.

To expand the width of the Timeline:  
Click the Media Pool/Effects Library/Edit Index height button to reduce the area used 
by the Media Pool, Effects Library, and/or Edit Index to shrink to half height. At this size, 
the Media Pool/Effects Library/Edit Index are restricted to the top of the UI (you can 
only show one at a time), and the Timeline takes up the full width of your display.

Hiding the Edit Index and the Effects Library causes the Timeline to expand to the full 
width of your screen.

To resize the height of individual video or audio tracks:  
Move the pointer to the top border of any video track header, or the bottom border of 
any audio track header, and when it becomes a resize cursor, drag that border up or 
down to resize that track. Each track can have an independent size when you do this.

To enable a full-screen timeline in Dual Screen mode:  
Choose Workspace > Layout > Dual Screen > Full Screen Timeline, which causes the 
Timeline to fully occupy the primary display, while the Browser, Viewers, Audio Mixer, 
Edit Index, and Effects Library appear on the secondary display.
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To customize the columns in the Edit Index:  
To show or hide columns in the Edit Index: Right-click any column header, and choose 
the column you want to show or hide from the contextual menu. Checked columns are 
shown, unchecked columns are hidden.

To resize any column of the Edit Index:  
Move your pointer over the divider between any two columns and drag when the 
horizontal resize cursor appears.

To sort the Edit Index by any column:  
Click the Option button at the top right to display all active tracks, just the video, or just 
the audio tracks.

To rearrange Edit Index columns:  
Drag the header of any column to the left and right to move that column.

To show and hide the Audio Meters or Audio Mixer:  
Click the Mixer button in the UI Toolbar.

To switch between the Audio Meters and the Audio Mixer:  
Choose Meters or Mixer from the Option menu at the top right corner of the Mixer.

Undo and Redo in the Edit Page
The Edit page shares its multiple-undo stack with the Fairlight page. However, the Edit and 
Fairlight page undo stack is entirely separate from the multiple-undo stacks maintained for each 
clip in the Color page, making it easy and reliable to undo edits and other changes you make in 
the Timeline without disturbing your work in the Color page. 

There are two ways you can undo. 

To undo and redo:

Press Command-Z to Undo, and Shift-Command-Z to Redo.

To undo and redo using the Undo list:

1	 Choose Edit > Undo List.

2	 When the History dialog appears, click an item on the list to undo back to that point. 
The most recent thing you’ve done appears at the bottom of this list.

The Undo List

3	 When you’re done, close the History window.
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Chapter 15

Creating and 
Working 
with Timelines
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Creating and Working with Timelines
In this chapter, you’ll learn how to create and modify the timelines into which you edit clips to 
create the edited sequences that are your programs.

This chapter covers the following topics:

Creating and Duplicating Timelines	 304

Creating Blank and Stringout Timelines	 304

Creating Timelines by Drag and Drop	 305

Creating Timelines From Bins and Selections	 305

Duplicating Timelines	 306

Timeline View Options	 306

Modifying Timeline Tracks	 307

Naming Timeline Tracks	 308

Using Timeline Snapping and Zooming	 308

Scrolling Through the Timeline 	 309

Resizing the Timeline’s Video and Audio Track Regions	 309

Comparing Timelines	 310

The Timeline Comparison Window	 310
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Creating and Duplicating Timelines
If you’re not importing a project that’s been edited elsewhere, you can create a new timeline to 
cut together a new edit from scratch, or to grade a set of dailies. When you create a new 
timeline, you can either create a timeline that contains all clips found in the Media Pool to 
quickly create a big batch of offline dailies, or an empty timeline that’s ready for you to add 
specific clips to.

Creating Blank and Stringout Timelines
If you’re cutting a new program, you’ll want a blank timeline. However, it’s often useful to create 
blank timelines when putting together dailies. For example, you could create an empty timeline, 
sort the Media Pool by reel name, and add all clips from a particular reel to a dedicated timeline.

To create a new blank timeline:

1	 Select or create a Folder in the Bin list in which to put the new timeline (optional).

2	 Do one of the following:

�� Choose File > New Timeline (Command-N).

�� Right-click within the Media Pool, and choose Timelines > Create New Timeline.

3	 When the New Timeline Options window opens, set the following options:

�� Start Timecode: You can change the Start Timecode if a specific start time 
is required.

�� Timeline Name: Enter a name into the Timeline Name field.

�� No. of Video Tracks: Enter how many video tracks you want to have. You can also 
drag within this field to adjust the number of video tracks with a virtual slider.

�� No. of Audio Tracks: Enter how many audio tracks you want to have. You can also 
drag within this field to adjust the number of audio tracks with a virtual slider.

�� Audio Track Type: Choose the channel mapping you want the new audio 
tracks to use.

�� Empty Timeline: Checked by default, this sets new timelines to be created empty. 
If you turn off the Empty Timeline checkbox, the new Timeline that’s created will 
contain all media found within the Media Pool, effectively creating a stringout of 
everything you’ve imported.

�� Use Selected Mark In/Out: Only available when “Empty Timeline” is turned off. When 
you turn this checkbox on, each clip’s duration in the new Timeline is defined by the 
In and Out points saved within each clip. If there are no In/Out points in a clip, the 
clip’s entire duration is used.

4	 Click Create New Timeline.

A new timeline is created. If necessary, you can duplicate an existing timeline in order to alter 
an edit or create an alternate grade.

TIP: If you’re going to be creating several new timelines with a specific set of 
parameters, you can open the User pane of the Preferences and edit the New 
Timeline Settings, found in the Editing panel. This will define new presets that 
populate the New Timeline Options window from that point forward.
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Creating Timelines by Drag and Drop
When you first create a new project, no timeline inhabits the Timeline Editor, and you have an 
opportunity to create a new timeline by drag and drop.

To create a timeline by dragging and dropping a clip:

Drag any clip into the empty Timeline Editor area underneath the Viewers on the 
Edit page, and a new timeline will automatically be created.

Creating Timelines From Bins and Selections
The “Create Timeline Using Bin” and “Create Timeline Using Selected Clips” commands let you 
quickly assemble a timeline using the contents of the Media Pool, using whatever In and Out 
points have been added to each clip, and using the sort order of the enclosing bin to determine 
the order in which the clips will be assembled.

To create a timeline using the full contents of a bin:

1	 (optional) Put the Media Pool into List mode, set In and Out points for each clip in your 
Bin, and sort the Media Pool by the column that will put all clips in the order you want 
them to be assembled.

2	 Right-click the bin in the Bin list, and choose “Create Timeline Using Bin.”

3	 Type the name of the new timeline in the New Timeline Properties dialog. If you want 
to use the In and Out points of each clip, make sure “Use Selected Mark In/Out” is 
checked, and click Create New Timeline.

To create a timeline using manually selected clips:

1	 (optional) Put the Media Pool into List mode, set In and Out points for each clip in your 
Bin, and sort the Media Pool by the column that will put all clips in the order you want 
them to be assembled.

2	 Select one or more clips you want to assemble into a new timeline.

3	 Right-click one of the selected clips, and choose “Create Timeline Using 
Selected Clips.”

4	 Type the name of the new timeline in the New Timeline Properties dialog. If you want 
to use the In and Out points of each clip, make sure “Use Selected Mark In/Out” is 
checked, and click Create New Timeline.

TIP: These commands are especially useful for putting together quick assembly edits 
if you have metadata-rich media with scene, shot, and take information that you can 
use to sort clips into the proper order, and In and Out points that you’ve 
already logged.
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Duplicating Timelines
You can also duplicate existing timelines in preparation for saving a copy prior to making 
modifications, or as a starting point for a different version of your content.

To duplicate a Timeline:

Right-click any timeline in the Media Pool, and choose Timelines > Duplicate Timeline 
from the contextual menu. The duplicate timeline appears with “copy” appended 
to the name.

Timeline View Options
As you’re working on an edit, it can often be useful to modify the appearance of the Timeline, 
changing the height of video or audio clips, choosing whether audio waveforms are drawn or 
not, etcetera. Using the Timeline View Options pop-up at the bottom right of the Timeline, you 
can make these kinds of changes as you work.

The Timeline View Options pop-up

Where Are Timelines Stored?

Ordinarily, timelines are created in the currently selected Media Pool bin. However, if 
you’d enabled “Use Timelines Bin” in the General Options panel of the Project Settings 
before you added anything to the Media Pool, a dedicated Timelines bin appears at 
the top of the Bin List, which contains all timelines in a project. 

When using the Timelines bin, you’re prevented from putting timelines into any other 
bin of the Media Pool. Whenever you create or import a new timeline, it automatically 
appears in the Timelines bin. You can add subfolders to the Timelines bin for more 
specific organization.

If you don’t want this kind of strict organization, but you would like an easy way to 
browse all the timelines in your project at once, regardless of their diverse locations, 
you can enable the “Create Smart Bin for Timelines” option, which is in the Editing 
panel of the User Preferences. This creates a Smart Bin in the Bin List of the Media 
Pool that filters all timelines in your project, making it easy to see all your timelines 
without altering your original organization.
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You have the following options:

�� Track appearance buttons: Three buttons let you choose the overall appearance of 
video and audio tracks. From left to right, the options are: Video Filmstrips, Video tracks 
with thumbnails, Minimized tracks.

�� Show Audio Waveforms checkbox: Lets you turn audio waveform viewing off and on. 
When Audio Waveform is turned off, audio tracks are minimized.

�� Show Flags and Markers checkbox: Lets you turn the drawing of Flags and Markers 
off and on.

�� Video track height slider: Lets you resize the size of all video tracks at once, 
independently of the audio tracks.

�� Audio track height slider: Lets you resize the size of all audio tracks at once, 
independently of the video tracks.

In addition, any track in the Timeline can be individually resized by dragging its top divider in 
the Track Header area.

Resizing an individual Timeline track by dragging its top border in the Track Header

Modifying Timeline Tracks
When you’re getting ready to edit clips into the Timeline, you need to make sure you’ve got 
enough tracks to do the job. The following procedures cover the different methods available for 
adding, removing, and rearranging tracks as you work. These commands are all available via 
the contextual menu that appears when you right-click anywhere in the Timeline header area 
(the header of the Timeline is the area to the left where each track’s various buttons and 
controls are located).

Methods for adding, deleting, and rearranging tracks:

�� To add a track to the Timeline: Right-click anywhere in the Timeline header and 
choose Add Track. If you add an audio track, you can choose what type of channel 
mapping you want. For more information about audio track channel mappings, see 
Chapter 25, “Working with Audio in the Edit Page.”

�� To add multiple tracks to the Timeline at a specific position: Right-click anywhere in 
the Timeline header and choose Add Tracks. When the Add Tracks dialog appears, 
choose the number of video and audio tracks you want to add, choose the position you 
want to insert the tracks above or below, and choose the Audio Track Type you want to 
add if you’re adding audio tracks. When you’re done, click “Create New Tracks.”

�� To delete a track from the Timeline: Right-click within a track’s Timeline header and 
choose Remove Track. If there are clips on a track you remove, they are deleted from 
the Timeline.
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�� To delete all unused tracks in the Timeline: Right-click anywhere in the track header 
area and choose Delete Empty Tracks. All tracks without clips will be deleted at once.

�� To move tracks and the clips on them up and down: Right-click within a track’s 
Timeline header and choose Move Track Up or Move Track Down from the contextual 
menu. That track, along with all clips on it, will be moved up or down relative to the 
other tracks in the Timeline.

Naming Timeline Tracks
If you’re a stickler for organization, you can also name the tracks on a timeline to identify 
its purpose.

To rename a track:

1	 Make sure the Timeline View Options are set to either the Filmstrip view or the 
Thumbnail view, and that audio tracks are tall enough, so that track names are visible.

2	 To edit the name of any track, click the default “Video X” or “Audio X” track name to 
select it, then type your preferred name and press the Return key.

Using Timeline Snapping and Zooming
When preparing to make an edit into the Timeline, you can set the snapping and zoom controls 
to whichever state is most useful for the operation you need to perform. For example, if you’re 
editing an insert shot into a rapid-fire section of edits in the Timeline, you may want to zoom in 
to better see the exact place where you want to place the incoming clip. Since there are many 
edits at that point, disabling snapping might make it useful to avoid having the clip jump to the 
nearest edit point if you need to move the incoming clip to a very specific frame.

Playhead Snapping and Timeline Zoom:

�� To turn clip and playhead snapping on and off: Click the Snapping button in the 
toolbar, or press N. When snapping is turned on, the In and Out points and markers 
of clips all snap to one another and to the playhead. You can also press N to turn 
snapping on or off while dragging a clip in the Timeline.

The snapping button in the toolbar

�� To zoom into and out of the Timeline: Drag the zoom slider to the left to zoom out, and 
right to zoom in. You can also press Command-Minus (–) and Command-Equal (=) to 
zoom out and in. Either way, zooming is always centered on the current position of the 
playhead, even if the playhead is off screen.

�� To frame every clip into the width of the Timeline: Press Shift-Z. This is a toggle, 
so pressing Shift-Z frames your whole edited sequence to the width of the Timeline, 
and then pressing Shift-Z again returns the Timeline to whatever level of zoom you 
were using previously. Using this keyboard shortcut makes it really easy to navigate 
the Timeline when you’re zoomed in, as you can press Shift-Z, move the playhead to 
another part of the Timeline you want to work on, and then press Shift-Z again to zoom 
back into the new location of the Timeline.
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Scrolling Through the Timeline 
When you’re zoomed into the Timeline, there are several methods you can use to scroll around 
as you work.

�� You can scroll left and right, or up and down, by dragging the Timeline’s horizontal and 
vertical scroll bars. 

�� You can also scroll up and down the tracks of the Timeline using the scroll wheel, scroll 
ball, or scroll gestures of your mouse, trackball, trackpad, or other pointing device. 

�� You can also scroll within the Timeline by middle-clicking and dragging in any direction, 
which works the same as panning around a viewer that you’ve zoomed into. This frees 
you from having to use the scroll bars as you move around your edited clips.

If you scroll past the position of the playhead, a small playhead indicator appears in the bottom 
scroll bar to let you know where it is relative to the entire duration of your edited sequence.

A small indicator shows the position of the playhead if it’s 
outside of the visible area of the Timeline

Resizing the Timeline’s Video 
and Audio Track Regions
If you need to see more of the video or audio tracks in the available area of the Timeline, you 
can drag the horizontal divider that separates the audio and video tracks up or down to create 
room where you need it.

Dragging the Timeline center divider to make 
more room for audio or video tracks
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Comparing Timelines
For instances where you’re importing multiple versions of a timeline that’s been edited in 
another application, or where you’re working with multiple editors on different versions of the 
same Timeline in either collaborative mode or on multiple separate DaVinci Resolve 
installations, DaVinci Resolve provides a method of comparing two timelines with one another. 
Using the Timeline Comparison window, you can both see a visual comparison of which 
sections of two timelines differ, and you can derive a more traditional change list by opening up 
the Difference Index.

To compare two timelines:

1	 Open the first timeline you want to compare.

2	 Right-click a second timeline in the Media Pool, and choose Compare With 
Current Timeline.

A Timeline Comparison window appears, showing you the currently opened Timeline at 
the bottom and the Timeline you right-clicked at the top.

The Timeline Comparison Window
When you first open the Timeline Comparison window, the first thing you see is a pair of 
miniature timelines. The currently open Timeline appears at the bottom and the Timeline you 
right-clicked appears at the top.

The Timeline Comparison window

Comparison Window Playhead Output
By default, the two playheads are ganged together, with the top playhead being displayed in 
the Source Viewer, and the bottom playhead being displayed in the Timeline Viewer. These 
playheads can be unganged if you want to compare different areas of both timelines, simply by 
turning off Gang Playheads in the option menu.

Highlighting Differences
Special highlights indicate sections of both timelines that are different. Individual changes are 
not individually highlighted, although they can be seen, on the premise that you’re more 
interested in a section by section analysis of what your collaborating editor has been doing, for 
purposes of deciding whether to incorporate changes or reversions based on this comparison.
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Each section of differences between the two timelines are highlighted

When using this tool, you can change the bottom Timeline to match the top Timeline, on a 
section by section basis, by right-clicking a highlighted section and choosing Accept Change 
from the contextual menu. When you do this, the currently open Timeline is immediately 
changed to incorporate the altered section from the Timeline you’re comparing to. If necessary, 
you can undo this.

Identifying Differences Using Clip Labelling
You can also use the Timeline Comparison window to use clip labeling to indicate all 
differences between the comparison Timeline and the currently open Timeline. The method for 
doing this has not yet been defined at the time of this writing.

The Change List
Clicking the Diff Index button opens the change list, which shows you a more conventional item 
by item comparison of the differences between the two timelines. 

The Change List of the Timeline Comparison window

The method of exporting this change list has not yet been defined at the time of this writing.
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Chapter 16

Preparing Clips 
for Editing and 
Viewer Playback
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Preparing Clips for Editing 
and Viewer Playback
Before you start editing, there are a wide variety of things you can do to prepare your clips for 
editing. In this chapter, you’ll learn how to browse, select, and play through clips that you need 
to log, adding markers, setting In and Out points, and creating subclips as you identify pieces 
you’ll be using later as you edit. 

This chapter covers the following topics:

Browsing Clips in the Media Pool	 314

Selecting Clips in the Media Pool to Edit	 315

Duplicating Clips in the Media Pool	 316

Viewer Playback and Navigation	 316

Source and Timeline Viewers vs. Single Viewer Mode	 317

Opening Clips Into the Source Viewer to Prepare for Editing	 317

Viewer Transport Controls	 318

Simple Keyboard Shortcuts for Playback and Navigation	 319

Using JKL to Control Playback	 320

Special-Purpose Playback Commands	 320

Enabling and Disabling Audio Scrubbing	 321

Playback Post-Roll	 321

Moving the Playhead Using Timecode	 321

How to Enter Timecode Values	 322

Gang Viewers (Playhead Ganging)	 323

Adding Markers	 323

Adding Markers to Clips	 323

Setting In and Out Points	 324

Saving In and Out Point Ranges as Markers with Duration	 326

Organizing Media by Creating Subclips	 327
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Browsing Clips in the Media Pool
The following procedures show how to select one or more clips in the Media Pool to accomplish 
various editing tasks, either by opening a clip in the the Source Viewer, or selecting a group of 
clips with which you want to do drag and drop editing. This section starts by presenting 
different ways you can browse the contents of the Media Pool to find clips you want to use, in 
preparation for making a selection for your next operation.

Methods of browsing clips in the Media Pool:

�� Using thumbnail hover scrub in the Media Pool’s Thumbnail view: Drag the pointer 
over a thumbnail to scrub though its contents.

Thumbnail hover scrubbing

�� Using the Media Pool Filmstrip in the Media Pool’s List view: Select a clip to expose it 
in the Filmstrip at the top of the Media Pool, and hover the pointer over the Filmstrip to 
watch it play. At any time, you can double-click a clip in the Filmstrip to open it into the 
Source Viewer.

Using the Filmstrip when the Media Pool is in List view

TIP: When browsing media, you can open clips you want to have a closer look 
at in the Source Viewer by double-clicking them in the Media Pool. Meanwhile, 
you can continue to open other clips in the Filmstrip with a single clip in order 
to compare different clips with your main selection that remains in the Viewer.
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Selecting Clips in the Media Pool to Edit
Once you’ve found one or more clips that you want to use in your edit, you’ll need to make a 
selection in preparation for performing an edit.

Methods of selecting clips in the Media Pool using the mouse:

�� To select a single clip using the mouse: Click a clip in the Media Pool with the mouse. 

�� To select a contiguous range of clips: In either Thumbnail or List view, drag a selection 
box over all the clips you want to select, or click to select the first clip in a series, then 
Shift-click the last clip to select those clips and everything in between.

Selecting a contiguous range of clips

�� To select a noncontiguous range of clips: Command-click each clip you want to 
include in the selection. Or, you can hold the Command key down while you drag 
bounding boxes over unselected clips to add them to the current selection, or over 
selected clips to remove them from the selection.

Selecting a discontiguous range of clips

�� To select all clips in the Media Pool: Make sure the Media Pool has focus by clicking a 
clip or clicking anywhere in the background of the Media Pool, then press Command-A 
to select all clips.
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Methods of selecting clips using the keyboard:

�� To navigate the Bin list: Either click any bin in the Bin list to the left of the Media Pool, 
or press Command-4 to make the Bin list the active pane of the Edit page, then use 
the Up and Down Arrow keys to to move up and down among the available bins. Use 
the Right Arrow key to open a bin that’s closed, and use the Left arrow key to close the 
bin again.

�� To select a single clip using the keyboard: Press Command-5 to make the Media 
Pool browser the active pane of the Edit page, then use the Arrow keys to change the 
selection from clip to clip in the Media Pool, up, down, left, and right. Once a clip is 
selected, you can press an edit keyboard shortcut to edit the selected Media Pool clip 
straight to the currently open Timeline.

�� To select multiple clips using the keyboard: Hold the Shift key down while you’re using 
the Arrow keys to move the selection to expand or contract a continuous selection in 
the Media Pool.

�� To open a selected clip into the Source Viewer: Press the Enter or Return key. Once 
you’ve opened a clip into the Source Viewer, you can use the transport controls to play 
through it.

Duplicating Clips in the Media Pool
If you want to create duplicates of clips in the Media Pool, you can Option-drag one or 
more clips to another bin. The duplicate clips have their own individual links to the source 
media on disk.

Viewer Playback and Navigation
By default, the Edit page presents a traditional source/record style editing experience. The 
Source Viewer lets you view individual clips from the Media Pool to prepare them for editing. 
Meanwhile, the Timeline Viewer lets you play through your program, showing you the frame at 
the position of the playhead in the Timeline. 

Source and Timeline Viewers
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Source and Timeline Viewers vs. Single Viewer Mode
If you want to change the Edit Page layout to hide the Source Viewer, you can choose View > 
Single Viewer Mode to instead use just a single viewer to contextually display either a selected 
Source Clip or the current frame of the Timeline.

Single Viewer mode

In Single Viewer mode, whatever you select in the Media Pool or Timeline determines which 
controls appear in the Viewer, which lets you do nearly everything you can do with two 
simultaneously open viewers.

Opening Clips Into the Source Viewer to Prepare for Editing
Once you’ve decided which clips you want to use in your program, you can open them into the 
Source Viewer to review them more completely. How this works depends on the Source 
Viewer’s Live Media Preview setting.

To skim through a Media Pool thumbnail and view clips in the Source Viewer using Live 
Media Preview:

1	 Turn on Live Media Preview (if necessary) by clicking the Source Viewer option menu 
and choosing Live Media Preview.

2	 With the Media Pool open and in Thumbnail mode, position the pointer over a clip, 
and after a few moments when that clip’s thumbnail starts to skim, you can see the clip 
you’re scrubbing in the Source Viewer. Do one of the following:

a.	� As you skim within the thumbnail, the playhead that appears in the thumbnail is locked 
to the playhead displayed in the Viewer’s jog bar. While skimming, you can add markers 
and set In and Out points.

b.	� Leaving the pointer positioned over that clip, use the JKL keyboard shortcuts to play 
through the clip, adding markers and setting In and Out points as you like.

3	 It takes a moment for skimming to begin, which allows you to quickly move the pointer 
from that clip back to the Source Viewer without opening any other clip.

Turning off Live Media Preview lets you use more traditional and controlled methods of opening 
clips into the Source Viewer.
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To open a clip into the Source Viewer using the mouse:

Double-click any clip in the Media Pool, or in the Filmstrip of the Media Pool, to open it into the 
Source Viewer.

To open a clip into the Source Viewer using the keyboard:

1	 If necessary, press Command-4 to select the Bin list, and press the Up and Down 
arrows to choose a folder to view its contents. Press the Right Arrow key to open 
folders and show any nested folders within, or the Left Arrow key to close folders and 
hide their nested contents. 

2	 Press Command-5 to select the Media Pool browser, and use the Arrow keys to change 
the selection from clip to clip in the Media Pool, up, down, left, and right. 

3	 When the clip you want is highlighted, press Return to open it into the Source Viewer.

To open a timeline into the Source Viewer:

Drag and drop any timeline into the Source Viewer in preparation for either ganging it 
to the existing Timeline, or editing it, in whole or in part using In and Out points, into the 
currently open Timeline.

Viewer Transport Controls
The Edit page has two Viewers. The left Viewer, when you’re editing, should be set to show 
either source video or source audio, so it shows the source clip in any edit you’re setting up. 
At right is the Timeline Viewer, that shows the frame at the current position of the playhead in 
the Timeline. Using the Source and Timeline Viewers, you can set up a wide variety of edits.

There are identical transport controls underneath each of the Viewers.

The transport controls at the bottom of the Source Viewer

A jog bar appears directly underneath the transport controls, letting you drag the playhead 
directly with the pointer. The full width of the Source Viewer’s jog bar represents the full 
duration of a clip, while the full width of the Timeline Viewer’s jog bar represents the full 
duration of the current timeline. The current position of each playhead is shown in the timecode 
field at the upper right-hand corner of each viewer.

Monitoring With An External Video Display

While working in the Edit page, the image that’s displayed on an external 
video display (if one is connected) is determined either by the current 
selection in the Media Pool, or by which part of the Edit page interface has 
focus. For example, if you select a clip in the Media Pool so it’s displayed 
within the Filmstrip, that clip is output to video. If you then open it into the 
Source Viewer, then the contents of the Source Viewer are output to video. 
If you switch to the Timeline Viewer, then your timeline is output to video.
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A separate jog control, to the left of the other transport controls, provides a way to jog more 
slowly through long clips or a long timeline. Click and drag to the left and right to move through 
a clip or the Timeline a frame at a time.

Transport controls appear above the jog bar. In the Source Viewer, these controls let you Jump 
to the First Frame, Play Reverse, Stop, Play Forward, and Jump to the Last Frame. In the 
Timeline Viewer, these control move to the Previous Edit, Play Reverse, Stop, Play Forward, and 
move to the Next Edit.  A loop control governs the looping behavior during playback.

Simple Keyboard Shortcuts for Playback and Navigation
There are many different keyboard shortcuts you can use to simply navigate clips and timelines, 
and control playback.

�� Spacebar: You can use the spacebar to start and stop playback.

�� Step One Frame Forward/Step One Frame Back: The Left Arrow and Right Arrow keys 
move the playhead back and forth one frame at a time, while Shift-Left Arrow and Shift-
Right Arrow move the playhead in one second increments.

�� Step One Second Forward/Step One Second Reverse: Shift-Left Arrow and Shift-Right 
Arrow moves the playhead back and forth one second at a time.

�� Next Edit/Previous Edit: Up Arrow moves the playhead to the previous edit and selects 
the edit point, while Down Arrow moves the playhead to the next edit and selects the 
edit point.

�� First Frame/Last Frame of the Current Clip: The Semicolon key moves the playhead 
to the first frame of the clip intersecting the playhead, while the Apostrophe key moves 
the playhead to the last frame of the clip intersecting the playhead.

�� Previous Keyframe/Next Keyframe: Shift-Semicolon moves the playhead to the next 
previous keyframe on the left when keyframes are displayed in the Timeline, while 
Shift-Apostrophe moves the playhead to the next keyframe to the right.

�� Previous Marker/Next Marker: If there are markers in either the Timeline Ruler or within 
clips in the Timeline, Shift-Up Arrow and Shift-Down Arrow moves the playhead left and 
right from one marker to the next.

�� Previous Gap/Next Gap: If any tracks of the Timeline that have auto-select control 
enabled have gaps between clips, Option-Command-Semicolon and Option-
Command-Apostrophe moves the playhead left and right from one gap to the next.

�� Timeline Start/Timeline End: The Home key moves the playhead to the first frame of 
the Source or Timeline Viewer, while the End key moves the playhead to the last frame 
of the Source or Timeline Viewer.

�� Go to In Point/Go to Out Point: Shift-I moves the playhead to the In point set in either 
the Viewer or the Timeline. Shift-O moves the playhead to the Out point.

TIP: One of the options in the Editing panel of the User Preferences window, “Always 
highlight current clip in the media pool,” lets you decide whether the current selection 
in the Timeline is mirrored in the Media Pool.
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Using JKL to Control Playback
The JKL keyboard shortcuts are common to many editing applications, and experienced editors 
know these to be some of the most useful controls for playback and editing there are. Here’s a 
list of the many different ways you can use these three keyboard shortcuts to play through clips 
and timelines as you work.

J Plays 100% backward.

K Stops playback.

L Plays 100% forward

Press J repeatedly
Increases backward play speed each time you press J, for a range of 
fast-reverse speeds.

Press L repeatedly
Increases forward play speed each time you press L, for a range of 
fast-forward speeds.

Shift-J Plays in fast reverse.

Shift-L Plays in fast forward.

K+J Plays backward at slow motion (with slow motion audio playback).

K+L
Plays forward at slow motion (with pitch-corrected audio 
playback on OS X).

Pressing K while tapping J Moves the playhead back one frame.

Pressing K while tapping L Moves the playhead forward one frame.

Command-J and Command-L

Holding the Command key down while using the J and L keyboard 
shortcuts lets you dynamically resize or trim selected edit points or 
clips at 100 percent or faster speed, depending on whether the 
Selection or Trim tool is enabled. More information on dynamic 
trimming appears later in this chapter.

Once you learn all the different methods of JKL playback, they will probably become one of the 
main ways you move the playhead around in DaVinci Resolve.

Special-Purpose Playback Commands
In addition to the standard transport controls, there are some additional playback controls, 
available via keyboard shortcuts or the Playback menu, that let you perform different playback 
operations.

�� Loop: Command-Forward Slash (/). Toggles looped playback off and on. While 
looped playback is on, playback initiated with any of the following commands will loop 
automatically until you stop playback.

�� Play around selection: Forward Slash (/). This command works contextually depending 
on what’s selected in the Timeline. Plays a section of the Timeline from x frames before 
to y frames after (a) the playhead (if nothing’s selected), (b) the currently selected edit 
point, (c) the currently selected clip, (d) a selection of multiple clips. This command is 
useful for previewing how the current selection plays within the context of the clips 
immediately surrounding it. The pre-roll and post-roll time is customizable in the Editing 
panel of the User Preferences.
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�� Play around current frame: Plays a section of the Timeline from x frames before to y 
frames after the current position of the playhead. This command is useful for previewing 
how edits play within the context of the clips immediately surrounding them. The pre-
roll and post-roll time is customizable in the Editing panel of the User Preferences.

�� Play around current clip: (no default key assigned). Plays a section of the Timeline 
from x frames before to y frames after the current clip intersecting the position of the 
playhead. The pre-roll and post-roll time is customizable in the Editing panel of the User 
Preferences.

�� Play Around In: Option-Space. Plays a section of the Timeline from x frames before to 
y frames after the current assigned In point, letting you preview the transition from one 
clip to the next. The pre-roll and post-roll time is customizable in the Editing panel of 
the User Preferences.

�� Play Around Out: Shift-Space. Plays a section of the Timeline from x frames before to y 
frames after the current assigned Out point, letting you preview the transition from one 
clip to the next. The pre-roll and post-roll time is customizable in the Editing panel of 
the User Preferences.

�� Play In to Out: Option-Forward Slash (/). If you’ve marked a section of a clip or timeline 
with In and Out points, this command lets you preview how it will play.

�� Play to In: (no default key assigned). Initiates playback and stops at the current In point.

�� Play to Out: Option-Command-Option-Forward Slash (/). Initiates playback and stops at 
the current Out point.

Enabling and Disabling Audio Scrubbing
Audio scrubbing is enabled by default, meaning that you’ll hear audio when dragging the 
playhead with the mouse back and forth. While this can be useful when you’re searching for 
audio cues, it can also be distracting if you’re just focused on the picture.

To enable or disable audio scrubbing:

Choose Timeline > Audio Scrubbing (Shift-S)

Playback Post-Roll
Enables the playhead to continue playing past the last clip in the Timeline for a duration equal 
to the “Post-roll time” Project Setting in the Editing panel. This is good for editors that want to 
experience a few moments of  playback after cutting or fading to black after the last frame of 
audio and video in the Timeline.

To enable or disable Playback Post-Roll:

Choose Timeline > Playback post-roll

Moving the Playhead Using Timecode
You can use absolute or relative timecode entry to either move the playhead in both the Source 
and Timeline Viewers, or to move or trim selected edit points or clips. When navigating the 
Timeline, timecode entry lets you move the playhead very precisely, or jump to specific 
timecode values really quickly.
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How to Enter Timecode Values
When entering timecode, type each pair of hour, minute, second, and frame values from left to 
right, with a period representing a pair of zeros for fast entry. The numbers you enter appear in 
the timecode field at the upper left-hand corner of the Viewer with focus. When you’re finished 
typing, press the Return key to execute the timecode command. The rules for timecode entry 
are as follows:

�� The right-most pair of timecode values (or period) you enter is always the 
frame number.

�� A period to the left or to the right of any number you type is considered to be a pair 
of zeroes. 

�� A single period between two numbers is considered to either be a single zero, or 
ignored if it’s between two pairs of numbers.

�� Any untyped pairs of values to the left of what you enter are assumed to be whatever 
those values were prior to the timecode you entered; this makes it easy to type partial 
timecode values even when the Timeline starts at hour one. 

�� It’s not necessary to enter colons or semicolons. 

Absolute timecode is entered simply by typing in a timecode value. So long as no clips or edit 
points are selected when you press the Return key, the playhead will move to that timecode 
value. If an edit point or clip is selected, those will be moved or trimmed to the corresponding 
timecode value, if possible.

Here are some examples of absolute timecode entry using this method:

Original TC Value User-Typed Value New TC Value

01:10:10:10 15245218 15:24:52:18

01:10:10:10 2.. 01:02:00:00

01:10:10:10 15 01:10:10:15

01:10:10:10 12 01:10:10:12

01:10:10:10 1.2 01:10:01:02

01:10:10:10 115.. 01:15:00:00

01:10:10:10 23... 23:00:00:00

Relative timecode is entered by starting the timecode value with a plus (+) or minus (–). Adding 
a plus results in the value you type being added to the current timecode value for purposes of 
offsetting the playhead or moving a selection. Adding a minus will subtract the value you type 
from the current timecode value.

Here are two examples of  relative timecode entry:

+20.	 00:00:20:00 is added to the current timecode value.

-5	 00:00:00:05 is subtracted from the current timecode value. 



323

P
re

p
ar

in
g

 C
lip

s 
fo

r 
E

d
iti

ng
 a

nd
 V

ie
w

e
r 

P
la

yb
ac

k 
P

ar
t 

3 
–

 1
6

Gang Viewers (Playhead Ganging)
Ordinarily, the playhead movement in the Source and Timeline Viewers is independent. 
However, if you click the Option menu at the upper right-hand corner of either Viewer and turn 
Gang Viewers on, the movement of the Source and Timeline Viewer playheads is locked 
together, so that they move in unison. 

This is useful when you’re marking the In and Out points of a clip in the Source Viewer to match 
the duration of a clip or other event in the Timeline.

Adding Markers
While markers, flags, and clip labels are covered in much more detail elsewhere in the editing 
section, the use of markers is so important that a summary of how to add and edit markers 
appears here. Markers are used to call attention to a particular frame within a specific clip. 
Markers can be individually colored, and can have customized name and note text. Whenever 
you enter text into a marker, that marker displays a small dot that indicates there’s more 
information inside of it. Once placed, markers snap to In and Out points, edit points, the 
playhead, and other markers whenever snapping is enabled, making it easy to use markers to 
“measure” edits and trims that you make in the Timeline.

Adding Markers to Clips
You can place markers on the jog bar of source clips in the Source Viewer (or in the Media Page 
Viewer) and on clips that are selected within a timeline.

(Top) Markers placed on a source clip,  
(Bottom) Markers placed on a clip in the Timeline

To mark a source clip in the Source Viewer or Media Page Viewer, do one of the following: 

�� To place a marker without doing anything else, move the playhead to the frame you 
want to mark, and then press M. 

�� To place a marker and immediately open the marker dialog to enter a name or note 
within it during playback, press Command-M. Playback pauses until you enter the text 
you want to and close the marker dialog again, at which point playback continues.
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�� Move the playhead to the frame you want to mark, then right-click in the jog bar and 
choose a marker color from the Add Marker submenu of the contextual menu.

�� Once you’ve added some markers, you may want to edit their contents to make them 
more useful.

To open a marker’s edit dialog to alter its properties:

1	 Do one of the following:

�� Press Command-M to add a marker during playback and immediately open its 
edit dialog.

�� Double-click any marker you want to edit.

�� Move the playhead to the frame containing the marker you want to annotate using 
Shift-Up Arrow/Down Arrow and press M.

�� Select a marker anywhere in the Source Viewer or Timeline, and press Shift-M.

2	 When the marker dialog opens, you can modify several properties.

The properties found in the Marker Dialog

For much more information about markers, see Chapter 20, “Marking and Finding Clips in the 
Timeline.”

Setting In and Out Points
Now that you’ve used playback commands to review your clips, you can place In and Out points 
to set the range of each clip that you want to edit into the Timeline. If you don’t set In or Out 
points, then the entire clip will be edited into the Timeline. If you do set In and Out points, those 
points will be saved in the Media Pool and used the next time you edit that clip.

To set In and Out points while skimming a thumbnail in the Media Pool’s Thumbnail view:

Set the Media Pool to Thumbnail view, then move the pointer over a clip and wait a moment 
until dragging the pointer begins to skim through that clip. As you skim, press I and O to set In 
and Out points to encompass the part of that clip you’re going to want to use. When you’re 
finished, that clip’s thumbnail will show a range indicator at the bottom to show how much of the 
clip you’ve selected.
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To set In and Out points using the Media Pool’s List view Filmstrip: 

Set the Media Pool to List view, then select a clip to expose it in the Filmstrip at the top of the 
Media Pool, drag the pointer through the Filmstrip to watch it play, and press I and O to set In 
and Out points to the appropriate range.

Marking In and Out points in the Filmstrip of the Media Pool in List view

The Filmstrip will dim the heads and tails to let you see the range of media you’ve marked. 
Once you’ve marked In and Out points in the Filmstrip, you can drag them to the left and right to 
move them.

To set In and Out points in the Source Viewer:

1	 Either skim a Media Pool thumbnail with Live Media Preview enabled in the Source 
Viewer’s option menu, or open a clip into the Source Viewer. 

2	 Use JKL, the spacebar, the transport controls, or drag in the jog bar to move the 
playhead to where you want to set an In or Out point.

3	 Do one of the following:

�� To mark simple In and Out points: Use the In and Out buttons to the right of the 
transport controls, or press the I or O keys.

�� To mark split In and Out points in preparation for making a split edit: Right‑click 
the Jog Bar and choose Mark Split > Video In (Shift-Option-I) / Audio In 
(Command‑Option-I) / Video Out (Shift-Option-O) / Audio Out (Command-Option-O).

(Top) Marking In and Out points in the Source Viewer, both as simple  
(Bottom) Split edits

Simple In and Out points let you join the audio and video of two clips at a single edit point in the 
Timeline. However, setting split In or Out points sets you up to create split edits where the 
video is offset from the audio in a single step.
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To clear In and Out points:

�� To clear In or Out points: Move the pointer over a marked thumbnail in the Media Pool 
or over the Media Pool film strip, or open a clip in the Source Viewer, and then press 
Option-I to clear the current In point, or Option-O to clear the current Out point.

�� To clear Split In or Split Out points: Press Shift-Option-X to clear the Video In and 
Video Out points. Press Command-Option-X to clear Audio In and Audio Out points.

�� To clear both the In and Out points at once: With the pointer over a marked thumbnail 
in the Media Pool or over the Media Pool film strip, or with the Source Viewer selected, 
press Option-X.

To jump the playhead to the current In or Out points in the Source or Timeline Viewer: 

Press Shift-I to move the playhead to the current In point, 

Press Shift-O to move the playhead to the current Out point.

Once set, In and Out points remain in place within each source clip or timeline until you 
set new ones.

Saving In and Out Point Ranges 
as Markers with Duration
This chapter will be updated during the beta testing period for the final release.

If you want to log the most important sections of clips using In and Out points, you can only log 
a single section at a time, as In and Out points are used to identify the next section of a clip to 
be edited in a three point edit. However, you can save any pair of In and Out points as a marker 
with duration, which lets you identify multiple regions of a clip that you might later want to edit 
into a program.

To turn In and Out points into a marker with duration:

1	 Set In and Out points in the Source Viewer jog bar to identify a region you want to log 
for future reference.

Marking In and Out points in preparation 
to log that section of the clip

2	 Do one of the following:

Right-click the jog bar and choose Convert In and Out to Duration Marker

A marker with duration appears above the In and Out points. To edit its name or notes, 
double-click the marker, press Shift-M, or choose Mark > Modify Marker.

A marker with duration is created from the 
In and Out points

In this way, you can log several regions within a single clip for future use. 
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A clip with multiple logged sections identified via markers with duration

This an extremely useful logging technique for two reasons. First, markers with duration can be 
searched for in the Media Pool using the All Fields, Marker Name, and Marker Notes Filter by 
options. Second, they can be filtered with Smart Bins using the Marker Name and Marker Notes 
Media Pool Properties options.

Organizing Media by Creating Subclips
Subclips give you another way of organizing media in the Media Pool, letting you break 
excessively long clips into shorter ones. For example, if the director of a project is fond of 
“rolling takes” where multiple takes are all recorded within a single clip, you can break these 
takes up by making them into subclips.

To create a subclip in the Edit page:

1	 Do one of the following to open a clip into the Source Viewer in either the Media page 
or the Edit page, in preparation for creating subclips.

�� Double-click any clip in the Media Pool.

�� Single-click any clip in the Media Library of the Media page to create a subclip 
without needing to first import that clip into the Media Pool.

2	 Set In and Out points in the Source Viewer to define the section you want to turn into 
a subclip.

3	 Do one of the following:

�� Choose Mark > Create Subclip

�� Press Option-B

�� Right-click the jog bar and choose Make Subclip from the contextual menu

A new subclip appears in the Media Pool, automatically selected so that you can 
immediately edit its metadata in the Metadata Editor.

Once created, subclips appear and work like any other clip in DaVinci Resolve. You can also 
create subclips in the Media page while performing other organizational tasks there.



328

E
d

iti
ng

 B
as

ic
s 

P
ar

t 
3 

–
 1

7

Chapter 17

Editing Basics



329

E
d

iti
ng

 B
as

ic
s 

P
ar

t 
3 

–
 1

7

Editing Basics
In this chapter, you’ll learn many of the fundamental methods and commands you’ll use when 
beginning to assemble clips into the Timeline. This includes drag and drop operations to begin 
assembling a timeline, different ways of selecting and deselecting the clips you’ve edited in 
preparation for different tasks, maintaining sync between the audio and video components of 
clips you’re editing, and deleting clips and gaps you don’t want.

This chapter covers the following topics:

Drag and Drop Editing	 330

Drag and Drop Editing of Individual Clips Into the Timeline	 330

Drag and Drop Editing of Several Clips Into the Timeline At Once	 331

Drag and Drop Editing of Video-Only or Audio-Only Edits	 332

Dragging Clips From the macOS Finder Into the Timeline	 333

Other Ways of Assembling Edits Into the Timeline	 333

Example: Assembling Clips Into the Timeline From the Source Viewer	 333

Example: Assembling Clips Into the Timeline from the Media Pool	 335

Making Selections in the Timeline	 336

Manually Selecting Clips in the Timeline	 336

Selecting Clips Based on Markers, Flags, and Clip Color	 337

Selecting Edits in the Timeline	 337

A Practical Example of Keyboard-Driven Selections	 339

Using Auto Select Controls to Define Selections	 340

Defining Selections With the Help of Auto Select Controls	 340

Overriding Automatic Selections By Making Manual Selections	 340

Using Auto Select Controls to Control Other Operations	 341

Locking Tracks You Don’t Want to Change	 343

Position Lock	 343

Position Locking All Tracks	 344

Position Locking Individual Tracks	 344

Disabling and Re-Enabling Clips in the Timeline	 345

Deleting Clips and Gaps from the Timeline	 345

Finding, Selecting, and Deleting Gaps in the Timeline	 347

Audio/Video Linking	 348

Controlling Audio/Video Linking While Making Selections	 348

Dealing with Audio Video Sync Offsets	 348

Manually Unlinking and Relinking Audio and Video	 349

Linking Multiple Clips in the Timeline	 350

Commands for Slipping Audio/Video Sync	 350
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Drag and Drop Editing
If you’ve already used other editing programs, the procedures in this section will almost 
certainly be remedial, but if you’re just getting started, this section covers the most basic 
methods of editing a series of clips into the Timeline. The simplest method of editing is to drag 
clips from the Media Pool and drop them into the Timeline. You can do this with individual clips, 
or with selected groups of clips.

Drag and Drop Editing of Individual Clips Into the Timeline
If you’re just editing one clips at a time to create an edited sequence in a timeline, this is how 
that works.

1	 If you need to edit specific ranges of the clips you’re editing, you can set In and Out 
points in source clips first by doing one of the following:

Setting In and Out points while skimming a thumbnail in the Media Pool: As you’re 
skimming over a clip’s thumbnail in the Viewer, press I and O to set In and Out points to 
encompass the part of that clip you’re going to want to use. When you’re finished, that 
clip’s thumbnail will show a range indicator at the bottom to show how much of the clip 
you’ve selected.

Using the Media Pool Filmstrip in the Media Pool’s List view: Set the Media Pool to 
List view, then select a clip to expose it in the Filmstrip at the top of the Media Pool, 
drag the pointer through the Filmstrip to watch it play and press I and O to set In and 
Out points to the appropriate range. The Filmstrip will dim the heads and tails to let you 
see the range of media you’ve marked.

Using the Source Viewer: Open a clip in the Viewer by double-clicking it in the Media 
Pool, or selecting it in the Media Pool and pressing the Return key. Then use the 
transport controls, jog bar, or control panel buttons to move the playhead, and place In 
and Out points using the In and Out buttons to the right of the transport controls, or by 
pressing the I or O keys.

2	 Drag the clip you want to edit from either the Media Pool or the Source Viewer, and 
drop it onto the desired position in the Timeline to perform an overwrite edit. If you 
drag a clip on top of another clip that’s already in the Timeline, the clip you’re dragging 
will overwrite the part of the clip that it overlaps.

Dragging a clip from the Media Pool to overwrite a clip in the Timeline
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Drag and Drop Editing of Several Clips 
Into the Timeline At Once
The procedure above also works when you want to edit several clips into the Timeline at once 
by dragging them from the Media Pool.

1	 Change the sort order of the Media Pool’s browser area to put the clips into the order 
in which you want them to appear. In Thumbnail view you can use the Sort Order 
menu, but in List view you can click the header of any metadata column to sort by that 
column’s data.

Using the Sort Order menu to change the sort 
order of clips in the Media Pool

2	 Use the Media Pool thumbnails, the Media Pool List view Filmstrip, or the Source 
Viewer to set In and Out points to define the part of each clip that you want to edit into 
the Timeline.

3	 Select the the Media Pool clips you want to edit into the Timeline by dragging a 
bounding box, Command-dragging multiple bounding boxes over different sets 
of clips, by Shift-clicking a range of clips, or by Command-clicking individual non-
contiguous clips.

4	 Drag any of the selected clips to the desired position in the Timeline to perform an 
overwrite edit.

TIP: If you drag a clip into the blank area above an existing video track or below an 
existing audio track, a new track will automatically be created.
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Dragging multiple clips into the Timeline in the sort order of the Media Pool

The clip(s) you drag overwrite whatever other clips they overlap in the Timeline. 
Multiple clips dragged from the Media Pool will be edited in the order in which they’re 
sorted in the Media Pool, using each clip’s In and Out points.

Drag and Drop Editing of Video-Only or Audio-Only Edits
While it’s easy to edit just the video or just the audio of a clip by disabling the audio or video 
destination control in the Timeline prior to doing any sort of edit (described later in Chapter 19, 
“Three and Four Point Editing”), there’s also a pair of keyboard modifiers you can use to do the 
very same thing while you’re dragging.

�� Option-drag clips from the Media Pool/Filmstrip, Source Viewer, or Finder into the 
Timeline to edit only the video component of that clip into the Timeline.

�� Shift-drag clips from the Media Pool/Filmstrip, Source Viewer, or Finder into the 
Timeline to edit only the audio component of that clip into the Timeline.

�� Open a clip into the Source Viewer, then move the pointer over the Source Viewer and 
drag from either the Video-only or Audio-only overlays that appear over the bottom of 
the image.

Video and Audio-only overlay controls appear in 
the Source Viewer that let you drag just the video 
or just the audio into the Timeline
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Dragging Clips From the macOS Finder Into the Timeline
You can also drag a clip directly from the Finder to the Timeline using the macOS version of 
DaVinci Resolve.

Dragging multiple clips into the Timeline from the Mac OS Finder

Other Ways of Assembling 
Edits Into the Timeline
While drag and drop editing is intuitive enough, there are other simple methods of editing clips 
into the Timeline by using the playhead to define where those clips will start. The examples in 
this chapter all use “Overwrite” edits, which are also shown above. Because Overwrite edits 
delete overlapping clips in the Timeline with the new incoming clip, they let you both delete 
unwanted media from the Timeline, and add clips that you do want. Here are two examples of 
how to do this.

Example: Assembling Clips Into the 
Timeline From the Source Viewer
The following example shows how you can use the Edit page to assemble a quick first cut of 
edits using different features of the Media Pool, Viewers, and Timeline.

1	 Open the first clip you want to edit into the Source Viewer.

2	 If necessary, set In and Out points to define the section of that clip you want to edit into 
your program.

3	 Choose what video and audio tracks you want to edit the clip to in the Timeline by 
clicking, dragging, using the Command-Option and Command-Shift Up and Down 
Arrow Key shortcuts, or using the Option-1–8 and Command-Option-1–8 key shortcuts 
to assign the video and audio destination controls. By default, the destination controls 
are assigned to tracks V1 and A1.

4	 Click any destination control itself to disable the video or audio component if you want 
to edit clips into the Timeline as audio or video only. By default, all destination controls 
are enabled.
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Setting the destination control to the track 
you want to edit into.

5	 In the Timeline Viewer or the Timeline itself, move the Timeline playhead to the frame 
you want the beginning of the clip you’re about to edit to start.

6	 To perform the edit, do one of the following:

�� Drag the clip from the Source Viewer to the Timeline Viewer and drop it on the 
Overwrite overlay. (Note: If you’re in single viewer mode, this overlay only appears 
when you drag a clip from the Media Pool to the Timeline Viewer)

�� Click the Overwrite Clip button at the middle of the Toolbar.

�� Choose Edit > Overwrite ( or press F10).

The selected clip(s) are overwritten to the selected track at the position of the 
playhead, and the playhead automatically moves to the end of the newly edited clip, 
ready for you to perform another edit. If that clip is the last one on the Timeline, you’ll 
see the last frame to the left of the playhead (with a jagged overlay at the right-hand 
side of the Timeline Viewer) instead of the black that is the actual frame after that clip. 
This makes it easier for you to line up the next edit. Otherwise, the playhead will show 
whatever frame happens to be at that point in time.

The Timeline playhead at the first frame after the clip you’ve just edited, the Timeline 
Viewer shows a jagged overlay at the right to let you know this isn’t a real frame
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7	 To edit another clip, open the next clip you want to edit into the Source Viewer, 
set In and Out points, and use the Overwrite Clip button or command to edit it into 
the Timeline. Continue this process until you’ve edited together the assembly of 
edits you want.

Example: Assembling Clips Into the 
Timeline from the Media Pool
If you want, you can also edit clips directly into the Timeline from the Media Pool using a variety 
of commands. This can be a fast way of appending clips to the end of the Timeline (although 
you can also perform Insert edits this way).

To edit one or more clips from the Media Pool to the Timeline:

1	 If necessary, set In and Out points for each of the clips you want to edit into the 
Timeline using either the Media Pool thumbnails (in Thumbnail view), the Media Pool 
Filmstrip Viewer (in List view), or by opening each one into the Source Viewer. For each 
method, press I to set an In point, and O to set an Out point.

Change the sort order of the Media Pool’s browser area to put the clips into the order in 
which you want them to appear. In Thumbnail view you can use the Sort Order menu, 
but in List view you can click the header of any metadata column to sort by that 
column’s data.

2	 Click, drag, use the Command-Option and Command-Shift Up and Down Arrow Key 
shortcuts, or use the Option-1–8 and Command-Option-1–8 key shortcuts to assign the 
video and audio destination controls to the tracks you want to edit the video and audio 
of the incoming clip(s) to. Click any destination control itself to disable it if you want to 
edit clips into the Timeline as audio or video only.

3	 Select one or more clips you want to edit. Insert, Overwrite, Place On Top, Ripple 
Overwrite, and Append At End edits are all capable of editing multiple clips at once, 
while Replace and Fit to Fill edits can only edit one clip at a time, and will only edit the 
first of multiple selected clips into the Timeline.

4	 To perform the edit, do one of the following:

�� Use any of the editing commands in the Edit menu.

�� Use the equivalent keyboard shortcuts to Insert (F9), Overwrite (F10), Replace (F11), 
Place On Top (F12), Ripple Overwrite (Shift-F10), Fit to Fill (Shift-F11), or Append To End 
of Timeline (Shift-F12) the selected clips into the Timeline.

�� Right-click one or more selected clips in the Media Pool, and choose “Insert Selected 
Clips to Timeline” or “Append Selected Clips to Timeline.”

The selected clip(s) are edited into the Timeline.
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Making Selections in the Timeline
Once you’ve assembled a sequence of clips in the Timeline, you’ll probably need to manipulate 
them further, moving, deleting, trimming, or otherwise adjusting the clips in the Timeline to 
make the edit play with the pacing and verve you require.

Manually Selecting Clips in the Timeline
Many operations require you to make a selection first, to define the scope of what you’re about 
to do. There are many ways to do so.

Selections you can make using the mouse:

�� To select one clip: Click a clip with the mouse. 

�� To select a continuous range of clips by dragging: Drag a bounding box from an 
empty area of the Timeline to surround a group of clips.

Dragging a bounding box to select a continuous range of clips in the Timeline

�� To select a continuous range of clips by Shift-clicking: Click the first clip you want to 
select, and then shift-click the last clip you want to select, and all clips in-between will 
automatically be selected as well.

�� To select a discontinuous range of clips: Command-click any clips to select them 
no matter where they appear on the Timeline. Command-clicking a selected clip 
deselects it.

Command-clicking to select a discontinuous range of clips in the Timeline
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Selecting clips using the keyboard or menu commands:

�� To select one clip: Using the keyboard, make sure the Auto Select button for 
the track the clip is on is enabled, then move the playhead over that clip and 
press Shift-V.

�� To select all clips forward of the playhead on the current track: Move the playhead 
to the first clip you want to include in the selection, then press the Y key (Timeline > 
Select Clips Forward > On This Track) to select that clip and every clip to its right in 
the same track of the Timeline.

�� To select all clips forward of the playhead on all tracks: Move the playhead to the 
first clip you want to include in the selection, then press Option-Y (Timeline > Select 
Clips Forward > On All Tracks) to select that clip and every clip to its right in all tracks 
of the Timeline.

�� To select all clips backward from the playhead on the current track: Move the 
playhead to the last clip you want to include in the selection, then press Command-Y 
(Timeline > Select Clips Backward > On This Track) to select that clip and every clip to 
its left in the same track of the Timeline. By default, there’s no keyboard shortcut for 
this command, but you can assign one.

�� To select all clips backward from the playhead on all tracks: Move the playhead to 
the last clip you want to include in the selection, then choose Command-Option-Y 
(Timeline > Select Clips Backward > On All Tracks) to select that clip and every clip 
to its left in all tracks of the Timeline. By default, there’s no keyboard shortcut for this 
command, but you can assign one.

�� To select all clips in the Timeline: Make sure the Timeline has focus, then press 
Command-A.

To change which clip is selected using the keyboard:

Select a clip, then use the Left Arrow and Right Arrow keys to change the selection to 
the previous or next clip among all tracks with Auto Select turned on.

Selecting Clips Based on Markers, Flags, and Clip Color
It’s also possible to select multiple clips that have a particular color of marker, flag, or clip 
coloration. This is useful in any situation where you’re using these organizational tools to keep 
track of clips with specific characteristics that you might need to later select for multi-clip 
operations. 

For example, you might add purple markers to a series of audio clips that might need special 
EQ settings. Later, you can choose Timeline > Select Clips With Marker Color > Purple to select 
all of those clips in order to move them to another track, where you can apply the same EQ to 
all of them using an audio filter applied to the track. There are three ways of selecting 
groups of clips.

To select groups of clips based on Marker, Flag, or Clip Color:

�� Choose Timeline > Select Clips With Flag Color > Blue – Purple

�� Choose Timeline > Select Clips With Marker Color > Blue – Purple

�� Choose Timeline > Select Clips With Clip Color > Green – Gray

Selecting Edits in the Timeline
A variety of editing and trimming methods require you to select an edit point, or part of an edit 
point, in order to resize, ripple, or roll an edit. You can do so using the mouse or using 
the keyboard.
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Methods for selecting edit points using the mouse:

�� To select an edit to roll: Move the mouse to the center of an edit point, and when the 
ripple cursor appears, click to select the edit.

Selecting an edit point to roll

�� To select just the incoming or outgoing half of an edit point to resize or ripple: Move 
the mouse to the left or right of the center of an edit, and when the resize/ripple cursor 
appears, click to select that portion of the edit.

Selecting incoming or outgoing halves of an 
edit point to resize or ripple

To select multiple edit points, do one of the following:

�� To select multiple roll points: Command-click the center of multiple edit points. 
Command-click a selected edit point to deselect it.

Command-clicking the center of several edits to prepare to roll them all

�� To select multiple ripple points: Command-click the left or right sides of multiple 
edit points.

Command-clicking the left or right of several edits to ripple them all

�� To drag to select many edit points: Select the Trim tool (T), and drag a bounding-box 
over the edit points you want to select. You can press U to switch all selected edit 
points among rippling incoming edits, rippling outgoing edits, and rolling edits.

Using the Trim tool, you can drag to select multiple edits

There is also a flexible set of keyboard shortcuts that makes it easy to select edit points in 
preparation for various operations if you like to avoid using the mouse.
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Keyboard shortcuts for selecting edits:

�� V: Selects the nearest edit point to the playhead on the lowest track with Auto Select 
enabled. Selects both the audio and video edit points of a clip together.

�� Option-C: Selects the nearest video edit point to the playhead on the lowest track with 
Auto Select enabled. Linked audio edit points are not selected.

�� Shift-C: Selects the nearest audio edit point to the playhead on the lowest track with 
Auto Select enabled. Linked video edit points are not selected.

�� U: Once you’ve selected an edit point, this shortcut toggles among selecting the 
outgoing half, incoming half, or the entire edit.

�� Option-U: Once you’ve selected an edit point, this shortcut toggles among selecting 
the video+audio of the edit, just the video, or just the audio.

To move the selection to another edit:

Select a single edit point, then use the Up Arrow key (Previous Edit) or Down Arrow key 
(Next Edit) to change the selection to the previous or next edit point among all tracks 
with Auto Select turned on.

To deselect all edit points:

�� Using the mouse: Click any empty area of the Timeline.

�� Using the keyboard: Press Shift-Command-A.

A Practical Example of Keyboard-Driven Selections
Here’s an example of how you would use these keyboard shortcuts together as a sequence of 
operations.

To select an edit point using the keyboard:

1	 Move the Timeline playhead close to the edit point you want to select using 
the JKL keys.

2	 Press the V key to select the nearest edit point to the playhead on the lowest track with 
Auto Select enabled. If there are overlapping superimposed clips on multiple tracks, 
turn off the Auto Select controls of tracks with edits you don’t want to select using 
Option-F1 through Option-F8 corresponding to the auto select controls on tracks 1-8. 
Using the mouse, you can solo a track’s Auto Select state by Option-clicking its Auto 
Select button. (Option-F9 toggles the auto select controls of all video tracks.)

3	 Initially, the entire edit is selected, in preparation for a roll edit. To toggle among 
selecting the outgoing half, incoming half, and the entire edit, press the U key.

4	 To toggle among selecting the video+audio of the edit, just the video, or just the audio, 
press Option-U.

5	 Perform whatever operation you need to. When you’re finished, using Up-Arrow or 
Down-Arrow to move the selection backward or forward in the Timeline, or press 
Command-Shift-A to deselect it.
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Using Auto Select Controls 
to Define Selections
The Timeline Auto Select controls are extremely useful and versatile controls that serve many 
purposes. In short, they give you a way to specify which tracks will be affected or considered 
when you’re performing an operation upon multiple superimposed clips on multiple tracks of 
the Timeline. 

Also, the Timeline Auto Select controls are particularly convenient when you’re using keyboard 
shortcuts to edit and you don’t want to have to grab your mouse to explicitly select a single clip, 
since you can turn Auto Select on or off via keyboard shortcuts.

Defining Selections With the Help of Auto Select Controls
Here is the easiest example of when the Auto Select controls are indispensable. In the following 
example, there are two superimposed video clips and three superimposed audio clips. 
Supposing you only want to delete the media from tracks V2, V1, and A1, but you want to leave 
the media on A2 and A3 alone, you can turn off the Auto Select controls for tracks A2 and A3, 
and set Timeline In and Out points to define the range of the clips you want to delete. When 
you press the Delete key, only the media on the Auto Select-enabled tracks is deleted.

Overriding Automatic Selections By 
Making Manual Selections
It’s important to note that manual selections that you make which highlight specific clips in the 
Timeline always override whatever the Auto Select control of a track is set to. In the following 
example, three clips are superimposed and the Auto Select control of every track except V2 
has been turned off. Setting Timeline In and Out points now automatically defines that region of 
the clip on track V2 to be deleted were you to press the Delete key. You can see the affected 
part of the Timeline because it’s highlighted while the rest of the Timeline is dimmed.

Soloing the Auto Select control on track V2 to limit a Delete operation

However, if you clicked the clip on track V1 to select it manually, the automatic selection defined 
by the In and Out points disappears in favor of the highlighted clip you just clicked. This is 
because manual selections almost always take precedence over automatic selections you 
define using the In and Out points and Auto Select controls.
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Making a manual selection overrides the Auto Select controls

This is good to keep in mind for situations where the fastest way to do the operation you need 
to do is to simply manually select the clip you want to define the operation.

Using Auto Select Controls to Control Other Operations
Other operations that are affected by the Auto Select controls include any command that uses 
“the clip on the lowest-numbered track with Auto Select enabled” to define what happens. 
This includes Copy and Paste, Mark Clip, Go To Next Edit/Previous Edit, the Selection Follows 
Playhead mode, Next Gap/Previous Gap, etcetera (a full list of affected operations 
appears later).

A common example of when this is important is whenever you use the Mark Clip command to 
automatically set In and Out points to match the duration of a clip on the Timeline. If that clip 
happens to be at a section of the Timeline where there are multiple superimposed clips, each 
of which has a different duration, then by default the In and Out points (first and last frames) of 
the clip on the lowest numbered track is used to set Timeline In and Out points when you use 
Mark Clip. 

Using Mark Clip with all Auto Select controls enabled, the clip on the 
lowest-numbered video track with Auto Select enabled defines the result

However, if you disable the Auto Select control of track V1, then whichever clip is on the lowest 
video track with Auto Select still enabled is used as the target clip for the Mark Clip operation. 
In this example, the shorter clip on track V2 now sets the locations of the In and Out points.

Using Mark Clip with Auto Select controls enabled
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Methods of enabling and disabling the Auto Select controls:

�� To toggle Auto Select for any track: Click any track’s Auto Select control.

�� To toggle Auto Select for video tracks: Press Option-F1 through F8 to toggle Auto 
Select for tracks V1 through V8. 

�� To toggle Auto Select for all video tracks off and on: Press Option-8.

�� To toggle Auto Select for audio tracks 1-8: Press Option-Command-F1 through F8. 

�� To toggle all video track Auto Select tracks off and on: Press Option-F9.

�� To toggle all audio track Auto Select tracks off and on: Press Option-Command-F9.

�� To “solo” Auto Select for a track and disable Auto Select on all other tracks: 
Option‑click any Auto Select control to leave that control on while turning off all other 
Auto Select controls of that type (video or audio).

�� To turn all audio or video Auto Select controls on and off: Shift-click any video or 
audio Auto Select control to toggle on or off all Auto Select controls of that type (video 
or audio).

The following operations are affected by the state of each track’s Auto Select control:

�� Cutting, Ripple Cutting, Copying, or Deleting clips: When using Timeline In and Out 
points to delete a range of media from the Timeline, only media on tracks with an 
enabled Auto Select control will be cut, copied, or deleted.

�� Deleting gaps: When selecting and deleting gaps in the Timeline, clips on other tracks 
that overlap the selected gap will also be deleted on tracks with an enabled Auto 
Select control. Media to the right of affected tracks will ripple left to close the gap.

�� Selecting edit points using the keyboard: When you press V to select the nearest edit 
point, the edit point on the lowest track with Auto Select enabled is selected. When 
pressing the Up Arrow and Down Arrow keys to move the selection from edit point to 
edit point, edit points on tracks with a disabled Auto Select control are ignored.

�� Selecting clips using the keyboard: When a clip is selected, you can press the Up 
Arrow and Down Arrow keys to move the selection from clip to edit clip, but clips on 
tracks with a disabled Auto Select control are not seen by this operation.

�� Using Mark Clip: When using the Mark Clip command, clips on tracks with disabled 
Auto Select controls are ignored. This lets you choose a target clip to use for marking 
the clip when there are multiple overlapping superimposed clips.

�� Match Frame: When making a Match Frame operation, clips on tracks with disabled 
Auto Select controls are ignored. This lets you choose a target clip to use for matching 
a frame when there are multiple overlapping superimposed clips.

�� Rippling the Timeline during a trim operation: Tracks with Auto Select turned off 
will not be rippled. More information on the rules of ripple trimming appear later in 
this chapter.

�� Pasting clips: All copied clips will be pasted to the lowest numbered track with 
Source Control enabled. If all tracks of a particular type have their Auto Select controls 
turned off, then no clips of that type will be pasted at all.

�� Paste Insert: Tracks with Auto Select turned off will not be rippled or affected by clips 
being pasted via a Paste Insert command.

�� Using the Insert or Ripple Overwrite edits: Only clips on tracks with Auto Select 
turned on will be rippled during an Insert edit or Ripple Overwrite edit.

�� Finding gaps: When using Playback > Previous Gap (Command-Option-;) or Next Gap 
(Command-Option-‘ ), gaps on tracks with Auto Select disabled will be ignored.

�� Using Selection Follows Playhead: When you turn on “Selection Follows Playhead” so 
that all clips intersecting the position of the playhead are automatically selected, clips 
on tracks with Auto Select disabled will not be selected.
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Locking Tracks You 
Don’t Want to Change
Another step you can take to prepare before performing any kind of editorial operation is to 
lock tracks with media that you don’t want to be affected by whatever it is you’re about to do. 
For example, if you have a complex set of music edits on track A3 that you don’t want to be 
affected by operations that will ripple the Timeline, you can lock track A3 so those clips 
remain unaffected.

Tracks V2, V1, and A1 are unlocked, while tracks A2, A3, and A4 are locked

Clips on locked tracks cannot be moved, deleted, cut, or otherwise affected by editorial 
operations. Furthermore, parameters of locked clips cannot be edited in the Inspector. 
However, clips on locked tracks can be graded and otherwise modified in the Color page.

To toggle the lock or unlock state of tracks, do one of the following:

�� Click any track’s lock control to toggle lock on and off.

�� Shift-click any track’s lock control to toggle locking on and off for all tracks.

�� Press Option-Shift-1 through 8 to lock or unlock tracks V1 through V8.

�� Press Option-Shift-9 to lock or unlock all video tracks.

�� Press Option-Shift-F1 though F8 to lock or unlock tracks A1 through A8.

�� Press Option-Shift-F9 to lock or unlock all audio tracks.

Position Lock
In a nutshell, turning position lock on prevents clips from being moved to the left or right, and it 
prevents all ripple operations. This is primarily useful when you’re near the end of post on a 
project for which the cut has been locked (or at least as “locked” as directors and producers 
allow any more), but you still need to make surgical changes that don’t risk throwing the video 
out of sync with audio that may be being edited and mixed elsewhere because of an 
accidentally rippled edit.

With position lock on, you can still make edits (such as Replace), slip clips, roll edits, add 
ResolveFX and other OpenFX, and alter all manner of effects in the Inspector. You just can’t do 
anything that alters the position of clips in the Timeline, or ripples entire sections of the 
Timeline. 

There are two ways you can enable Position Lock.
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Position Locking All Tracks
You can turn Position Lock on and off for all tracks via a button in the toolbar above the Timeline.

The Position Lock button on the toolbar

When you turn position lock on, the Lock button of all tracks changes to show that position lock 
is enabled instead.

Position lock indicated by each track’s Lock icon changing

Position Locking Individual Tracks
You can also be extra tricky and enable position lock on a track-by-track basis by Command-
clicking any track’s Lock button.

Command-click any track’s Lock button to put that 
track into Position Lock mode

Position lock can be released by simply clicking that track’s Lock icon.
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Disabling and Re-Enabling 
Clips in the Timeline
Sometimes there’s one or more video or audio clips in the Timeline that you don’t want to play 
along with the rest of the edited sequence, but you don’t want to remove from the Timeline 
either, in case you change your mind later. For this reason, it’s possible to Disable clips, 
effectively turning them off without removing them.

Disabled clips appear dimmed in the Timeline. They don’t play back, they’re not rendered, and 
they’re not output to video. However, their position is preserved in the Timeline, so you can 
always re-enable them at a later time if you change your mind and decide you want 
to use them.

A clip that’s been disabled between two enabled clips; the disabled clip is dimmed

To disable or re-enable one or more selected clips:

�� Right-click part of the selection and choose Enable Clip from the contextual menu

�� Choose Clip > Enable Clip

�� Press D

Deleting Clips and Gaps 
from the Timeline
There are two ways you can delete clips you don’t want in the Timeline. Using the Delete key, 
you can perform what’s sometimes called a “lift edit,” removing the unwanted clips and leaving 
a gap. Using the Forward Delete key, you can perform a “ripple delete,” removing unwanted 
clips and closing the gap by rippling the rest of the edited Timeline to the right of the deleted 
clip/s by moving it to the left.

Deleting clips as a “lift edit” operation:

�� To remove one or more clips from the Timeline, leaving a gap: Select a clip in the 
Timeline, or Shift-click or Command-click to select the clips you want to remove, and 
press the Delete key (or right-click the selection and choose Delete).

�� To remove a range of media from the Timeline on multiple tracks, leaving a gap: 
Set Timeline In and Out points defining the range of media you want to delete, then 
turn off the Auto Select controls of any tracks with media you want to preserve, and 
press the Delete key (or right-click the selection and choose Delete).
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Deleting Clip I using the Backspace or Delete key and leaving a gap

Deleting clips as a “ripple delete” operation:

�� To delete one or more clips and close the gap by rippling the Timeline left: Select 
a clip in the Timeline, or Shift-click or Command-click to select the clips you want to 
remove, and press the Forward Delete key.

�� To delete a range of media and close the gap by rippling the Timeline left: Set 
Timeline In and Out points defining the range of media you want to delete, then turn off 
the Auto Select controls of any tracks with media you want to preserve, and press the 
Forward Delete key.

Deleting Clip I using the Forward Delete key to ripple all clips with In 
points to the right in the Timeline to close the gap

As with any ripple operation, all clips with In points to the right of the deleted range of media on 
tracks with auto -select enabled are rippled to close the gap, and any clips with In points to the 
left of the In point of the affected range of media are unaffected.
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Finding, Selecting, and Deleting Gaps in the Timeline
A gap is defined as a space between any two clips on the same track. Often gaps are desirable 
as they allow audio or video clips to be spaced apart from one another very specifically, but 
sometimes they’re not. If you want to find accidental gaps in your timeline that may be too small 
to see, a pair of commands lets you do this.

To move the playhead to the next gap on the Timeline:

1	 Turn off the Auto Select controls of any tracks you want to omit from this operation.

2	 Do one of the following:

�� Choose Playback > Previous Gap, or press Option-Command-Semicolon (;) to move 
the playhead to the next gap to the left of the playhead’s current position.

�� Choose Playback > Next Gap, or press Option-Command-Apostrophe (‘) to move the 
playhead to the next gap to the right of the playhead’s current position.

To select or deselect a gap:

Click once to select a gap, and click that gap again to deselect it.

You can only select one gap at a time. The principal reason to select a gap is to delete it, in the 
process rippling the Timeline to close the gap. In the following example, there’s a gap between 
two clips on track V1 that you’d like to close.

Selecting a gap on Track V1

To delete a gap:

Press the Delete key to close the gap. All clips to the right of it on tracks with Auto 
Select enabled will be rippled to the left to close the gap. Clips on tracks with Auto 
Select disabled will not ripple.

If you select a gap in a timeline with clips on multiple tracks, which clips will be deleted 
depends on the state of the Auto Select controls for each track in the Timeline.

�� All tracks with Auto Select enabled: The range of media that overlaps the selected 
gap will also be deleted. Clips on those tracks will ripple left to fill the gap.

�� All tracks with Auto Select disabled: The range of media that overlaps the selected 
gap will be left intact, and clips on those tracks will not ripple left, going out of sync with 
whichever clips do ripple.
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Audio/Video Linking
DaVinci Resolve gives you complete control over the linked relationship between the video and 
audio associated with a clip. By default, DaVinci Resolve tries its best to keep the video and 
audio of clips and timelines in sync. However, there are several ways you can suspend 
automatic syncing when you need to make a specific kind of edit.

Controlling Audio/Video Linking While Making Selections
While selecting edits and clips, you can also choose whether the video and audio associated 
with a clip should be selected together (linked) or not. This determines whether operations 
performed to the video of a clip automatically affect the audio of the clip, and vice versa. In 
most instances, you’ll probably want to leave Audio/Video Linking turned on, so that selecting 
the video of a clip to move it elsewhere in the Timeline also results in the audio being selected 
and moved at the same time. Disabling A/V linking in this case could cause your video and 
audio to go out of sync undesirably.

However, there are plenty of instances when you’ll want to temporarily suspend this linked A/V 
relationship, such as when you want to create a split edit, where a clip’s audio In point is at a 
different frame than the video In point. In this case, you can suspend Audio/Video Linking to 
select just the audio In point, then roll it either further back or forward to create the split, without 
changing the In point of that clip’s video. When you’re finished, you can re-enable A/V linking.

At all times, the state of Audio/Video Linking is visible via the Chain-link button at the right of 
the toolbar.

The Audio/Video Linking button

To turn Audio/Video Linking off and on:

Click the Link Audio/Video button (or press Shift-Command-L).

To temporarily suspend Audio/Video Linking while making a selection:

Press the Option key while clicking a clip or edit point to select the video without 
selecting the audio, or vice versa.

Dealing with Audio Video Sync Offsets
Audio/Video sync is one of the most important things to maintain in any edited program. 
However, there are times when you may want to override the sync relationship of a clip’s audio 
and video to make a particular edit, so moving a clip’s audio and video out of sync is allowed.

If you disable Audio/Video Linking and then move the audio or video of a clip independently of 
its linked video or audio counterpart, you’ll see red “out-of-sync” indicators at the right of each 
clip’s name bar, that displays the timecode offset by which the audio and video of that clip are 
out of sync. In the following example, the audio and video of a clip have been moved out of 
sync by Option-clicking the video and dragging it to the right.

Sync markers on a clip with audio and video out of sync
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If you’ve moved the audio and video of a clip out of sync with one another, there’s a really easy 
way of getting them back into sync, by right-clicking the red out-of-sync indicator of any clip and 
choosing one of the available commands:

�� Slip into place: Slips the content of the selected clip, without moving the clip, so that it’s 
in sync with the other items that are linked to that clip.

�� Move into place: Moves the selected clip so that it’s in sync with the other items that 
are linked to that clip.

�� Slip others into place: Slips the content of all other items that are linked to the selected 
clip, without moving them, so that all linked items are in sync.

�� Move others into place: Moves all other items that are linked to the selected clip so 
that all linked items are in sync.

Commands in the contextual menu of sync tooltips

Manually Unlinking and Relinking Audio and Video
By default, clips that you import into DaVinci Resolve have their video and audio linked 
together, which makes it easy to maintain the relationship and sync of the audio and video 
components of a clip while you’re editing. However, there are many reasons you might want to 
override this automatic relationship, either breaking the a/v linking of a clip’s audio and video 
completely, or breaking it and relinking in a different way, or to different clips.

Methods of permanently changing Audio/Video Linking in the Timeline:

�� To unlink audio and video from one another: Select a clip, then right-click it and 
choose Link from the contextual menu (or press Option-Command-L). Unlinked clips do 
not appear with a dot before the clip name in the Timeline.

�� To link audio and video clips to one another: Command-click an audio clip and a video 
clip so they’re both selected, then right-click the selected clips and choose Link from 
the contextual menu (or press Option-Command-L). A dot appears before the name of 
linked clips in the Timeline.

Left - linked video and audio with a dot to the left of the clip name,  
Right - unlinked audio and video items have no dot
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Linking Multiple Clips in the Timeline
You don’t just have to link audio and video clips that sync together, though. You can actually link 
any number of video and audio clips that you want to be able to select, move, and edit together 
as one, even if they were never originally meant to be synced. This makes linking an 
organizational mechanism as much as a sync management tool. Here are some examples of 
how you can use this:

�� You can link a text generator with a subtitle to the clip it plays along with.

�� You can link a sandwich of overlapping audio sound effects with the video clip they 
accompany.

�� You can link off camera audio to an on camera shot.

�� You can link the background and foreground clips of a green screen composite, with 
sound from both.

Linking multiple clips in the Timeline works the same as linking a single audio and video clip 
together; every single linked item appears with a dot to the left of the clip name, and 
suspending linked selection to force any single clip out of sync will result in the display of an 
“out-of-sync” indicator.

Multiple audio and video items that have been manually linked 
together to act as a single clip in the Timeline when Linked 
Selection is enabled

Commands for Slipping Audio/Video Sync
Another set of commands in the Trim > Slip Audio submenu let you slip the contents of one or 
more selected clips in order to alter the sync between the audio and video, either in whole 
frame increments, or in sub-frame increments if there are clips with marginal sync that you want 
to improve.

�� One Frame Forward (Option-Period)

�� One Frame Reverse (Option-Comma)

�� One Subframe Forward (Option-Right Arrow)

�� One Subframe Reverse (Option-Left Arrow)
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Chapter 18

Modifying Clips 
in the Timeline
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Modifying Clips in the Timeline
Once you’ve edited a variety of clips into the Timeline, you’ll start working with them as you 
refine your edit. In this chapter, you’ll learn simple methods of modifying clips, including 
resizing, splitting, shuffling, disabling, copying and pasting, and duplicating.

This chapter covers the following topics:

Moving, Resizing, and Rolling Clips in Selection Mode	 353

Trimming Gaps	 355

Resizing or Trimming Clips in the Source Viewer	 355

Shuffle or Swap Edits and Inserts	 357

Splitting and Joining Clips	 359

Enabling and Disabling Clips and Tracks	 360

Copying and Pasting Clips in the Timeline	 361

Paste Insert	 361

Copying and Pasting Partial Clip Segments Using In and Out Points	 361

Copying and Pasting Clips to a Different Track	 362

Audio Channels When Copying and Pasting Audio Clips	 362

Duplicating Clips and Transitions in the Timeline	 363



353

M
o

d
ify

in
g

 C
lip

s 
in

 t
he

 T
im

e
lin

e
 

P
ar

t 
3 

–
 1

8

Moving, Resizing, and Rolling 
Clips in Selection Mode
After editing a series of clips into a timeline, the next thing even the most careful of editors 
probably needs to do is to start making changes. The simplest changes are made in Selection 
Mode, using the regular arrow pointer. 

The Selection Mode button at left is enabled; 
the Trim mode button at right is disabled

This is the default mode when you open DaVinci Resolve, and allows you to move clips to other 
places in the Timeline, resize them to make them longer or shorter, and roll the edit points 
between two clips to move the edit to an earlier or later position on the Timeline. What this tool 
does depends entirely on what you click to select as you work.

Manipulating clips using the mouse:

1	 Click the ”Selection Mode” tool (the arrow), or press A.

2	 Do one of the following:

To move clips in the Timeline: Drag any clip in the Timeline to any other position. If you 
drag a clip to overlap another clip, the clip you’re dragging overwrites the clip you’re 
dropping it onto.

Moving a clip in the Timeline to overwrite part of another 
clip; a tooltip shows you how many frames you’ve moved

To move clips in the Timeline up or down to other tracks while keeping them at the 
same time: Hold the Shift key down while dragging clips up or down in the Timeline. 
Or, you can hold the Option key down and press Up or Down Arrow.

Moving a clip into another track without sliding it in time by holding the Shift key down
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To shorten or lengthen clips: Move the Selection Mode pointer over the beginning or 
end of a clip, and when it turns into the Resize cursor, drag the In or Out point to the left 
or right to change the clip’s length.

Resizing a clip in the Timeline to create a gap; a tooltip shows the offset, and 
outlines show you how much media is available in the clip being adjusted

To roll any edit: Move the Selection Mode pointer over any edit point, and when it turns 
into the Roll Edit cursor, drag it to the left or right to move the edit point while 
simultaneously resizing the outgoing and incoming edits points of the two clips 
surrounding it.

Rolling an edit; a tooltip shows the offset, and an outline 
shows the available area you can roll within

Manipulating clips using the keyboard:

1	 Press A to choose ”Selection Mode.”

2	 Do one of the following:

To roll any edit: Select the closest edit point to the playhead using the V key, moving 
the selection to another edit, if necessary, using the Up Arrow and Down Arrow keys, 
and then press the Comma key (nudge 1 frame left) or Period key (nudge 1 frame right) 
to roll the selected edit to the left or right. Shift-Comma and Shift-Period nudges 
by 5 frames.

To shorten or lengthen clips: Select the closest edit point to the playhead using the V 
key, then use the U key to toggle the selection among the end of the outgoing clip and 
the beginning of the incoming clip. Then, press the Comma key (nudge 1 frame left) or 
Period key (nudge 1 frame right) to shorten or lengthen that side of the clip. If you nudge 
one end of a clip to overlap another, the clip you’re nudging overwrites the adjacent 
clip. Shift-Comma and Shift-Period nudges by 5 frames.

To move clips forward or back in the Timeline: To select a clip in preparation for 
moving it, either click it, or move the playhead over it and press Shift-V. Then press the 
Comma key (nudge 1 frame left) or Period key (nudge 1 frame right) to move the clip to 
the left or right. If you nudge a clip to overlap another clip, the clip you’re nudging 
overwrites the adjacent clip. Shift-Comma and Shift-Period nudges by 5 frames.
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To move clips up or down to other tracks: To select a clip in preparation for moving it, 
either click it, or move the playhead over it and press Shift-V. Then, press Option-Up 
Arrow to move the Video and Audio of that clip to the next higher-numbered track, or 
press Option-Down Arrow to move the Video and Audio to the next lower-
numbered track.

Trimming Gaps
The start and end of gaps can also be rippled using the Trim tool. For more information, see 
“Using Trim Mode and the Trim Tool” later in this chapter. 

Using the Trim tool to ripple the out point of a gap to narrow it

Resizing or Trimming Clips 
in the Source Viewer
You can also double-click a clip in the Timeline to open it into the Source Viewer for trimming. 
When the Selection tool is selected, you can drag the In and Out markers, or use the playhead 
and I and O keyboard shortcuts to resize that clip in the Timeline.

TIP: When holding down the Shift key while nudging a selection to do a “fast 
nudge,” the duration of the nudge is customizable in the Editing panel of the 
User Preferences. By default it’s five frames, but you can set it to 
whatever you want.
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A Timeline clip being resized by opening it in the Source Viewer and dragging its In point

Additionally, you can open Timeline clips into the Source Viewer for trimming using the Trim 
tool, dragging to ripple the In and Out points, and slipping the contents of the clip by holding 
the Shift key down and dragging the In and Out points.

NOTE: To open a match frame of a clip in the Timeline using the mouse as in previous 
versions of DaVinci Resolve, hold the Option key down while double-clicking a clip.
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Shuffle or Swap Edits and Inserts
A Shuffle edit (sometimes referred to as a Swap edit) lets you quickly rearrange selected clips in 
the Timeline simply by Command-Shift dragging them to the left or right (or Command-Option 
dragging them to do a shuffle insert). When you do so, the surrounding clips automatically move 
to the right or left to switch places with the clip or clips that you’re dragging. This is a really fast 
way to reorder clips to try out different arrangements, without needing to drag clips onto 
multiple tracks to get them out of the way, first.

You have a lot of flexibility in how you shuffle clips around. You can select one clip, or multiple 
consecutive clips to shuffle. If you select multiple consecutive clips, they’ll move together as a 
single block. You can even select multiple consecutive clips on multiple tracks to shuffle around 
the Timeline as a single item.

Furthermore, you can also select clips that are part of split edits, where the audio and video In 
and Out points start or end at different frames. In this case, how other clips move in the 
Timeline to make room for the Split-edit clip you’re dragging depends on whether you click the 
video or audio portion of the clip to start dragging:

�� If you click-and-drag the video portion of the clip, then all clips will rearrange 
themselves based on the duration of that video item on that track, so that all video 
items on that track rearrange themselves without either overwriting one another or 
leaving gaps. As you drag to shuffle the selection through the Timeline, overlapping 
linked audio items will either overwrite the audio on neighboring clips, or leave a gap.

�� If you click-and-drag the audio portion of the clip, then all clips will rearrange 
themselves based on the duration of that audio item on that track, so that all audio 
items on that track rearrange themselves without either overwriting one another or 
leaving gaps. As you drag to shuffle the selection through the Timeline, overlapping 
linked video items will either overwrite the video on neighboring clips, or leave a gap.

Given the rules previously described, shuffling clips is really easy, and you can do so in one 
of two ways.

To shuffle clips with adjacent clips in the Timeline:

Select one or more consecutive clips you want to shuffle, then press and hold the 
Command and Shift keys down and drag either the Video or Audio portion of the 
selected clips to the left or right. Adjacent clips will automatically switch places with the 
selection of clips you’re dragging, until you drop it in the desired location.

Before and after clip L being shuffled with clips I, K, and J in a scene to rearrange the sequence

To shuffle insert one clip into adjacent clips in the Timeline:

Select one or more consecutive clips you want to shuffle, then press and hold the 
Command and Option keys down and drag either the Video or Audio portion of the 
selected clips to the left or right. The selection of clips you’re dragging will be inserted 
in the middle of adjacent clips as you drag, with the cut portion of each clip being 
moved into the gap left behind by the clip you’re dragging. Drop the clip into the 
desired location when you’re finished.
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Before and after clip L being inserted into the middle of Clip K, which is split in half to make way for it

To shuffle multiple clips to another position in the Timeline:

Select all of the clips you want to move to another position of the Timeline, then press 
and hold the Command and Shift keys, and drag the clips left or right. Make sure the 
item you click to drag is on the same track as the majority of clips you’re rearranging; 
the item you click defines which track is used to guide the rearrangement of clips. In 
the following example, the video item of Clip C is selected on track V1, so as it’s 
dragged to the right, all clips on other tracks are rearranged according to the duration 
and location of clips B and C on track V1. As a result, clips on tracks other than V1 may 
be overwritten, or leave gaps, as necessary for the items on track V1 to be 
rearranged cleanly.

Before and after a group of clips being shuffled to the right. The clip that 
was clicked to drag defines how all other clips will be rearranged

IMPORTANT: If you begin Command-Shift-dragging a superimposed clip on a track 
with large gaps, the resulting shuffle edit operation will jump all the way to the next 
clip on that track. For this reason, shuffle edits work best on tracks containing the 
majority of clips in your edit.
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Splitting and Joining Clips
In many situations you may find yourself splitting clips in order to separate multiple clips that 
were inadvertently baked together, or to cut up clips into sections that you’re planning on 
applying different effects to or grading differently.

Methods of splitting and joining clips:

�� To split a clip once: Drag the playhead to the frame where you want to split a clip, and 
press Command-Backslash (\) to split every clip on a track with Auto Select enabled.

�� To split many clips: Click the Razor Edit mode button (or press B), and then click clips in 
the Timeline to split as many clips as you want.

�� To split clips using the DaVinci control panel on the Color page: Move the playhead to 
the frame you want to split, then press SHIFT UP and SPLIT/UNDO on the T-bar panel.

�� To join clips using the DaVinci control panel on the Color page: Move the playhead to 
the edit point you want to join, and press SHIFT UP and JOIN/REDO on the T-bar panel. 
Both clips must be from the same media file, and the frames to either side of the edit 
point need to be continuous for those clips to be joined.

When you split a clip, a through edit appears to show that you currently have an edit with 
continuous timecode running from the outgoing to the incoming half. This is called a Through 
Edit, and is displayed with a dotted line running along its edge so you know that it’s special.

A through edit seen in the Timeline

To eliminate a through edit:

Select it in the Timeline, and press Delete.

TIP: You can show an isolated list of every Through Edit in the Timeline by opening the 
Edit Index and choosing “Show Through Edits Only” in the Edit Index Option menu. 
Clicking any item in the list jumps the playhead to that Through Edit, making it easy to 
check all the Through Edits in a timeline to see if they’re necessary or not.
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Enabling and Disabling Clips and Tracks
As you work in the Timeline, you’ll find there are times when you want to disable clips that you 
don’t want to appear during playback, without actually removing them from the edit. For 
example, you may decide to disable superimposed clips that are positioned as insert shots in 
the middle of a scene because of a client’s notes, but you don’t want to eliminate the clips 
because they might change their minds. 

A disabled clip on track V2

In another example, you’ve edited a series of titles on track V3, so you need to disable track V3 
in its entirety to output a textless version of the movie as a deliverable.

When a clip or track is disabled, clips within it appear dimmed, and these disabled clips don’t 
appear in the Color page, and aren’t output to tape or rendered to disk in the Deliver page until 
that track is re-enabled first.

Track V3 is disabled, making the Timeline textless as a result

To disable/enable one or more clips in the Timeline:

Select one or more clips, then right-click the selection and check or uncheck Clip 
Enable in the contextual menu, or press D to toggle a clip’s enabled state. 

To disable/enable an entire track:

Click the track enable button.
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Copying and Pasting Clips 
in the Timeline
Clips can be cut, copied, and pasted in a variety of ways using standard keyboard shortcuts. 
You can cut or copy one clip or a selection of several, and you can also choose to copy or cut 
just the video or audio media of a clip. When pasting, you can paste to the same timeline, or to 
a different timeline if you want to move media from one to another.

Methods of doing simple cut, copy, and paste:

�� To Cut one or more clips, leaving a gap: Make a selection, and choose Edit > Cut 
(Command-X). The selected clip or clips are removed from the Timeline and stored in 
memory for pasting.

�� To Ripple Cut one or more clips and ripple the Timeline to close the gap: Make a 
selection, and choose Edit > Ripple Cut (Command-Shift-X). The selected clip or clips 
are removed from the Timeline and stored in memory for pasting. All clips on tracks 
with Auto Select enabled will be rippled to the left to fill the gap left by the cut clips.

�� To Copy one or more clips: Make a selection, and choose Edit > Copy (Command-C). 
The selected clip or clips are left in the Timeline, but copies are stored in memory 
for pasting.

�� To Paste one or more clips to the same track: Move the playhead to the frame where 
you want the pasted selection to start, and then choose Edit > Paste (Command-V). By 
default, each copied clip is pasted onto the same track it was copied from. Pasted clips 
overwrite any clips in that track that are in the way.

�� To Paste one or more clips to a different track: Pasting clips to a different track 
requires a slightly different procedure. Move the playhead to the frame where you want 
the pasted selection to start, then either Option-click any empty area on the track you 
want to paste the clip(s) to or Option-click the Auto Select control of that track to solo 
that track, and then choose Edit > Paste (Command-V). Pasted clips overwrite any clips 
in that track that are in the way.

Paste Insert
Another paste command, Edit > Paste Insert (Command-Shift-V), lets you paste clips that you cut 
or copied via an Insert Edit, so that an edit is added at the position of the playhead to clips that 
are already in the Timeline, and all media to the right of the playhead is rippled farther right to 
make room for the clip or clips being pasted. As with all other ripple edits, only clips on tracks 
with their auto select control turned on are affected.

Copying and Pasting Partial Clip 
Segments Using In and Out Points
You can use the Timeline’s In and Out points to cut and copy partial segments of longer clips in 
various ways. This is a valuable technique for doing in-depth audio and dialog editing, although 
it’s useful for copying partial segments of any kind of clip in the Timeline.

To Cut or Copy part of a clip to Paste elsewhere:

1	 Set In and Out points to isolate the part of the clip you want to cut or copy. You can 
use the Auto Select controls to include or omit clip segments on specific tracks while 
you do this.
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2	 Press Command-X to cut or Command-C to copy that clip segment.

3	 Clear the In and Out points by pressing Option-X. Otherwise, you’ll paste the clip 
segment right back into the same place it started.

4	 Move the playhead to the frame of the Timeline you want the pasted clip to start, and 
use the Paste or Paste Insert commands to paste the clip segment there.

You can also use In and Out points to paste only a partial segment of a much longer clip that 
you’ve cut or copied.

To Paste only part of a clip:

1	 Select a clip, and press Command-X to cut or Command-C to copy that clip.

2	 Set In and Out points to identify the region of the Timeline you want to paste into.

3	 Use the Paste or Paste Insert commands to paste only as much of the Cut or Copied 
clip as will fit between the In and Out points you’ve placed.

Copying and Pasting Clips to a Different Track
If all Auto Select controls on all tracks are turned on, clips are always pasted back to the same 
track they were copied from, starting at the position of the playhead. This is valuable for the 
many instances where you’ll find yourself copying and pasting clips you want to repeat, 
especially when doing audio editing. 

However, if you want to paste the clips you cut or copied to a different track entirely, you need 
to use the Auto Select controls to specify which track you want to paste to. Here are the rules:

�� You can force paste what you copied to a specific track by Option-clicking that track’s 
Auto Select control to solo it before pasting. Another way to do this is to Option-click 
any empty area of the track you want to Auto Select solo.

�� When one or more Auto Select controls are disabled, then clips are pasted to the 
lowest-numbered track with an enabled Auto Select control. 

�� If you’ve copied clips on multiple tracks, clips on the lowest copied track will be pasted 
to the lowest Auto Select enabled track, and all other clips will be pasted to higher 
tracks, with new tracks automatically created, if necessary.

�� If Auto Select is disabled on every single track, then a new track will be created above 
all other video tracks and/or below all other audio tracks, and the clip will be pasted 
into this new track, which has Auto Select turned on.

Audio Channels When Copying and Pasting Audio Clips
Copying and pasting audio has one other consideration. If you’re force pasting a clip into a 
different track, the track you solo the Auto Select control of could possibly be set to an audio 
channel mapping that doesn’t match the clips you’re pasting there. An example of when this 
would happen is if you copy stereo audio clips from a stereo track and paste them to a mono 
audio track.

DaVinci Resolve allows you to do this, so you have the freedom of pasting audio clips to any 
track you want to. However, extra audio channels within clips that exceed the number of 
channels supported by the audio track they’re on will be muted. Fortunately, this situation is 
easy to rectify. Simply right-click the track header of the problem audio track, and use the 
Change Track Type To submenu to change its channel mapping to one more appropriate to the 
clips you’ve pasted into it.
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Duplicating Clips and 
Transitions in the Timeline
One or more clips can be duplicated by making a selection, and then Option-dragging the 
selected clips to another position and/or track in the Timeline. When duplicating clips in this 
way, you must hold the Option key down until you release the mouse button.

Individual selected transitions can also be duplicated by Option-dragging them to another 
edit point.
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Chapter 19

Three and Four 
Point Editing
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Three and Four Point Editing
A more controlled form of editing is to use three and four point editing to make a specific range 
of source media fit into a specific range of the Timeline. This chapter covers the basics of three 
and four point editing, as well as the wide variety of edit commands that are available.

This chapter covers the following topics:

Introduction to Three-Point Editing	 366

Choosing a Track to Edit to Using Destination Controls	 366

Setting In and Out Points in the Timeline	 367

Mark Clip and Mark Current Selection	 368

Preview Marks During Three-Point Editing	 370

Dragging Preview Marks to Change an Edit	 371

The Rules of Three Point Editing	 371

Editing Rules for Split In and Out Points	 373

Editing a Specific Range of the Source Clip Into the Timeline	 373

Editing Part of a Source Clip to Fit Into a Specific Range of the Timeline	 374

Backtiming a Source Clip When Editing Into the Timeline	 375

Switch Focus to Timeline After Edit	 377

Different Types of Three and Four Point Edits	 377

Overwrite Edits	 377

Insert Edits	 378

Replace Edits	 379

Fit to Fill	 382

Place On Top	 383

Ripple Overwrite	 384

Append at End	 387

Insert Selected Clips to Timeline with Handles	 387

Three Point Editing From the Media Pool	 388

Example: Assembling Clips Into the Timeline From the Media Pool	 388
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Introduction to Three-Point Editing
Three-point editing is a standard editorial method that’s shared with many other postproduction 
applications, so this procedure should feel familiar. The idea is that you need only set any 
combination of three In and Out points  in the source clip and Timeline to edit a clip into your 
program at a specific time, and DaVinci Resolve automatically figures out the fourth edit point 
that’s necessary to execute the edit. Three-point editing is most commonly accomplished using 
Overwrite and Insert edits.

Choosing a Track to Edit to Using 
Destination Controls
The orange destination controls, found in the Timeline header area, let you specify which video 
and audio tracks you want incoming source clips to be edited to when you use editing methods 
other then drag and drop. No matter how many video or audio channels may be embedded 
within a single clip of media, only one video and one audio destination control is available. In 
the case of video, you can only expose one video channel of a clip at a time. In the case of 
audio, all audio channels for a given clip are embedded within a single Timeline track, making it 
a snap to edit stereo or other multi-channel audio sources together. (For more information 
about working with audio, see Chapter 25, “Working with Audio in the Edit Page.”)

Setting the destination control of a track is a vital step in the process of creating an edit, and is 
easy to do. You can set the video and audio destination controls to be separate tracks.

To set the destination tracks of incoming source clips, do one of the following:

�� Click the destination control of any unassigned track to enable that track as the 
destination.

�� Drag the destination control to any unassigned track in the Timeline.

�� Press Command-Option Up Arrow and Down Arrow to move the Video Destination 
control up and down among different video tracks, or press Command-Shift Up Arrow 
and Down Arrow to move the Audio Destination control up and down among different 
audio tracks.

�� Press Option-1 through 8 to set a video destination, or press Option-Command-1 
through 8 to set an audio destination on tracks 1 through 8.

Moving the destination control to 
track V2, labeled “Titles”

You can also disable the Video or Audio Destination controls in situations where you want to 
edit a source video clip into the Timeline without its audio, or vice versa.
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To disable or reenable a destination control, do one of the following:

Click an already assigned destination control to toggle it off and then on again. 
Disabled destination controls are highlighted white.

A disabled destination control

Setting In and Out Points in the Timeline
When you’re setting up an edit to the Timeline, you can oftentimes get away with simply putting 
the Timeline playhead at the frame where you want to edit the incoming source clip. In the 
absence of In or Out points, the playhead is used as the In point. However, you can set up 
different kinds of edits by setting specific In and Out points to define different ranges of 
the Timeline.

Methods of setting and clearing In and Out points in the Timeline:

�� To set an In or Out point: Select the Timeline or Timeline Viewer by clicking or 
pressing the Q key, then use the transport controls, jog bar, or control panel buttons 
to move the playhead, and press the I key to set an In point, or the O key to set an 
Out point.

�� To clear In or Out points: With the Timeline Viewer selected, press Option-I to clear the 
current In point, or Option-O to clear the current Out point.

�� To clear both the In and Out points at once: Press Option-X.

�� To jump the playhead to the current In or Out points: Press Shift-I to immediately 
move the playhead to the current In point, or Shift-O to move the playhead to the 
current Out point.

In and Out points shown in the Timeline, with unmarked areas outside the selection dimmed
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Methods of moving In and Out points in the Timeline:

�� Press the I or O keys at any time to change the In or Out points.

�� Drag any In or Out point in the Timeline ruler to another position.

The area of the Timeline outside the region that’s currently defined by In and Out points is 
dimmed, to call attention to the portion of the Timeline that will be affected by the next edit 
you’ll make.

Mark Clip and Mark Current Selection
These commands are automatic ways of setting In and Out points in the Timeline both at once, 
using the timing of other clips. They’re both exceptionally handy for defining the range of an 
incoming edit using clips that are already in the Timeline that you want to replace, or gaps in the 
Timeline that you want to fill. 

In short, Mark Clip uses the first and last frame of a target clip or gap in the Timeline to 
automatically set Timeline In and Out points for editing. For example, if there’s a shot in an edit 
that you want to replace with a different take of the same action, or there’s a gap in a sequence 
of clips that you’d like to quickly fill with b-roll, you can use the Mark Clip command to help 
set this up.

Mark Current Selection uses the first and last frames of a range of selected clips to 
automatically set Timeline In and Out points for editing. A good example is when you have a 
series of clips in the Timeline, all of which you’d like to overwrite with a single incoming source 
clip, you can use the Mark Current Selection command.

To use Mark Clip:

1	 Move the playhead to intersect either a clip you want to use to set In and Out points, or 
a gap (empty area) between two other clips that you want to target. The playhead can 
be on any frame of this clip, it doesn’t matter which.

Positioning the playhead at a clip you want to mark

2	 If there are other clips on a multi-track timeline that overlap the clip you’re targeting 
for this operation, then the clip on the lowest video track will be used as the target 
to set the In and Out points. If you want to target a clip on a higher track, then either 
disable the Auto Selection controls of all timelines underneath, or Option-Click the Auto 
Selection control of the track with the clip you’re targeting to solo it, which will force that 
track to be the target of this operation.

3	 Press the X key to automatically set In and Out points that match the first and last 
frames of the target clip.
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Using Mark clip to set In and Out points that match a clip’s duration

To use Mark Selection:

1	 Select one or more clips in the Timeline.

Selecting clips you want to use as a range to mark In and Out points

2	 Press Shift-A to automatically set In and Out points that match the first and last frames 
of the selection. A range of discontinuous clips will produce the same result as a range 
of continuous clips.

Marking a selection to set In and Out points

TIP: To clear both In and Out points, press Option-X, which is the opposite of 
this command.
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Preview Marks During Three-Point Editing
In order to help you see what will happen whenever you execute a three-point edit, preview 
marks appear in either the Source Viewer or the Timeline Ruler to let you know the exact 
duration of the Timeline that’s about to be affected by the edit you’re preparing to make. To 
prevent them from being a distraction, preview marks only appear once you’ve explicitly 
marked three edit points in the Source Viewer and Timeline, and they can be turned on and off 
by choosing View > Show Preview Marks.

For example, if you set In and Out points in the Source Viewer, and an In point in the Timeline, 
then a preview marker will appear in the Timeline Ruler to show the implied Out point in the 
Timeline of the edit you’re about to make.

A preview marker in the Timeline shows the Timeline Out point being automatically 
calculated by DaVinci Resolve based on the In and Out points that are set in the Viewer, 
and the In point in the Timeline

On the other hand, if you set both In and Out points in the Timeline, and only an Out point in the 
Source Viewer, a preview marker appears in the jog bar of the Source Viewer to show you the 
implied In point, in the Source Viewer, of the edit you’re about to make.

A preview marker in the Source Viewer shows the Source Viewer In point being 
automatically calculated by DaVinci Resolve based on the In and Out points that are set in 
the Timeline, and the In point in the Source Viewer
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If you like, you can move the playhead to the position of the preview mark by using Shift-I if the 
preview mark is an In point, or Shift-O if the preview marker is an Out point.

Dragging Preview Marks to Change an Edit
You can drag preview marks to alter the edit you’re about to make. When you drag a preview 
mark, the corresponding In or Out point that’s opposite the Viewer with focus is altered to 
accommodate the new three point edit you’re setting up. For example, if you have an In point in 
the Source Viewer, and In and Out points set in the Timeline, a preview mark appears in the 
Source Viewer to show the Out point that will be used to edit the clip in the Source Viewer into 
the Timeline. However, you can drag this preview mark to the left in the Source Viewer, and the 
result will be that the Out point in the Timeline will move along with it, since you’re 
retiming the edit.

Dragging a preview mark in the Source Viewer changes 
the opposite edit point in the Timeline

The Rules of Three Point Editing
In the previous examples, three point editing was being used by virtue of source In and Out 
points being set to define a range of the source clip to be edited into the Timeline, and the 
Timeline playhead being used as the acting Timeline In point; three points defined the edit to 
be made. However, three point editing is also very useful when you need to overwrite sections 
of a previously edited timeline with new source clips in a controlled manner, such as when 
adding an insert shot to a scene to cover a particular change you’re making that would 
break continuity.
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Depending on the combination of Source and Timeline In and Out points you set, the following 
rules govern three-point editing:

�� If there is no In point in the source clip: The first frame of media will be used as the 
acting source In point. This can be seen by the thick bar that extends to the left of the 
Out point in the Source Viewer’s jog bar.

�� If there is no Out point in the source clip: The last frame of media will used as the 
acting source Out point. This can be seen by the thick bar that extends to the right of 
the In point in the Source Viewer’s jog bar.

A thick bar indicates which part of the source clip 
will be used in the absence of a Source Out point

�� If there are no In or Out points in the Timeline: The playhead will be used as the 
acting Timeline In point. 

�� If you set a Timeline In point but no Timeline Out point: The whole range from the In 
to Out points of the source clip is edited into the Timeline such that the Source In point 
is aligned with the Timeline In point. This can be seen by the thick bar that extends to 
the right of the In point in the Timeline Ruler.

A thick bar indicates where the Source clip will be 
edited in the absence of a Timeline Out point

�� If you set a Timeline Out point but no Timeline In point: The incoming source clip 
will be backtimed so the Out point of the source clip is aligned with the Timeline Out 
point. This can be seen by the thick bar that extends to the left of the Out point in the 
Timeline Ruler.

A thick bar indicates a backtimed edit in the absence of a Timeline In point
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�� If you set Timeline In and Out points but only a Source Out point: In this case, the 
incoming source clip will also be backtimed so the Out point of the source clip is 
aligned with the Timeline Out point, with the Timeline edit points defining the duration 
of the source clip being edited.

�� If you set all four Source In and Out and Timeline In and Out edit points: The Timeline 
edit points dictate the duration of source clip that is edited into the Timeline, and the 
frame at the Source In point is aligned with the Timeline In point, unless you perform a 
Fit to Fill or Ripple Overwrite edit, both of which can be done as four point edits.

Editing Rules for Split In and Out Points
If you’ve created split In and Out points in the Source Viewer or Timeline, the following 
rules apply:

�� If the Source Viewer has split In and Out Points: The leftmost split point of the 
incoming clip, whether video or audio, will be aligned with the playhead when the clip is 
edited; the other split point will be offset to the right.

�� If the Timeline has split In and Out Points: The In point of the incoming clip will be 
aligned with the left-most split point, whether video or audio; the accompanying audio 
or video In point will be offset to the split point to the right.

Editing a Specific Range of the 
Source Clip Into the Timeline
This section provides some common examples of three-point editing when performing edits in 
the middle of a previously edited timeline. In the following example, you have a specific range 
of source media that you need to edit into the Timeline, and you don’t particularly care what 
gets overwritten in the Timeline by the incoming clip.

1	 Set In and Out points in a source clip, either in the Media Pool or in the Source Viewer.

Setting source clip In and Out points

2	 To set where you want the incoming clip to go, set the destination control to the tracks 
you want to edit onto, and then do one of the following:

�� Move the Timeline playhead to the frame you want to use as the Timeline In point 
for the edit.

�� Set a Timeline In point for the edit.

TIP: If you want to use all four Source and Timeline edit points to retime a 
source clip to fit into a specific range of the Timeline, use a Fit-to-Fill edit 
instead of an Overwrite edit.
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Setting a Timeline In point

3	 To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or 
drag a clip onto the appropriate overlay in the Timeline Viewer.

The resulting edit; the duration of the source clip defines the duration of the edit

Editing Part of a Source Clip to Fit Into a 
Specific Range of the Timeline
In this example, you have a section of a clip or a gap in the edited sequence of clips in the 
Timeline that you want to fill with as much of the current source clip as it will take to “plug 
the hole.”

1	 Set an In point in the source clip, if necessary, to define the first frame of the range of 
source media that you want to edit into the Timeline.

Setting a source clip In point only
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2	 Set In and Out points in the Timeline to set both where you want the incoming clip to 
go, and how much of the incoming clip you want to use.

Setting both In and Out points of the Timeline for a gap

3	 To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or 
drag a clip onto the appropriate overlay in the Timeline Viewer.

The resulting edit; the duration of the Timeline edit points 
define how much of the source clip is edited

Backtiming a Source Clip When Editing Into the Timeline
In this last example, you’ve got a specific moment in the second half of a source clip that you 
need to align with an Out point in the Timeline, such that the remaining duration of the incoming 
clip overwrites the edited sequence of clips from the right to the left. This is referred to as 
backtiming, when you’re lining up a Source Out point with a Timeline Out point in order to make 
an edit, and can be set up one of two ways.

Backtiming method one:

1	 Set In and Out points in the source clip, either in the Media Pool or in the 
Source Viewer.

2	 Set an Out point in the Timeline, at the frame where you want the corresponding 
Out point of the incoming source clip to be aligned.
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Setting up a backtimed match-on-action edit via In and Out points 
in the Source Viewer, and only an Out point in the Timeline

3	 To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or 
drag a clip onto the overwrite overlay in the Timeline Viewer.

The resulting edit, aligning the Out point of the source clip with the Out point of the Timeline

Backtiming method two:

1	 Set an Out point in the source clip, either in the Media Pool or in the Source Viewer.

2	 Set In and Out points in the Timeline to set both where you want the incoming clip to 
go, and how much of the incoming clip you want to use.

Setting up a backtimed edit by setting an Out point in the Source Viewer, 
and In and Out points in the Timeline to define the duration of the edit

To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or 
drag a clip onto the appropriate overlay in the Timeline Viewer.

The resulting edit, aligning the Out point of the source clip with the Out point of the Timeline
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Switch Focus to Timeline After Edit
A setting in the Edit menu, “Switch focus to timeline after edit,” lets you set whether or not 
DaVinci Resolve changes the application focus from the Source Viewer to the Timeline Viewer/
Timeline every time you make an edit. This setting is on by default.

For example, if you’re assembling clips from many different source files into the Timeline, and 
trimming the results as you go, leaving this option on may save you time. In this case, after 
every edit, the focus switches from the Source Viewer to the Timeline, so you can quickly select 
the clip or edit point you want to trim and make your adjustments before loading the next clip 
into the Source Viewer in preparation for the next edit.

On the other hand, if you’re editing several pieces from a long interview clip into the Timeline, 
you may want to turn this setting off to make it easy to continue playing forward in the Source 
Viewer, setting In and Out points and editing clips into the Timeline as you go. After every edit, 
focus remains on the Source Viewer, so you can continue making edits from the same source 
clip without interruption.

Different Types of Three 
and Four Point Edits
This section covers the different types of edits that are available for cutting source clips into the 
currently open Timeline.

Overwrite Edits
The most common type of edit you’ll make, an overwrite edit eliminates whatever media was in 
the Timeline previously with the incoming source clip taking the place of whatever was there. 
Overwrite edits are commonly used when initially assembling clips, or doing three-point editing.

Overwrite edits do not ripple the Timeline.

To overwrite one or more clips in the Timeline:

1	 Move the playhead to the frame of the Timeline where you want to insert a clip.

2	 Click the appropriate audio and video destination controls of the tracks you want to edit 
the incoming source clip onto. If necessary, create new tracks.

3	 Select a single clip in the Media Pool to open it into the Source Viewer, then set In and 
Out points to define the range of media you want to insert.

4	 To make the edit, choose Edit > Overwrite, click the Overwrite Clip button in the toolbar, 
press the F10 key, or drag a clip onto the Overwrite overlay in the Timeline Viewer.
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Before and after an overwrite edit, the Timeline duration stays the same

The selected clips in the Media Pool are overwrite edited to the selected track starting 
at the position of the playhead, eliminating whatever was there originally while adding 
incoming clip. No other clips are rippled during this operation.

Insert Edits
An insert edit splits whatever media is already in the Timeline at the position of the playhead, 
and pushes that media to the right to make room for the incoming clip.

Insert edits have the effect of rippling almost all clips in the Timeline that are to the right of the 
Insert Edit point you’re making, pushing them further to the right by the duration of the incoming 
source clip. However, clips in any tracks of the Timeline that overlap to the left of the Insert Edit 
point aren’t rippled, and remain in place.

For example, if you’re insert editing a clip into the middle of a sequence of clips in track V1 and 
A1 of the Timeline, and there’s also a clip of music edited into track A2 that overlaps well to the 
left of the insert edit point, the music clip remains where it is, but the other clips on track V1 and 
A1 that are to the right of your edit point on are pushed to the right.

To insert edit one or more clips into the Timeline:

1	 Move the playhead to the frame of the Timeline where you want to insert a clip.

2	 Click the appropriate audio and video destination controls of the tracks you want to edit 
the incoming source clip onto. If necessary, create new tracks.

3	 If necessary, set In and Out points in the clip or clips you want to insert edit into the 
Timeline using the controls of the Media Pool or the Source Viewer.	

4	 Do one of the following:

�� Select one or more clips in the Media Pool, right-click one of the selected clips, and 
choose “Insert Selected Clips to Timeline.” 

�� Choose Edit > Insert, click the Insert Edit button in the toolbar, press the F9 key, or 
drag any clip onto the Insert overlay in the Timeline Viewer.
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The selected clips are insert edited to the selected track at the position of the 
playhead, pushing all other media in the destination track back by the total duration of 
the selected clips, except for clips on other tracks that overlap to the left of the edit 
point (as seen by the overlapping music clip in the example below).

Before and after an overwrite edit, the Timeline gets longer as non-
overlapping clips to the left of the edit point are rippled to the right

Replace Edits
Replace edits are a unique three-point edit type that aligns the frame at the Source Viewer 
playhead with the frame at the Timeline playhead when the edit is executed. This is the fastest edit 
type to use when you need to align an action at a specific frame of video, or a sound at a specific 
frame of audio, to a particular frame’s action or sound in the video or audio of the Timeline.

The fastest way of using the Replace Edit is to not bother setting either In or Out points in the 
Source Viewer, and to either use the duration of an existing clip intersecting the Timeline to 
define the edit, or a pair of timeline In/Out points specifying either a section of a clip you want 
to overwrite, or an empty section of the Timeline to which you want to edit.

Replace edits do not ripple the Timeline.

Replace Edits to Replace Existing Clips in the Timeline
A replace edit automatically replaces an existing clip in the Timeline with a clip in the Source 
Viewer, so long as that clip overlaps the playhead and is on a track with its destination control 
enabled. When you make a Replace edit in this way, DaVinci Resolve automatically uses the 
duration of the Timeline clip to define the duration of the incoming media, and the positions of 
the Viewer and Timeline playheads to line up how the incoming media should be placed. This is 
an extremely fast edit to make, since you needn’t use any In or Out points at all.

To replace a clip in the Timeline:

1	 Move the playhead in the Timeline to the clip that you want to replace, and align it with 
a frame that you want to line up with a frame in the clip you’ll be replace editing into 
the Timeline.

2	 Click the appropriate audio and video destination controls of the track containing the 
clip you want to replace.

3	 Open a clip into the Source Viewer.
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4	 Move the playhead in the Source Viewer to the frame that you want to line up with the 
frame at the position of the playhead in the Timeline.

In the example shown below, the original clip that was shot on location of a car driving 
past a slab of real concrete (shown in the Timeline Viewer at right) is going to be replaced 
by a VFX shot of a concrete wall with a small hole for the car to drive through (shown in 
the Source Viewer at left). The playhead in the Source Viewer is aligned on the very 
same frame as the playhead in the Timeline Viewer, which can be seen by the identical 
position of the white stripe on the road in the lower right-hand corner of the picture.

In the Source Viewer to the Left is a VFX clip we want to edit into the Timeline to 
replace the existing Timeline clip, shown in the Timeline Viewer at Right

5	 Now that the playheads are aligned on the frames that must match one another in 
both the Source and Timeline Viewers, choose Edit > Replace, click the Replace 
Clip button in the toolbar, press F11, or drag any clip onto the Replace overlay in the 
Timeline Viewer.

The resulting replace edit, in which the original timeline clip is replaced by the 
incoming Source Viewer clip by aligning the frames at each playhead

The camera original clip in the Timeline is now replaced with the VFX source clip from the 
Media Pool, with the source frame at the Source Viewer playhead aligned with the frame at the 
Timeline playhead.

Replace Edits to Edit Clips Into Empty Tracks
You can also use a replace edit to edit a clip into an empty track of the Timeline so that the 
frame at the position of the Source playhead is aligned with the Timeline playhead, and the In 
and Out points of the incoming clip fall where they may. This is useful when you want to “spot” a 
particular action of an alternate take or a cue in a sound effect to a specific frame of 
the Timeline.



381

T
hr

e
e

 a
nd

 F
o

ur
 P

o
in

t 
E

d
iti

ng
 

P
ar

t 
3 

–
 1

9

To use Replace Edit to spot a sound effect or action video clip into the Timeline:

1	 Move the playhead in the Timeline to the clip that contains the moment you want to 
align the new incoming audio or video clip with, and position it on the exact frame that 
you want to line up with a frame of the clip you’re going to edit into the Timeline.

2	 Click the appropriate audio and video destination controls of the empty track you want 
to edit the incoming clip into.

3	 Open a clip into the Source Viewer.

4	 Move the playhead in the Source Viewer to the frame that you want to line up with 
the frame at the position of the playhead in the Timeline. This may be the sample 
of a sound effect that corresponds to the action in a particular frame of your 
program’s video, or a frame of video that corresponds to a particular sound in your 
program’s audio.

5	 If necessary, set In and Out points in the Timeline to restrict how much of the incoming 
clip will be edited. Otherwise, the entire source clip will be edited into the Timeline.

In the Source Viewer to the Left is an SFX clip, shown in the Timeline 
Viewer at Right

6	 Now that the playheads are aligned on the frames that must match one another in 
both the Source and Timeline Viewers, choose Edit > Replace, click the Replace 
Clip button in the toolbar, press F11, or drag any clip onto the Replace overlay in the 
Timeline Viewer.

The resulting replace edit, in which the incoming Source Viewer 
clip is aligned perfectly with the video

The SFX source clip has now been edited into the specified audio track, with the 
source frame at the Source Viewer playhead perfectly aligned with the frame at the 
Timeline playhead
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Fit to Fill
Fit-to-fill edits are the only edit type that actually use all four edit points, and it’s the only edit 
type that retimes clips at the same time as they’re being edited. By setting In and Out points in 
the incoming source clip, and another pair of In and Out points in the Timeline, you can stretch 
or compress the timing of the specified range of source media to cover the entire specified 
range of the Timeline. In the process, the speed ratio of the clip changes so the clip plays in 
either fast or slow motion.

Fit-to-fill edits are especially valuable when you have a source clip in which the action is slightly 
slow, and you just want to speed it up by squeezing it into a shorter duration of the Timeline. 
They’re also incredibly handy in situations when you have a gap in an edited sequence of clips 
to fill with a source clip that’s just not long enough, but in which slightly slower motion won’t be 
noticeable.

Fit-to-fill edits do not ripple the Timeline.

To use Fit-to-fill to edit a clip into the Timeline:

1	 Do one of the following to define where in the Timeline to edit the incoming clip:

a.	� You can set both In and Out points in the Timeline, to define the duration you want to fill 
with the incoming source clip as a three point edit.

b.	� You can clear the Timeline In and Out points (pressing Option-X), so that you can 
instead use the duration of whichever clip or gap intersects the playhead on the track 
with the destination controls assigned to them. In the following screenshot, the clip can 
easily be edited to take the place of the gap by positioning the playhead anywhere 
within it. 

Setting timeline In and Out points to mark a gap

2	 Next, you’ll need to set both In and Out points in the Source Viewer to define a longer 
or shorter source clip that you want to fill into the available space. In this example, we 
have a very short section of the source clip defined that, because of the matching 
action in the Timeline, must be fit into the larger gap seen above.

Setting In and Out points in a source clip to define a shorter 
duration segment that you want to completely fill the gap

3	 Click the audio and video destination controls of the tracks you want to edit the 
incoming source clip onto. If necessary, create new tracks.

4	 Choose Edit > Fit to Fill, drag any clip onto the Fit-to-Fill overlay in the Timeline Viewer, 
or press Shift-F11.
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The resulting edit; the shorter source clip is retimed to fit into the longer timeline gap

The incoming source clip is retimed, as necessary, to fit into the specified duration of 
the Timeline. This can be seen by the retiming badge that appears within the clip that’s 
just been edited into the Timeline.

Place On Top
Place-on-top edits automatically superimpose clips onto the first empty track above (for video 
clips) or below (for audio clips) any other clips in the Timeline that either intersect the playhead 
or fall in between the currently set Timeline In and Out points, regardless of the current track 
specified by the destination controls. It’s designed to make it easy to superimpose titles and 
other clips you want to composite over another clip, or to add additional versions of clips such 
as VFX on top of previous versions that you want to preserve.

Place-on-top edits create new timeline tracks if necessary, and do not ripple the Timeline.

To use Place-on-top to edit a clip into the Timeline:

1	 To choose where in the Timeline the clip will be “placed on top,” do one of the following:

�� Move the playhead to intersect the clip you want to edit the incoming source clip 
on top of.

�� Set In and Out points in the Timeline to define the duration within which you want to 
place the incoming source on top.

2	 Set In and Out points in a source clip that you want to edit.

3	 Choose Edit > Place on Top, drag any clip onto the Place-on-Top overlay in the Timeline 
Viewer, or press F12.
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Before and after using Place on top, the incoming text generator is 
superimposed to a track above the clip at the position of the playhead

Incoming video clips will be edited to the topmost video track so they are above any 
previously existing video in the Timeline. Incoming audio clips are edited to the 
bottom-most audio track so they are below any previously existing audio. If necessary, 
new video and/or audio tracks will be created automatically to hold the new 
incoming clip.

Ripple Overwrite
Ripple Overwrite is a four-point edit that’s useful when you can identify a segment of the 
Timeline you want to overwrite, but the incoming clip is of a different duration and you want 
DaVinci Resolve to automatically ripple the Timeline to accommodate the difference.

You can use the Ripple Overwrite command one of two different ways:

�� You can overwrite an entire clip in the Timeline with a another clip of different length.

�� You can overwrite a section of the Timeline marked with In and Out points with a 
another clip of different length. 

In both cases, all clips to the right of the clip or timeline section being overwritten are rippled to 
the right or left to make room or fill the gap. Because of this, the Ripple Overwrite edit will most 
likely change the overall duration of your edited sequence of clips.

Using Ripple Overwrite on an Entire Clip in the Timeline
Using Ripple Overwrite as an automatic four-point edit, you can overwrite whichever clip in the 
Timeline intersects the playhead on the tracks defined by the destination controls, in its 
entirety, with the incoming clip. For this to work, there must be no In or Out points set in 
the Timeline.

After performing a Ripple Overwrite in this way, the original timeline clip is eliminated and the 
incoming clip takes its place, and all clips to the right of the clip being replaced are either (a) 
rippled to the right if the incoming clip is longer than the original timeline clip, or (b) rippled to 
the left if the incoming clip is shorter than the original timeline clip. All of this is done in a 
single step.

This is useful in situations where you want to quickly switch one clip in the Timeline with another 
of unequal duration and have the Timeline automatically make room to allow this all in one step.

To use Ripple Overwrite to replace an entire clip in the Timeline with another source clip:

1	 Move the playhead in the Timeline to intersect the clip that you want to replace; the 
playhead’s exact position is not important.

2	 Click the appropriate audio and video destination controls of the track containing the 
clip you want to replace, and press Option-X to eliminate any In and Out points there 
might be in the Timeline.
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3	 Open a clip into the Source Viewer, and set In and/or Out points as necessary to define 
how much of the clip you want to edit into the Timeline.

4	 To execute the edit, choose Edit > Ripple Overwrite, drag the clip to the Ripple 
Overwrite overlay of the Timeline Viewer, or press Shift-F10.

Before and after of using Ripple Overwrite with no Timeline In or Out points; Clip K at the 
position of the playhead is replaced in its entirety by the short segment of Clip U from the 
Source Viewer; all clips with In points to the right are rippled to the left to fill the gap

Using Ripple Overwrite on a Section of the Timeline Defined by In/Out Points
You can also use Ripple Overwrite as an explicit four-point edit, to overwrite a section of the 
Timeline that’s marked with In and Out points with an incoming clip that’s also marked with In 
and Out points that is of unequal duration. 

After performing a Ripple Overwrite in this way, the section of the Timeline marked with In and 
Out points is eliminated and the incoming clip takes its place, and all clips to the right of the clip 
being replaced are either (a) rippled to the right if the incoming clip is longer then the original 
timeline clip, or (b) rippled to the left if the incoming clip is shorter then the original timeline clip. 
All of this is done in a single step.

A good example of when this can be useful is when you’re cutting a close-up of an actor 
performing a particular action into a medium shot of the actor performing the same action that’s 
already in the Timeline, and the action you’re matching is of different durations in each of the shots.

To use Ripple Overwrite to replace a section of the Timeline with another source clip:

1	 Set In and Out points in the Timeline to mark what part of the clip or clips you want 
to overwrite. You must set both In and Out points for this to work as expected. In this 
example, the part of the clip where the woman leans forward is marked.

Setting In and Out points to identify an action in the Timeline that you want 
to overwrite with another clip that has a matching action
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2	 Open a clip into the Source Viewer, and set In and/or Out points as necessary to define 
how much of the clip you want to edit into the Timeline. In this example, a section of the 
woman’s close up where she leans forward in a way that matches the same movement in 
the wider shot is marked.

Setting In and Out points to identify an action in a source clip that you want to 
overwrite the action you’ve marked in the Timeline. It’s a matching action, but 
the timing might be different, and that’s okay with this kind of edit.

3	 To execute the edit, choose Edit > Ripple Overwrite, drag the clip to the Ripple 
Overwrite overlay of the Timeline Viewer, or press Shift-F10. As a result, the section of 
the timeline that was marked in step 1 is overwritten by the section of the source clip 
marked in step 2, and all clips to the right of this edit in the Timeline are rippled to the 
right to make room for the much longer source clip. The final result is an edit where the 
movements match nicely.

After the Ripple Overwrite, the part of the Timeline clip marked with In and Out points 
has been overwritten by the part of the Source clip marked with In and Out points, and 
all clips to the right of this edit in the Timeline are rippled left or right as necessary
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Append at End
Append at End always puts the edited clip at the very end of the current Timeline. It’s a very 
useful edit type when you’re quickly stringing together a series of clips.

To use Append at End to edit a clip into the Timeline:

1	 Set In and Out points in a source clip that you want to add to the end of the current 
Timeline. If necessary, change the sort order of the Media Pool to put these clips into 
the order in which you want them to be added to the Timeline.

2	 Click the audio and video destination controls of the tracks you want to edit the 
incoming source clip onto. If necessary, create new tracks.

3	 Choose Edit > Append to End Of Timeline, drag the clip to the Append At End overlay 
of the Timeline Viewer, or press Shift-F12.

Incoming video clips are added after the very end of the last clip in the Timeline.

Insert Selected Clips to Timeline with Handles
“Insert Selected Clips to Timeline With Handles” is a command that’s available from the Media 
Pool contextual menu for editing one or more selected clips to the currently open timeline, such 
that the default handles length is subtracted from the beginning and end of each clip. The goal 
is to make it easy to string together a series of clips that you want to connect using transitions 
by automatically changing the In and Out points of each clip being edited into the Timeline in 
order to add handles. 

To use Insert Selected Clips to Timeline with 
Handles to edit one or more clips into the Timeline:

1	 Select one or more clips in the Media Pool that you want to add to the Timeline. If 
necessary, change the sort order of the Media Pool to put these clips into the order in 
which you want them to be added to the Timeline.

2	 Click the audio and video destination controls of the tracks you want to edit the 
incoming source clip onto, and position the playhead where you want the incoming 
clips to start. If necessary, create new tracks.

3	 Right-click one of the selected clips in the Media Pool and choose “Insert selected clips 
to timeline with handles” from the contextual menu.

The selected clips are added to the Timeline starting at the position of the playhead.

To change the length of handles that are removed, open the Editing panel of the User 
Preferences and change the “Default handles length” setting. Handles will not be added in 
either of the following two cases:

�� If any of the selected clips in the Media Pool already have handles because of In and 
Out points that you’ve set, then additional handles won’t be added.

�� If the duration of the frames to be removed to create handles in this operation is greater 
than the duration of one or more of the clips you’ve selected in the Media Pool, then 
handles won’t be added at all. 
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Three Point Editing From the Media Pool
You can also execute three point edits directly from the Media Pool, with no need to use the 
Source Viewer.

Example: Assembling Clips Into the 
Timeline From the Media Pool
If you want, you can also edit clips directly into the Timeline from the Media Pool using a variety 
of commands. This can be a fast way of appending clips to the end of the Timeline (although 
you can also perform Insert edits this way).

To edit one or more clips from the Media Pool to the Timeline:

1	 If necessary, set In and Out points for each of the clips you want to edit into the 
Timeline using either the Media pool thumbnails (in Thumbnail view), the Media Pool 
Filmstrip Viewer (in List view), or by opening each one into the Source Viewer. For each 
method, press I to set an In point, and O to set an Out point.

2	 Change the sort order of the Media Pool’s browser area to put the clips into the order 
in which you want them to appear. In Thumbnail view you can use the Sort Order 
menu, but in List view you can click the header of any metadata column to sort by that 
column’s data.

3	 Position the playhead to where you want to edit the clips.

4	 Click, drag, use the Command-Option and Command-Shift Up and Down Arrow Key 
shortcuts, or use the Option-1–8 and Command-Option-1–8 key shortcuts to assign the 
video and audio destination controls to the tracks you want to edit the video and audio 
of the incoming clip(s) to. Click any destination control itself to disable it if you want to 
edit clips into the Timeline as audio or video only.

5	 Select one or more clips you want to edit. Insert, Overwrite, Place On Top, Ripple 
Overwrite, and Append At End edits are all capable of editing multiple clips at once, 
while Replace and Fit to Fill edits can only edit one clip at a time, and will only edit the 
first of multiple selected clips into the Timeline.

6	 To perform the edit, do one of the following:

�� Drag the selected clips to the Timeline Viewer and drop them on an editing overlay 
to execute that edit type.

�� Right-click one or more selected clips in the Media Pool, and choose “Insert Selected 
Clips to Timeline,” or “Append Selected Clips to Timeline.”

The selected clip(s) are edited into the Timeline.
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Chapter 20

Marking and 
Finding Clips in 
the Timeline 
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Marking and Finding Clips in the Timeline
As you work on your project, you’ll find it useful to identify important information about each 
clip, and about significant moments in each timeline, using a combination of Flags, Markers, and 
clip Label colors. These can be applied to source clips in the Media Pool, or to clips that have 
already been edited into timelines. In the case of markers, these can also be added to the 
Timeline ruler itself to help you keep track of important moments or notes, and to help you with 
snapping. You’ll also find yourself modifying clips in different ways, unlinking and relinking the 
audio and video of different clips, enabling and disabling clips in the timeline. 

This chapter covers the following topics:

Using Flags	 391

Using Markers	 391

Adding Markers to Clips	 391

Adding Markers to Timelines	 393

Saving In and Out Point Ranges As Markers with Duration	 393

Editing Marker Information	 394

Reading Marker Information	 396

Using Markers for Navigation	 397

Exposing Markers in Lists	 397

Editing With Markers in the Media Pool	 398

Color Labeling Clips in the Timeline	 399

Finding Clips, Media, Markers, Gaps, and Timelines	 400

Finding Clips in the Timeline	 400

Finding Offline Clips in the Timeline	 400

Finding Edit Index Events Using Clips in the Timeline	 400

Finding Clips in the Media Pool	 400

Finding Clips Using Markers or Flags	 401

Finding Gaps	 401

Finding the Currently Open Timeline in the Media Pool	 401

Finding Media Using Match Frame Operations	 402

Matching From the Timeline	 402

Matching From a Source Clip	 403

Finding a Clip in the Media Pool Using a Timeline Clip	 404

Using a Clip in the Source Viewer to Find a Media Pool Clip	 404

Using a Clip in the Timeline to Find a Media Pool Clip	 404
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Using Flags
Flags are meant to mark an entire clip, and they also flag every other clip in the Timeline that 
shares the same Media Pool source clip, making this a handy way of quickly identifying which 
clips in a given timeline come from the same Media Pool source.

The Flag and Marker buttons and pop-ups.

You can apply multiple flags to clips, with a variety of colors to choose from. In addition to 
flagging specific media files, flags can be useful for timeline filtering in the Color page, sorting 
by column in the Media Pool, and a variety of other operations.

Methods for flagging clips:

�� To flag a clip: Select one or more clips, and either click the Flag button to flag that 
clip with the current color, or click the Flag pop-up in the toolbar to choose a different 
color and then click the Flag button. In the Edit page, flags appear in the Timeline 
superimposed in the name bar of each clip.

�� To remove all flags from a clip: Select one or more clips with flags you want to remove, 
then click the Flag pop-up in the toolbar, and choose the top “Clear All” option. 

�� To filter all flagged clips in the Edit Index: Click the Option menu of the Edit Index 
and choose Show Flags. Each flagged clip appears in a list, with a column showing the 
color(s) of the flags applied to each entry in the list.

Using Markers
Markers are used to call attention to a particular frame within a specific clip. Markers can be 
individually colored, and can have customized name and note text. Whenever you enter text 
into a marker, that marker displays a small dot that indicates there’s more information inside of it. 
Once placed, markers snap to In and Out points, edit points, the playhead, and other markers 
whenever snapping is enabled, making it easy to use markers to “measure” edits and trims that 
you make in the Timeline.

Adding Markers to Clips
You can place markers on the jog bar of source clips in the Source Viewer (or in the Media page 
Viewer), and on clips that are selected within a timeline.

(Top) Markers placed on a source clip, (Bottom) Markers placed on a clip in the Timeline
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When you add markers to a source clip, those markers also appear in the Media Pool as 
hierarchically disclosable items attached to that clip in List view (markers are not visible in 
Thumbnail view). More information about using markers in the Media Pool’s List view appears 
later in this chapter.

Markers can be viewed as separate clips identified by marker 
name when the Media Pool is set to List view

The following procedures describe how to add markers to clips and timelines in 
DaVinci Resolve.

To mark a source clip in the Source Viewer or Media Page Viewer, do one of the following: 

�� To place a marker without doing anything else, move the playhead to the frame you 
want to mark, and then press M. 

�� To place a marker and immediately open the marker dialog to enter a name or note 
within it during playback, press Command-M. Playback pauses until you enter the text 
you want to and close the marker dialog again, at which point playback continues.

�� Move the playhead to the frame you want to mark, then right-click in the jog bar and 
choose a marker color from the Add Marker submenu of the contextual menu.

To mark a clip in the Timeline, do one of the following: 

�� Select one or more clips you want to mark, then move the playhead to the frame of a 
selected clip in the Timeline, and click the Marker button in the toolbar (or press M) to 
place a marker at that frame, using the current color (if multiple overlapping clips are 
selected, you’ll add a marker to all clips). 

�� To place a marker during playback and immediately open the marker dialog to enter 
a name or note within it, select one or more clips you want to mark, play through the 
selection until you want to place a mark, then press Command-M. Playback pauses 
until you enter some text and close the marker dialog again, at which point playback 
continues.

�� Select one or more clips you want to mark, and then click the Marker pop-up to choose 
a different color, and click the Marker button. 

Markers appear in the Timeline at the top of the title bar of the clip to which they’re applied
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Adding Markers to Timelines
You can also place markers of any color into the Timeline ruler to denote specific times for 
future reference, or add notes about issues you want to keep track of.

Timeline markers placed for future reference

You should note that all markers placed on clips or in the Timeline also appear within the 
Mini-Timeline of the Color page, making it easy to place notes for later reference when grading.

Clip and Timeline markers as seen in the Mini-Timeline of the Color page

Once you’ve added one or more markers placed on clips, snap to clip In and Out points, edit 
points, the playhead, and other markers whenever snapping is enabled.

To mark the Timeline itself, make sure all clips are deselected, and do one of the following: 

�� Click the Marker button (or press M) to place a marker of the currently selected color in 
the Timeline ruler. 

�� To place a marker during playback and immediately open the marker dialog to 
enter a name or note within it, select one or more clips you want to mark, then press 
Command-M. Playback pauses until you enter some text and close the marker dialog 
again, at which point playback continues.

�� Click the Marker pop-up to choose a different color, and click the Marker button. 

�� Right-click in the Timeline ruler and choose a marker color from the Add Marker 
submenu of the contextual menu.

Saving In and Out Point Ranges As Markers with Duration
You can also create markers with duration to keep track of any region of a clip or timeline that 
you’ve defined with In and Out points. This lets you identify multiple regions of a clip that you 
might later want to edit into a program.

To turn In and Out points into a marker with duration:

1	 Set In and Out points in the Source Viewer jog bar to identify a region you want to log 
for future reference.

Marking In and Out points in preparation to log 
that section of the clip
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2	 Do one of the following:

�� Right-click the jog bar and choose Convert In and Out to Duration Marker

�� A marker with duration appears above the In and Out points. To edit its name or 
notes, double-click the marker, press Shift-M, or choose Mark > Modify Marker.

A marker with duration is created from the In and Out points

In this way, you can log several regions within a single clip for future use. 

A clip with multiple logged sections identified via markers with duration

This an extremely useful logging technique for two reasons. First, markers with duration can be 
searched for in the Media Pool using the All Fields, Marker Name, and Marker Notes Filter by 
options. Second, they can be filtered with Smart Bins using the Marker Name and Marker Notes 
Media Pool Properties options.

Editing Marker Information
Once you’ve added some markers, you may want to edit their contents to make them 
more useful.

To open a marker’s edit dialog to alter its properties:

1	 Do one of the following:

�� Press Command-M to add a marker during playback and immediately open its 
edit dialog.

�� Double-click any marker you want to edit.

�� Move the playhead to the frame containing the marker you want to annotate using 
Shift-Up Arrow/Down Arrow and press M.

�� Select a marker anywhere in the Source Viewer or Timeline, and press Shift-M.

2	 When the marker dialog opens, you can modify several properties.

The properties found in the Marker Dialog
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�� Time: The frame the marker is positioned at relative to that clip or timeline.

�� Duration: Optional, the length of a marker that’s been assigned a duration.

�� Name: The name of the marker, defaults to the number of that marker in the order it 
was added.

�� Notes: A field where you can enter any information you want to keep track of.

�� Color: A series of buttons for choosing the color of the marker.

�� Remove Marker: Deletes that marker.

�� Done: Closes the marker edit dialog.

3	 When you’re finished, click Done.

Once you add notes to a marker, a small symbol appears on top of that marker to show you it 
has information.

A small dot on a marker shows 
that it contains notes

To move one or more markers in the Timeline or Source Viewer: 

�� Click a marker or Command-click multiple markers you want to move, and drag them 
to a new location.

�� Drag a bounding box from the Timeline up into the Timeline ruler to select multiple 
markers, and drag them to a new location.

To enable marker rippling:

Choose Timeline > Ripple Timeline Markers. When checked, all markers to the right of a 
clip being ripple edited, trimmed, or ripple deleted will ripple to the left along with the 
rest of the Timeline. You can turn this behavior off and on at will.

To modify marker duration:

�� Option-drag any marker to the right or left to create a marker with duration.

�� Move the playhead to the frame containing the marker you want to modify and press 
M, or double-click the marker you want to edit, then type a number into the duration 
field, and click Done. 

�� Markers with duration appear as a bar in the Timeline ruler or jog bar of the Source 
Viewer. Drag the middle of a marker with duration to move it, or drag the left or right 
edge to change its duration.

�� To eliminate a marker’s duration, set its numeric duration to 00:00:00:00 in the 
marker dialog, or drag either end so that it merges with the other as a single marker.

A marker with duration in the Timeline
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Methods of deleting markers:

�� To remove one or more markers using the mouse: Click to select a marker, or 
Command-click to select multiple markers, and press the Delete key. You can also 
double-click a marker to open its dialog, and click the Delete button.

�� To remove a marker using the keyboard: Move the playhead to the marker you want 
to delete, and press Option-M.

�� To remove all markers from a clip: Select one or more clips with markers you want 
to remove, then either press the Backspace key, or click the Marker pop-up in the 
Toolbar, and choose Clear All.

�� To remove all markers from the Timeline: With all clips deselected, choose Clear 
All from the marker pop-up menu in the Toolbar, or right-click the Timeline ruler, and 
choose Remove All Markers from the contextual menu.

Reading Marker Information
Once you’ve added a number of markers with custom information, there are two ways of 
viewing this information without having to open the marker dialog.

To read marker notes using your pointer:

Double-click a marker to open its marker dialog.

Move the pointer over any marker in the Source Viewer or Timeline to see a tooltip 
showing that marker’s information.

Moving the pointer over a marker displays its information in a tooltip

To read marker information in the Source and/or Timeline viewers:

1	 Open the Source or Timeline Viewer’s option menu, and turn on Show Marker Overlays.

2	 Stop playback, and move the playhead to a marker. That marker’s information is 
displayed in the Viewer, superimposed.

Marker information shown in the Source Viewer
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Using Markers for Navigation
Markers can be used to aid navigation, via two keyboard shortcuts that let you jump the 
playhead from marker to marker. When moving the playhead among markers, Clip and Timeline 
markers are mixed together.

To move the playhead to the next or previous marker:

�� Press Shift-Up Arrow to move the playhead to the next marker to the left in 
the Timeline.

�� Press Shift-Down Arrow to move the playhead to the next marker to the right in 
the Timeline.

To move the playhead to a specific marker using the Source or Timeline Viewer’s Marker list:

For a source clip or timeline with multiple markers, you can move the playhead 
immediately to a specific marker by opening the Source or Timeline Viewer’s Option 
menu, and choosing a marker from the Markers submenu, which exposes all the 
markers that are available in that Viewer, by name and note.

All markers in the currently open clip as seen in the Source Viewer Option menu Markers list

Exposing Markers in Lists
You can also use the Edit Index to filter out a list of markers appearing within the current 
Timeline. You can filter all markers at once, in which case columns expose the notes and colors 
applied to each marker. You can also filter by a specific marker color if you only want to see one 
type of marker.

Methods of working with markers in the Edit Index:

�� To filter all clips with markers in the Edit Index: Click the Option menu of the Edit 
Index and choose Show Markers > All or choose a specific color. Each clip with a 
matching marker appears in a list, with columns corresponding to the color(s) and notes 
of each Timeline and Clip marker.

�� To move the playhead to the position of a marker in the Edit Index: Click that marker’s 
entry in the list.

�� To show hidden marker columns: Right-click any column header, and turn on either 
Color or Notes to reveal that column. If necessary, columns can be rearranged by 
dragging them left or right.

You also have the option to export lists of markers as an EDL, a .txt, or .csv file.
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Exporting lists of markers:

�� To export Timeline markers as an EDL: Right-click that timeline in the Media Pool, and 
choose Timelines > Export > Timeline Markers to EDL. Choose a location and export 
format from the Export Edit Index dialog, and click Save. Each Timeline marker is listed 
in the resulting EDL, with any notes included along with a duration, where applicable.

�� To export all filtered markers in the Edit Index as a .txt or .csv file: After you choose 
Show Markers in the Edit Index option menu, then right-click that timeline in the Media 
Pool, and choose Timelines > Export > Edit Index. Choose a location and export format 
from the Export Edit Index dialog, and click Save.

Editing With Markers in the Media Pool
Once you’ve added one or more markers to source clips in the Media Pool, you can use them 
for editing in a considerably more direct way than just using them to move the playhead around. 
Markers can be exposed in the List view of the Media Pool, and once exposed, they can be 
opened into the Source Viewer, and they can be edited into the Media Pool just like any other clip.

To show markers in the Media Pool:

Set the Media Pool to List view, then click the disclosure button to the left of the clip 
with markers you want to work with. They appear as a hierarchical list underneath the 
clip to which they’re attached.

Markers exposed in the Media Pool in List view

To open a marker in the Media Pool into the Source Viewer:

Double-click any marker to open that clip into the Source Viewer with the playhead at 
the position of that marker.

To edit a clip defined by the marker into the Timeline:

Drag any marker into the Timeline. A clip will be edited into the Timeline with the In 
point defined as the frame at the marker, and the Out point defined by either (a) the 
frame before the next marker in that clip, or (b) the duration of that marker if the duration 
is greater than the default 1 frame.
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Color Labeling Clips in the Timeline
By default, different clips have specific colors that identify each type of clip. Furthermore, clips 
with effects applied to them (adjustments in the Inspector, volume level changes, speed 
changes, etcetera), appear as a darker shade of their default color to help you identify at a 
glance which clips have been modified. The following table lists what these default colors are.

Clip Type Color

Video Clip Steel Blue

Audio Clip Light Green

Generator Light Purple

Text Beige

Additionally, you can assign one of sixteen colors to clips that appear in the Timeline. While you 
can assign clip colors in a variety of ways, they only appear once a clip has been edited into the 
Timeline, as a way to tint clips to identify them at a glance. Each clip can only have a single color 
assigned to it. Clip colors are also clip-specific, so assigning a clip color to one clip in the 
Timeline has no effect on other clip that share the same source media in the Media Pool.

A timeline with audio clips that have been tinted to identify what they are to the editor 

To assign a clip color to one or more clips, do one of the following:

�� Use the Media page to assign clip colors to clips in the Media Pool using the Shot & 
Scene preset in the Metadata Editor. Clip colors do not appear in the Media Pool. Clip 
colors can be removed by clicking the X  to the left of the Clip Color buttons in the 
Metadata Editor.

�� Right-click one or more selected clips in the Timeline, and choose a color from the 
Clip Color submenu of the contextual menu. Clip colors can be removed by choosing 
Default Color from this same submenu.

NOTE: Clip colors are distinct from flags, which appear as badges in the Timeline, 
Media Pool, and Color page.
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Finding Clips, Media, Markers, 
Gaps, and Timelines
DaVinci Resolve has several methods of locating clips, markers, and gaps, to help you 
troubleshoot problem timelines, or to find media that you want to edit into a timeline differently.

Finding Clips in the Timeline
DaVinci Resolve makes it easy to find one or more clips in the Timeline that correspond to 
specific criteria using the Edit Index.

To find a clip in the Timeline: 

1	 Open the Edit Index.

2	 Click the magnifying glass button to open the search controls.

3	 Choose a criteria from the Filter By pop-up menu

4	 Type a search term in the Search field at the top right of the Edit Index. 

As soon as you start typing, all edit events that don’t match the search criteria are 
temporarily hidden. To show all of the clips in the Edit Index again, click the cancel 
button at the right of the search field.

5	 Click any event in the Edit Index to move the playhead to that clip in the Timeline.

Finding Offline Clips in the Timeline
It’s also easy to use the Edit Index to find all of the offline clips that may be in the Timeline.

To locate offline media in the current Timeline via the Edit Index:

1	 Open the Edit Index

2	 Click the Option menu of the Edit Index and choose Show Offline Clips Only. 

The Edit Index is filtered to only show the offline clips in the currently open Timeline, 
and you can click any item on the list to jump the playhead to that particular clip in 
the Timeline.

3	 Click any event in the Edit Index to move the playhead to that clip in the Timeline.

Finding Edit Index Events Using Clips in the Timeline
You can also locate specific Edit Index events using the Timeline playhead.

To locate a clip in the Edit Index from the Timeline: 

Move the Timeline playhead to intersect a clip you want to find in the Edit Index. That 
clip’s corresponding event (or events if the playhead intersects multiple clips) are 
automatically highlighted in the Edit Index.

To move the playhead to a clip in the Timeline via the Edit Index: 

Click any event in the Edit Index to move the Timeline playhead to the In point of 
that clip.

Finding Clips in the Media Pool
As you work, there are a variety of methods you can use to find clips in the Media Pool.
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Methods of finding clips in the Media Pool:

�� To find a clip in the Media Pool: Open the Media Pool, if necessary, and click the 
magnifying glass button to open the search controls. Then choose a criteria from the 
Filter By pop-up menu, and type a search term in the Search field. As soon as you start 
typing, all clips that don’t match the search criteria are temporarily hidden.

�� To locate a Timeline clip in the Media Pool: Right-click any clip in the Timeline, and 
choose Find in Media Pool. That clip appears highlighted in the Media Pool. 

�� To locate a Source Viewer clip in the Media Pool: With any clip open in the Source 
Viewer, press Option-F.

�� To locate a media file in the Finder from the Media Pool: Right-click any clip in the 
Media Pool and choose Reveal in Finder. A Finder window, or its equivalent in Windows 
and Linux, opens to the directory with that clip, which appears highlighted.

Finding Clips Using Markers or Flags
If you’re using markers to keep track of notes, issues, or items on your to-do list, there are a few 
different ways of finding and moving among them.

Methods of finding Markers or Flags:

�� To find all markers or flags via the Edit Index: Click the Option menu of the Edit Index 
and choose Show Markers or Show Flags. Each clip with one or more markers appears 
in a list, with columns corresponding to the color(s) and notes of each timeline and 
clip marker.

�� To find a specific marker or flag in the Edit Index: Click the magnifying glass button 
in the Edit Index, choose Notes in the Filter by pop-up, and type a search term in the 
Search field.

�� To move the playhead to the next marker forward or previous: Choose Playback > 
Previous Marker (Shift-Up Arrow) or Next Marker (Shift-Down Arrow).

Finding Gaps
Gaps, or spaces between two clips on the Timeline, appear by default as black. Unwanted gaps 
may appear as black flashes while your program plays back, and are generally to be avoided. 
DaVinci Resolve makes it easy to find gaps in specific tracks of your timeline.

To find gaps in the Timeline:

1	 Make sure that the Auto Select control is enabled on any track you want to search for 
gaps. Turn Autoselect off on any tracks you don’t want to search for gaps (for example, 
title tracks where gaps are to be expected).

2	 Do one of the following: 

�� Choose Playback > Previous Gap or press Option-Command-; (semicolon)

�� Choose Playback > Next Gap or press Option-Command-‘ (apostrophe)

The playhead will automatically move to the first frame of the next gap in the Timeline.

Finding the Currently Open Timeline in the Media Pool
If you’re not using one of the available methods for organizing timelines separately from clips, 
it can be easy to lose track of where your timeline happens to be. To find the currently open 
Timeline in the Media Pool, choose Timeline > Find Current Timeline in Media Pool.
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Finding Media Using 
Match Frame Operations
Match frame operations are a terrific time saver when you need to match the original source clip 
to a clip in the Timeline, or when you want to use a clip in the Source Viewer to find that same 
clip in the Timeline. With a single command, you can match one clip to another in order to set up 
a new edit to take care of a variety of tasks.

Matching From the Timeline
A classic example of using Match Frame is when you originally edited a video clip into the 
Timeline without its corresponding audio, and you later decide you want that audio in the 
Timeline after all. An easy fix is to move the playhead in the Timeline to intersect the clip you 
need to fix, and use the Match Frame command to automatically load the original source media 
for that clip into the Source Viewer, setting Source In and Out points that match those of the 
Timeline clip, and putting the Source playhead at the same frame as the Timeline playhead. At 
that point, you can simply edit the source audio and video back into the Timeline to overwrite 
the video-only clip you started with, confident that you’re editing exactly the same range of 
media at the same place.

Using the pointer to Match Frame from the Timeline to find a source clip:

Hold the Option key down and double-click the clip in the Timeline. 

The original source media for that clip is automatically loaded into the Source Viewer, with In 
and Out points that match those of the targeted Timeline clip; the Source playhead is at the 
same frame as the Timeline playhead.

Using keyboard shortcuts or Viewer controls to 
Match Frame from the Timeline to find a source clip:

1	 Move the Timeline playhead to intersect the clip you want to target.

Placing the playhead over a clip to Match Frame

2	 If there are other clips on a multi-track timeline that overlap the clip you’re targeting 
for this operation, then the clip on the lowest video track will be used as the target 
for Match Frame operations. If you want to target a clip on a higher track, then either 
disable the Auto Selection controls of all timelines underneath, or Option-Click the Auto 
Selection control of the track with the clip you’re targeting to solo it.

3	 Press the F key, or click the Match Frame button at the bottom right of the Timeline 
Viewer (it’s at the left of the In and Out buttons).
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The frame that’s matched to the frame at the playhead in the Timeline; 
In and Out points are set to match those of the clip in the Timeline

4	 The original source media for that clip is automatically loaded into the Source Viewer, 
with In and Out points that match those of the targeted Timeline clip; the Source 
playhead is at the same frame as the Timeline playhead.

Matching From a Source Clip
Match Frame also works in the opposite direction. You can open a source clip into the Source 
Viewer that you know corresponds to a clip in the Timeline, and then you can use Match Frame 
to automatically find any clip in the Timeline that corresponds to media found within the 
source clip.

To use Match Frame in the Source Viewer to find a clip in the Timeline:

1	 Open a clip in the Source Viewer that includes a range of media that’s already been 
edited into the Timeline. If no part of the source clip has been edited into the Timeline, 
source match framing won’t work.

2	 Move the Source Viewer playhead to a frame that you want to find in the Timeline. 
Again, if the frame at the position of the playhead in the Source Viewer hasn’t already 
been edited into the Timeline, the Source Match Frame command won’t work.

3	 Click the Match Frame button at the bottom right of the Source Viewer (it’s at the left of 
the In and Out buttons), or press the F key.

The Timeline playhead automatically moves to the the clip and frame after the current 
playhead position that matches the clip in the Source Viewer.
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Finding a Clip in the Media 
Pool Using a Timeline Clip
There are two ways you can use a clip in the Timeline to find a clip in the Media Pool.

Using a Clip in the Source Viewer to Find a Media Pool Clip
To locate the original clip in the Media Pool that corresponds to a clip in the Timeline:

1	 Open a Timeline clip into the Source Viewer by doing one of the following:

�� Double-click a clip in the Timeline.

�� Move the playhead to a clip in the Timeline, press Shift-V to select it, then press the 
Return key.

2	 Press Option-F to locate the source clip corresponding to the clip that’s open in the 
Source Viewer in the Media Pool. That clip appears highlighted in the Media Pool.

Using a Clip in the Timeline to Find a Media Pool Clip
To locate a Timeline clip’s corresponding clip in the Media Pool, right-click any clip in the 
Timeline, and choose Find in Media Pool from the contextual menu. That clip appears 
highlighted in the Media Pool.
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Chapter 21

Multicam Editing 
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Multicam Editing
If you’re working with media that was shot simultaneously using multiple cameras, then you can 
use the Multicam Editing tools in DaVinci Resolve to create multicam clips that can be edited 
using a visual switcher. Additional controls let you change the angles of multicam clips that have 
already been edited into the Timeline.

This chapter covers the following topics:

Introduction to Multicam Editing	 407

Creating and Modifying Multicam Clips	 407

Logging and Editing Multicam Clips	 409

Setting up a Timeline for Multicam Editing	 409

Opening and Altering Multicam Clips	 410

Performing a Multicam Edit	 411

Multicam Controls in the Source Viewer	 413

Multicam Keyboard Controls	 413

Editing Multicam Clips in the Timeline	 414

Grading Multicam Clips	 415
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Introduction to Multicam Editing
If you’re working on a program where a performance, interview, or event was recorded using 
multiple simultaneous cameras, DaVinci Resolve has multi-camera editing tools; multicam 
editing for short. Editing using these tools is a three part process:

�� First, you have to create multicam clips from the individual camera angles (called “ISOs,” 
or isolated cameras). 

�� Second, you need to put the multicam clips you’ve created into a timeline. 

�� Third, you turn on the Multicam Viewer, and then you’re ready to start cutting and 
switching among angles, as if you were a live multi-camera director.

This section describes all of these steps, and the various options available for each of them.

Creating and Modifying Multicam Clips
Before you do anything else, you need to create one or more multicam clips. 

To create a multicam clip:

1	 Import all the ISO (isolated camera) clips that correspond to the multi-camera 
performance or event that you’ll be editing into the Media Pool.

2	 Select all the clips that you need to sync together, right-click the selection, and choose 
“Create Multicam Clip Using Selected Clips.”

3	 When the New Multicam Clip Properties dialog opens, choose from the 
following options:

New Multicam Clip Properties dialog

�� Start Timecode: Presents the start timecode of the new multicam clip you’re about 
to create, which is determined by either the timecode value of the sync point if Angle 
Sync is defined by timecode, or by the sync point timecode value of the clip with the 
earliest timecode if Angle Sync is defined by waveform.

�� Multicam Clip Name: Use to choose a more descriptive name than “Multicam 1” for 
the multicam clip you’re about to create.
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�� Frame Rate: Automatically lists the frame rate associated with the clips you selected.

�� Angle Sync: The method used to synchronize all of the different angles. If you’re 
manually syncing all of the angles, you can use In or Out points that you set within 
each clip, or you can use the first Marker that you’ve set within each clip. If matching 
timecode was jam synced to each camera recording an angle, you can choose 
Timecode for a fast sync that’s as accurate as the timecode is. If each camera had a 
microphone with which to simultaneously record the location audio, you can choose 
Sound to use the shape of each audio waveform to align all of the angles.

�� Angle Name: The method used to name each angle within the multicam clip being 
created. The angles can have Sequential numbering, use Angle or Camera metadata, 
or use the Clip name.

�� Detect clips from same camera: Turning on this checkbox results in multiple clips 
that are identified as being from the same camera being put into the same angle 
track of the resulting multicam clip being created. It also enables the “Link using” 
pop-up menu.

�� Detect Using: The metadata used to determine which clips come from the same 
camera. You can choose from Camera ID, Angle, Reel Number, and Roll/Card, which 
are user-editable in the Metadata Editor of the Media page, or you can choose Reel 
Name which is automatically or manually derived using either the Conform Options 
of the General Options panel of the Project Settings, or the Name panel of the Clip 
Attributes window. For more information on the Conform Options, see Chapter 3, 
“Project Settings and Preferences.”

�� Move Source Clips to “Original Clips” Bin: A checkbox that lets you move all of 
the original ISO clips into an Original Clips bin to get them out of the way after the 
multicam clip has been created.

4	 When you’re done choosing options, click Create. Depending on the Angle Sync 
method you chose, a waveform analysis might generate a progress bar, and then the 
new multicam clip is created in whichever bin is currently selected in the Media Pool. 
Multicam clips appear with a multicam badge in the lower left-hand corner of the clip 
thumbnail.

A Multicam clip showing its badge in the Media Pool
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Logging and Editing Multicam Clips
Once you create one or more multicam clips, you can view them in the Media page or in the 
Source Viewer of the Edit page, and add markers to them (all angles share the same markers) to 
prepare for the multicam edit you’re planning on performing. When viewing multicam clips in the 
Media page, you can choose how many angles to show in the viewer via the Viewer 
Option menu. 

Markers set in a multicam clip in the Media page to prepare for editing

Setting up a Timeline for Multicam Editing
Once you’ve created one or more multicam clips, preparing them for editing is as simple as 
editing them into the Timeline, either by dragging and dropping the multicam clip to the 
Timeline from the Media Pool, or by opening the multicam clip into the Source Viewer, and then 
using any of the available editing methods to cut it into the Timeline from there. Once edited, 
they appear in the Timeline like any other clip, just with a multicam badge to the left of the 
clip name.

Multicam clip badge in the Timeline

When you perform a multicam edit, DaVinci Resolve plays the entire audio mix while you’re 
editing, so if you want to take the opportunity to edit a master audio mix file or additional piece 
of music to play along with the multicam clip, you can do so.
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Opening and Altering Multicam Clips
After you’ve created a multicam clip and put it into a timeline, you can modify it in a variety of 
ways by right-clicking it in the Media Pool and choosing “Open in Timeline.” This replaces the 
contents of the Timeline with a vertical stack of superimposed angles, one per track, each of 
which is offset from the beginning of the Timeline to align with one another. 

An open multicam clip appears like a timeline with a vertical stack of clips

With the multicam clip open, you can make a variety of changes in preparation for editing:

�� You can slide a multicam clip left or right to alter its sync (selecting an angle and 
using the period (.) and comma (,) “nudge” keyboard shortcuts can be a good way of 
doing this).

�� You can delete the track of an angle you don’t need (right-click the track header and 
choose Delete Track).

�� You can rearrange tracks to rearrange the order in which angles appear (right-click any 
track header and choose Move Track Up or Move Track Down).

�� You can rename tracks to change the angle name that appears by default in the 
Multicam Viewer.

�� You can disable audio or video tracks that correspond to angles you don’t want to see, 
but don’t want to eliminate, either.

�� You can grade each multicam angle separately (discussed later in this section).

When you’ve finished altering the contents of the multicam clip, you can close it using the path 
control at the bottom left-hand corner of the Timeline. Click the name of the edited timeline to 
go back, in preparation for the next steps.

A path control lets you exit the multicam clip
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Performing a Multicam Edit
After you’ve created one or more multicam clips and edited them into a timeline, actually 
executing a multicam edit is simple.

1	 Open the Timeline you created to hold the multicam clip or clips comprising your edit, 
and position the playhead where you want to start editing.

2	 Choose Multicam from the Source Viewer mode pop-up.

Switching the Source Viewer to Multicam viewing

The Source Viewer changes to display all of the different angles within that clip as 
switching controls.

3	 Choose how many angles you want to display from the pop-up menu at the bottom 
right of the Source Viewer. If you’re using a computer that’s not very fast, you may need 
to reduce the number of angles you’re viewing to maintain real time playback.

Choosing how many angles to view in the Multicam Viewer

If there are more angles within the multicam clip intersecting the playhead in the 
Timeline than the Multicam Viewer is set to show, then page controls appear to the left 
of this pop-up menu that let you choose which set of angles you want to view. You can 
move to another page of angles by doing one of the following:

�� Click any dot to jump to that page of angles.

�� Click the arrows to move among next/previous sets of angles.

�� Choose Edit > Multicam > Previous Page (Option-Shift-Left Arrow) or Next Page 
(Option-Shift-Right Arrow).
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4	 Choose whether you want to switch both the audio and video, just the video, or just the 
audio using the Audio/Video selection buttons at the bottom center of the Multicam 
Viewer. You can also choose Edit > Multicam > Video and Audio (Option-Shift-[ ), Video 
Only (Option-Shift-] ), Audio Only (Option-Shift-\).

Buttons for choosing whether to switch the 
video, the audio, or both

5	 Start playback, and while watching the program play, do one of the following:

�� Click any angle in the Multicam Viewer to insert a cut in the Timeline and switch to 
that angle. As you cut-and-switch, the cuts immediately appear in the Timeline while 
you play onward.

�� Option-click any angle to switch the angle used by the current clip without adding 
a cut. This is useful if you later regret the angle you cut to and just want to switch 
the entire segment since the last cut you made. This can also be accomplished by 
choosing Edit > Multicam > Previous Angle (Command-Shift-Left Arrow) or Next Angle 
(Command-Shift-Right Arrow).

As you play, the entire mix in the Timeline will play along with what you’re switching, so 
you can work in context.

A timeline while it’s being edited using cut and switch

6	 When you’re ready to stop multicam editing, simply stop playback. If you want to start 
trimming the Timeline to fine-tune what you’ve done, choose Source from the Source 
Viewer mode pop-up, and you can re-edit and trim the multicam clips in the Timeline 
just like any others.



413

M
ul

tic
am

 E
d

iti
ng

 
P

ar
t 

3 
–

 2
1

Multicam Controls in the Source Viewer
The Source Viewer, in Multicam mode, has four sets of controls that let you set up and execute 
multicam editing.

The Source Viewer showing Multicam switching controls

�� Multicam Angle buttons: Each multicam angle displayed in the Source Viewer is a 
button that lists the angle name underneath. Clicking any of these buttons inserts a cut 
and switches the angle of the next clip, while Option-clicking changes the angle of the 
clip at the position of the playhead without adding a cut.

�� Audio/Video Selection buttons: Clicking any of these buttons inserts a cut and 
switches the angle of the next clip, while Option-clicking changes the angle of the clip 
at the position of the playhead without adding a cut.

�� Multicam display pop-up: Lets you choose how many angles to view while switching. 
Depending on your workstation’s performance, reducing the number of angles can 
improve playback performance while you edit. You can choose from a grid of 1x1, 1x2, 
2x2, 3x3, or 4x4 angles to view.

�� Multicam Page buttons: If there are more angles within the multicam clip intersecting 
the playhead in the Timeline than the Multicam Viewer is set to show (via the multicam 
display pop-up), then page controls appear that let you choose which set of angles you 
want to view. Click any dot to jump to that page of angles, or click the arrows to move 
among next/previous sets of angles.

Multicam Keyboard Controls
There’s also a full set of keyboard shortcuts that can be used for multicam editing.

�� Multicam Cut: (Clip > Multicam Cut submenu) Pressing the 1 through 9 number keys 
performs a cut-and-switch operation, the same as if you’d clicked on an angle button of 
a multicam clip in the Source Viewer.

�� Multicam Switch: (Clip > Multicam Switch submenu) Pressing Option-1 through 9 
performs a switch operation, the same as if you’d Option-clicked an angle button of a 
multicam clip in the Source Viewer.
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�� Previous/Next Angle: (Edit > Multicam submenu) Pressing Command-Shift-Left or 
Right Arrow lets you switch to the previous or next angle.

�� Audio/Video Switching: (Edit > Multicam submenu) Pressing Option-Shift-[ sets the 
Multicam Viewer to cut or switch both Video and Audio at the same time. Pressing 
Option-Shift-] sets the Multicam Viewer to cut or switch Video only. Pressing Option-
Shift-\ sets the Multicam Viewer to cut or switch Audio only.

�� Previous/Next Page: (Edit > Multicam submenu) Pressing Option-Shift-Left or Right 
Arrow lets you move to the previous or next page of multicam angles, if there are more 
angles than can be displayed in the Viewer’s current multi-angle setting.

Editing Multicam Clips in the Timeline
When it comes to editing and trimming, there’s no functional difference between multicam 
clips and any other kind of clip. Because you’re technically adding through-edits to a single clip, 
you have the option or deleting any edit by selecting it and pressing the Delete key.

But multicam clips are special in that you always have the option of switching angles, either 
using the Multicam Viewer, or right in the Timeline via each clip’s contextual menu.

To switch the angle of any multicam clip in the Timeline:

Right-click any clip and choose a new angle from the “Switch Multicam Clip 
Angle” submenu.

In the event that you want to eliminate all unused angles from a multicam clip and “flatten” it to 
simply be a single clip in the Timeline, there’s a command for that. 

To flatten a multicam clip in the Timeline: 

Right-click any clip and choose Flatten Multicam Clip from the contextual menu. 
All unused angles are deleted, the clip becomes shorter if it included black tails 
because of another unused angle, and you end up with a single ordinary clip in 
the Timeline. 

Referencing a Line Cut

You may sometimes be provided with what’s called a “Line Cut” from a production. 
This is a pre-edited version of the program, cut live with the switcher and recorded 
during the performance or event, that’s meant to be used as a reference for what 
you’re doing. If you want to reference a Line Cut that’s been given to you as a movie 
file, you can add it as an Offline Reference Movie, and compare it to the Timeline using 
the Offline Reference Movie mode of the Source Viewer in the Edit page. For more 
information on using an Offline video to compare with a timeline in the Edit page, see 
Chapter 33, “Preparing Timelines for DaVinci Resolve Import.” 
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Grading Multicam Clips
Multicam clips appear like any other clip in the Color page. However, each angle within a 
multicam clip has its own grade (unlike the Take Selector described later, in which all takes 
share the same grade). If you grade a multicam clip, you’re actually editing the grade of the 
specific angle that’s currently exposed in that clip. 

If you want access all of the angles within a multicam clip for grading, right-click it and choose 
“Open in Timeline” to expose each angle within a superimposed stack. Then you can open the 
Color page and grade whatever angles you want, whether they’re visible back in the Edit page 
or not. You might do this to make the different angles match one another better, or to pre-grade 
all of the angles to give them the look you want prior to multicam editing.

An open multicam clip in the Color page exposes all of its angles for individual grading

Because opening multicam clips in the Timeline results in a vertical stack of superimposed 
clips, you’ll want to turn on Unmix in the Color page viewer so that you can actually see the 
currently selected angle in the Thumbnail Timeline while you work.

The Unmix control lets you see only one  
of a superimposed stack of clips

When you’re done grading the individual angles, go back to the Edit page, and use the path 
control at the bottom left-hand corner of the Timeline to return to your edited timeline.
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Chapter 22

Take Selectors, 
Compound 
Clips, and 
Nested Timelines 
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Take Selectors, Compound Clips, 
and Nested Timelines
This chapter covers a variety of different ways you can turn multiple clips into a single object in 
the Timeline, to accommodate a variety of different editing tasks. Take Selectors, Compound 
Clips, and Nested Timelines all appear as a single clip in the Timeline, but they all organize 
multiple clips in different ways. Take Selectors let you organize multiple clips vertically, making it 
easy to associate clips with one another so you can easily switch among them. Compound Clips 
and Nested Timelines let you organize multiple clips horizontally, so that you can manage long 
or short sequences of clips within an edit as a single clip, when convenient.

This chapter covers the following topics:

Take Selectors	 418

Compound Clips	 419

Grading Compound Clips	 421

Nested Timelines	 422

Editing the Contents of a Nested Timeline	 422

Swapping the Source Viewer With the Timeline	 423

Decomposing Nested Timelines in Place	 423

Decomposing Nested Timelines While Editing	 423

Grading Nested Timelines	 423
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Take Selectors
Take Selectors in DaVinci Resolve provide a way for you to manage multiple takes or versions 
of a particular clip in the Timeline. They’re ideal for storing multiple useful takes for scenes 
where you or the client can’t quite decide which one is the best, or for maintaining multiple 
versions of VFX clips that are going through different iterations. 

When you place a number of clips inside a Take Selector, only one clip appears in the Timeline, 
but you can open that Take Selector and switch to any other take or version that’s stored within 
to switch which clip appears in the Timeline whenever you want.

A Take Selector, shown open, with several alternate takes placed within

Take selectors are easy to create and use and populate. Once you’ve placed a number of clips 
inside the Take Selector, you can slip each clip’s range of media, or choose a new clip to appear 
in the Timeline, before closing the Take Selector. 

When closed, a Take Selector appears as a regular clip with a badge
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When closed, multi-take clips can be edited, trimmed, graded, and rendered like any other clip 
in the Timeline. A Take Selector badge appears to the left of the name of a clip to which it’s 
applied to show its status; double-clicking this badge opens the Take Selector so you can 
adjust its contents.

Methods of using Take Selectors:

�� To create a Take Selector: Right-click any clip that’s not a Title or Generator, and 
choose Take Selector from the contextual menu. The Take Selector interface 
appears, disabling the rest of the Timeline temporarily while you work with the Take 
Selector’s contents.

�� To populate a Take Selector: Drag any clip from the Media Pool into the Take Selector, 
and it appears “stacked” on top of the original clip in the Timeline.

�� To choose the current clip: Click any clip so that it’s highlighted in blue, and click the 
close button at the upper-left corner of the Take Selector. When next you open the 
Take Selector, the current clip appears at the bottom of the stack, with a star at the 
upper-left corner.

�� To set a Take Selector to ripple the Timeline when a longer or shorter take is 
selected: Click the Ripple Take button, at the upper right-hand corner of the Take 
Selector panel, to the left of the trash can button.

�� To slip a clip within the Take Selector: Drag any clip to the left or right to slip the range 
of media that appears within the Take Selector’s duration in the Timeline.

�� To remove a clip from a Take Selector: Click the clip you want to remove to select it, 
then click the garbage can button at the upper-right corner of the Take Selector.

�� To close a Take Selector: Click the X close button.

�� To reopen a Take Selector: Double-click the Take Selector badge at the left of 
a clip’s name, or right-click a multi-take clip and choose Take Selector from the 
contextual menu.

�� To eliminate a Take Selector: Close the Take Selector, if open, then right-click that clip 
in the Timeline and choose Finalize Take from the contextual menu.

Compound Clips
You can select a series of clips in the Timeline, be they edited one after the other in serial or 
superimposed and stacked in parallel, and turn them into a Compound Clip, which is a single 
clip in the Timeline that’s actually comprised of many other audio and video clips embedded 
inside. This allows you to work with a block of clips as if it were a single unit, governed by a 
single set of Inspector controls, and able to be connected to another clip in your timeline by a 
single transition.

Editing a compound clip works the same as editing any other type of clip. They can be edited, 
trimmed, and deleted using all the same methods. In addition, compound clips can be renamed, 
and decomposed back into their component clips right in the Timeline.
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To create a compound clip:

1	 Select a range of clips.

Selecting a range of clips to turn into a compound clip

2	 Right-click one of the selected clips and choose New Compound Clip.

3	 Enter an optional start timecode, a name, and choose what kind of audio tracks you 
want for the compound clip you’re about to make, and click Create.

The New Compound Clip Properties dialog

A compound clip is created which takes the place of the original clips you selected on 
the Timeline. Additionally, a copy of that compound clip appears in the currently 
selected bin of the Media Pool.

The resulting compound clip

To rename a compound clip:

1	 Either click the name of the compound clip twice to select the name text, or right-click 
the clip and choose Rename from the contextual menu.

2	 Type a new name, and press the Return key to accept the change.
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To edit a compound clip:

1	 Right-click any compound clip and choose Open in Timeline from the contextual menu. 

The Timeline updates with the contents of the compound clip, which you can re-edit at 
your discretion. 

An open compound clip in the Timeline

2	 To return to the original timeline when you’re finished, click the name of the enclosing 
timeline in the Path Control at the bottom left-hand corner of the Timeline.

The path control you can use to close the compound clip

To decompose a compound clip into its individual clips:

Right-click any compound clip and choose Decompose in Place from the contextual 
menu. The compound clip is replaced by the individual clips it was made from.

To edit a compound clip from the Media Pool to the Timeline as individual clips:

Command-drag a compound clip from the Media Pool or Source Viewer to the Timeline 
to edit it as a sequence of individual, decomposed clips. You can press or release the 
Command key any time while dragging to choose whether to edit it as a single 
compound clip or multiple decomposed clips.

Grading Compound Clips
Since compound clips act like a single clip in the Timeline, you can grade them as a single clip 
in the Color page. However, if you want to individually grade the original clips inside the 
compound clip, you can use the Open in Timeline command to access its constituent clips, and 
then open the Color page, where you’ll find each of the individual clips available for separate 
grading. When you’re done, go back to the Edit page and close the compound clip, and you’ll 
go back to seeing it as a single clip whenever you open the Color page.
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Nested Timelines
Timelines can be edited inside other timelines, either partially or whole. For example, if you’ve 
edited a program in scenes or reels such that each reel is contained in a separate timeline, you 
can edit all of the timelines together, one after the other, into a single timeline to assemble them 
into a final program.

Multiple timelines edited together into a single sequence

Nested Timeline clips appear with a special badge to the left of the Timeline name.

The badge that indicates a nested timeline

Timelines can be edited like any other clip, you can select one or more timelines and drag and 
drop them into another timeline, drag them onto the Timeline Viewer editing overlay, or use the 
toolbar editing buttons or keyboard shortcuts to edit them, just as you would any other clip. 
Additionally, you can select multiple timelines in the Media Pool, right-click them, and choose 
Create Timeline Using Selected Clips to quickly assemble a group of timelines into a 
nested sequence.

The one exception is that you must drag and drop a timeline into the Viewer if you want to use it 
to set In and Out points, since double-clicking a timeline, or selecting a timeline and pressing 
Return simply opens it into the Timeline Editor. However, you can set In and Out points for 
timelines in the Filmstrip of the Media Pool, or you can edit a timeline into another timeline in its 
entirety, and then trim the head and tail down to just what you need. Double-clicking a nested 
timeline opens it into the Source Viewer for trimming, exactly like any other clip.

Editing the Contents of a Nested Timeline
If you want to edit the contents of a nested timeline, you can right-click it and choose Open in 
Timeline. Unlike Compound Clips, no path control appears when you do this, because you’ve 
simply opened the original timeline. To go back to the previous timeline, find and double-click it 
in the Media Pool, or choose it from the Timeline pop-up at the top of the Timeline Viewer.

Editing an original timeline does nothing to change the duration of nested instances of that 
timeline inside other timelines. If you trim or delete clips in the original timeline that appear in 
nested instances of that timeline, then those areas of the nested timeline simply go black.
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Swapping the Source Viewer With the Timeline
When editing the partial contents of one timeline into another, it can be useful to see the 
contents of a timeline that’s open in the Source Viewer in the Timeline Editor. To do so, choose 
Timeline > Swap Timeline and Source Viewer (Command-Page Up). This puts the Timeline that 
was open in the Source Viewer into the Timeline Editor, and the Timeline that was in the 
Timeline Editor into the Source Viewer. This makes it easier to mark In and Out points while 
seeing the exact boundaries of clips, prior to pressing Command-Page Up to swap the contents 
of the Source Viewer and Timeline Editor once again in preparation for executing the next edit.

Decomposing Nested Timelines in Place
To decompose a nested timeline that’s already been edited into another timeline back into its 
constituent clips, right-click it and choose Decompose in Place. You can also do this for multiple 
selected nested timelines, all at once.

Decomposing Nested Timelines While Editing
You can also Command-drag a Timeline clip from the Media Pool or Source Viewer to the 
Timeline to edit it as a sequence of individual, decomposed clips. You can press or release the 
Command key at any time while dragging to choose whether to edit a timeline as a single clip, 
or as individual decomposed clips.

Grading Nested Timelines
Similarly to Compound Clips, nested timelines act like a single clip in the Timeline; you can 
grade them as a single clip in the Color page. However, if you want to individually grade the 
original clips inside the Nested Timeline, you can either open that timeline from the Media Pool, 
or right-click that clip and choose Open in Timeline in order to access its constituent clips.
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Chapter 23

Trimming
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Trimming
Most editors would agree that trimming is half the job of editing. While you can make many 
kinds of changes in the Timeline using the selection and razor blade tools, there is a dedicated 
Trim mode in which you can perform more sophisticated trim operations in fewer steps using 
either the mouse or keyboard shortcuts, depending on how you like to work. Mastering DaVinci 
Resolve’s trimming operations will save you time when doing the necessary work of fine-tuning 
your edit. 

This chapter covers the following topics:

Summarizing Trim Operations	 426

Selection-Based Trimming Using the Trim Tool	 426

How the Trim Tool Differs From the Selection Tool	 426

Using the Trim Tool With the Mouse	 428

Turning Off the Heads Up Display While You Trim	 432

Trim Tool Operations With the Keyboard	 432

Trimming Using Timecode Entry	 435

How to Enter Timecode Values	 435

Commands to Make Selections and Trim	 436

Trimming Clips in the Source Viewer	 437

Ripple Editing Rules	 438

Using Auto Select Controls to Control Trimming	 440

Using Auto Select to Control Which Clips are Trimmed	 440

Using Manual Selections to Control Which Clips Are Trimmed	 441

Using Auto Select to Control Which Tracks Are Rippled	 442

Trimming Multiple Edits or Clips at Once	 444

Resizing and Rolling Multiple Edit Points	 444

Rippling Multiple Edit Points	 444

Asymmetric Trimming	 446

Slipping Multiple Clips	 448

Sliding Multiple Clips	 449

Keyboard Trimming During Looped Playback	 449

Dynamic JKL Trimming	 450

Quick Trimming	 450

Trimming in Dynamic Mode	 451

Trim Operations that are Targeted Using the Playhead	 452

Trim Start and Trim End	 452

Resize, Ripple, and Roll Start and End Commands	 453

Slip and Slide Playhead to In and Out Commands	 454

Extend Edits	 454
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Summarizing Trim Operations
Before going into the different methods of trimming that are available, users who are new to 
editing might benefit from a quick summary of what each trimming operation actually does. 
Each trim operation is designed to let you move edits and clips in relation to whichever clips are 
around them, by performing several operations at once. The five primary methods of 
trimming are:

�� Resize: Shortens or lengthens the end of an outgoing clip or the beginning of an 
incoming clip, while either overwriting a neighboring clip or leaving a gap behind as 
necessary. While this isn’t usually included in a discussion of “trim” operations, it’s 
actually the simplest kind of trimming you can do.

�� Roll: Moves an edit point to the left or right by either shortening the outgoing clip while 
lengthening the incoming clip, or vice versa. Roll edits do not change the duration of 
the overall Timeline.

�� Ripple: Shortens or lengthens the end of an outgoing clip or the beginning of an 
incoming clip, while simultaneously moving all clips either to the right in the Timeline 
(if you’re rippling to lengthen a clip) or left in the Timeline (if you’re rippling to shorten a 
clip) to fill the gap or prevent overwriting that would otherwise occur if you were doing 
a resize operation. Ripple edits do change the duration of the overall Timeline and can 
alter the sync relation between different tracks if you’re not careful.

�� Slip: Keeps a clip in the same place in the Timeline, while changing the range of media 
that appears in that spot. Slip edits do not change the duration of the overall Timeline.

�� Slide: Keeps a clip’s range of media the same, but moves that clip to the left or right by 
either shortening the outgoing clip to its left while lengthening the incoming clip to its 
right, or vice versa. 

Selection-Based Trimming 
Using the Trim Tool
Trim mode differs from Selection mode in that operations that would move clips with the 
Selection tool will either slip or slide clips with the Trim tool. Other operations that would resize 
edits with the Selection tool instead ripple the Timeline to automatically close gaps when using 
the Trim tool. The following sections describe the various trim operations that are available, 
both when using the mouse, and when using the keyboard.

To enter Trim Edit mode:

Click the Trim Edit button, or press the T key.

How the Trim Tool Differs From the Selection Tool
Aside from the actual trimming operations that are available, there are a few other important 
differences between the Trim tool and the Selection tool. 

Selecting Edit Points
When the Trim tool is selected, dragging a bounding box over a series of clips in the Timeline 
selects the edit points to join clips together, instead of the clips themselves. This makes it fast 
and easy to select multiple edit points that you want to operate on simultaneously.
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Selecting edit points in the Timeline using the Trim tool

Rippling the Timeline With Different Operations
When the Trim tool is selected, other commands and controls that would ordinarily resize a clip 
or clips and leave gaps in the Timeline instead move (ripple) clips that are to the right of the clip 
or edit you’re trimming over to the left to prevent gaps whenever clips or edits are moved 
or resized. 

Rippling the incoming edit point of Clip L to resize it and prevent a gap from 
appearing by moving all clips that are to the right (Clips P, L, and N) over to the left

For example, the Retime controls, the Extend and Trim Start/End commands, and the Nudge 
keyboard shortcuts all work differently depending on whether you’re using the Selection or 
Trim tools. This lets you use one set of tools to do different operations, depending on what you 
need to do.

Rippling Gap
You can also use the Trim tool (or other trim operations described later in this chapter) to ripple 
the start and end of a gap in the Timeline. Rippling a gap lets you grow or shrink the gap while 
moving the portion of the Timeline to the right of the gap forward or backward in time. 
Whenever you ripple against gap, a two-up display appears that lets you see both the clip 
you’re trimming and whatever superimposed clips may be showing through that gap.

Using the Trim tool to ripple the out point of a gap to narrow it
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Using the Trim Tool With the Mouse
When trimming using the mouse, you can perform every kind of trim operation that’s available 
using a single tool, simply by clicking the Trim mode/tool button, and then dragging on the 
appropriate area of a clip in the Timeline.

Methods of trimming with the mouse in Trim Edit mode:

�� To slip a clip: To slip a clip’s range of content without changing its position in the 
Timeline, click the middle top region of a clip, and then drag to the left or right to 
“slip” the clip to contain a different range of frames. A dashed overlay shows the total 
duration of media available for you to slip with, which moves left and right as you drag.

Clicking the top clip area before a slip, an overlay shows the clip’s available range of media

After dragging to slip, clips don’t move, but the slipped clip’s range of media has changed

When slipping clips, a 4-up display shows all relevant outgoing and incoming frames, so you 
can compare the continuity of action from one clip to the next. During a slip, the top two frames 
update to show you the new incoming and outgoing frames of the clip being slipped, relative to 
the unchanging outgoing frame of the clip to the left and incoming frame of the clip to the right.

TIP: You can temporarily disable this four-up display by pressing the Shift key while 
you ripple so that you only see the frame at the position of the playhead. This makes it 
possible for you to see which frame passes the playhead by as you ripple the 
Timeline. You can toggle this two-up display off completely by choosing View > Enable 
Preview During Editing, or by pressing Shift-Q.
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Four-up display when slipping a clip

�� To slide a clip: To slide a clip, moving it to another position in the Timeline while 
simultaneously adjusting the Out point of the previous clip and the In point of the next 
clip to accommodate the change in position of the current clip being dragged, click the 
bottom-middle name bar of the clip and drag it to another position.

After dragging to slide, the selected clip is at a new location, surrounding clips filled the gap

When sliding clips, a 4-up display shows all relevant outgoing and incoming frames, so you can 
compare the continuity of action from one clip to the next. During a silde, the bottom two 
frames update to show you the new outgoing frame of the clip to the left, and the new incoming 
frame of the clip to the right of the clip being slid.

TIP: You can temporarily disable this four-up display by pressing the Shift key while you 
ripple so that you only see the frame at the position of the playhead. This makes it 
possible for you to see which frame passes the playhead by as you ripple the Timeline. 
You can toggle this two-up display off completely by pressing Shift-Q
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Four-up display when sliding a clip

�� To roll an edit point: To roll an edit, moving the Out point of the outgoing clip and the In 
point of the incoming clip at the same time, drag an edit point between two clips to the 
left or right. (Roll edits can also be done in Selection Mode.)

Selected edit point before roll

Edit point moved further to the right, both adjacent clips resized to prevent gap

When rolling an edit, a 2-up display shows the changing continuity of action from the 
outgoing frame of the clip to the left to the incoming frame of the clip to the right.
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Two-up display when rolling an edit

�� Ripple Edit: To ripple the outgoing or incoming part of an edit to add or remove media 
to a clip while simultaneously moving all other clips at the left in the Timeline to make 
room, click the Ripple tool, and drag an edit point to a new position in the Timeline

Selected outgoing half of an edit point before ripple

Rippled clip is shorter, the rest of the Timeline has moved left to fill the gap

When rippling an edit, a 2-up display shows the continuity of action from the outgoing 
frame of the clip to the left to the incoming frame of the clip to the right. Which frame 
updates depends on which side of the edit you’re rippling.

TIP: You can temporarily disable this two-up display by pressing the Shift key while 
you ripple so that you only see the frame at the position of the playhead. This makes it 
possible for you to see which frame passes the playhead by as you ripple the 
Timeline. You can toggle this two-up display off completely by pressing Shift-Q.
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Two-up display when rippling an edit

Turning Off the Heads Up Display While You Trim
If you press the Shift key while performing most drag and trim operations, you can suspend the 
multi-frame heads up displays that appear in the Timeline window in order to focus on the frame 
that intersects the Timeline.

To toggle the two- and four-frame heads up displays off or on:

�� Choose View > Enable Preview During Editing

�� Press Shift-Q to toggle the trimming display off, and Shift-Q again to toggle it back on.

Trim Tool Operations With the Keyboard
You can also perform every trim operation more precisely using the Nudge keyboard shortcuts.

To trim with the keyboard:

1	 Press T to select the Trim tool.

2	 To trim the selection, do one of the following:

�� To slide a clip: Press Shift-V to select a clip, and press the Comma key to slip it one 
frame to the left, or the Period to slip it one frame to the right. Shift-Comma and Shift-
Period slips the clip in 10 frame increments.

�� To slip a clip: Press Shift-V to select a clip, then press the S key to toggle to Slip 
mode (pressing S again toggles back to Slide mode) and press Comma or Period to 
slide its contents to the left or right. Shift-Option-Comma and Shift-Option-Period 
slides the contents in 5 frame increments.

�� To roll an edit: Press V to select an edit point, then press the Comma key to nudge 
it one frame to the left, or the Period to nudge it one frame to the right. Shift-Comma 
and Shift-Period rolls the edit in 5 frame increments.

�� To ripple an edit: Press V to select an edit point, then press U to select either the 
incoming or outgoing side of the edit by itself. Then, press the Comma key to ripple 
the selected In or Out point of the clip to the left, or the Period to ripple it one frame 
to the right. Shift-Comma and Shift-Period ripples in 5 frame increments.

3	 If you want to suspend the two or four-up display that appears in the Timeline Viewer 
while trimming, you can press Shift-Q to toggle the trimming displays off and on.
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Important Trimming Keyboard Shortcuts
When trimming using the keyboard, the following keyboard shortcuts are important for you to 
remember. Most of these commands, and many more that haven’t been assigned to keyboard 
shortcuts, can also be found in the Trim menu. You can remap many of these commands to 
different keyboard shortcuts using the Keyboard Mapping panel of the User Preferences. 
For more information, see Chapter 3, “Project Settings and Preferences.”

Key Shortcut Function

T Trim mode, ripples edits and slips or slides clips.

A Selection mode, resizes edits and moves clips.

Command-L and J Fast trim commands, lets you dynamically trim the selection at 100% 
forward and reverse speeds.

W Dynamic trim or resize mode, uses JKL to trim the selection

S Toggles between Slip and Slide mode when a clip is selected in 
Trim mode.

V Selects the edit point closest to the playhead, and moves the 
playhead there.

Shift-V Selects the clip or gap that intersects the playhead, and moves the 
playhead to the center of the clip or gap. If there are superimposed 
clips, turn off the Auto Select controls of tracks containing clips you 
don’t want to select.

Shift A modifier that temporarily disables the 2- and 4-up display that 
appears when trimming edits and clips with either the pointer or 
keyboard shortcuts.

Shift-Q Toggles Enable Preview During Editing, which controls visibility of 
the 2- and 4-up displays that appear in the Viewer when trimming 
edits and clips.

Option-F1 through F9 Toggles Auto Select for video tracks 1 through 9, making it possible 
to restrict certain selection and trim operations performed with 
the keyboard.

Command-Option 
F1 through F9

Toggles Auto Select for audio tracks 1 through 9, making it possible 
to restrict certain selection and trim operations performed with 
the keyboard.

U Toggles the currently selected edit point among the outgoing, 
centered, or incoming part of the edit.

Option-U Toggles the currently selected edit point or clip among Video+Audio, 
Video Only, or Audio Only.

TIP: When holding down the Shift key while nudging to do a “fast nudge,” the duration 
of the nudge is customizable in the Editing panel of the User Preferences. By default 
it’s five frames, but you can set it to whatever you want.
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Key Shortcut Function

Comma (,) After you’ve made a selection, nudges selected edits or clips one 
frame to the left. Shift-Comma nudges 5 frames (the duration is 
customizable in the Editing panel of the User Preferences).

Period (.) After you’ve made a selection, nudges selected edits or clips one 
frame to the right. Shift-Period nudges 5 frames (the duration is 
customizable in the Editing panel of the User Preferences).

Forward-Slash (/) This command works contextually depending on what’s selected in 
the Timeline. Plays a section of the Timeline from x frames before to 
y frames after (a) the playhead (if nothing’s selected), (b) the currently 
selected edit point, (c) the currently selected clip, (d) a selection of 
multiple clips. This command is useful for previewing how the current 
selection plays within the context of the clips immediately 
surrounding it. The pre-roll and post-roll time is customizable in the 
Editing panel of the User Preferences.

Command-/ Toggles looped playback off and on.

Down Arrow, Up Arrow Moves both the playhead and selection state to the next or previous 
edit point. If multiple clips or edits are superimposed, the first clip on 
the lowest numbered track will be selected first, then the next clip 
up, and so on until the topmost superimposed clip is selected, before 
selecting the next clip in the Timeline.

E Extend edit. Resizes or ripples selected edit points to the current 
position of the playhead.

Shift-[ Trim Start. Resizes (Selection) or ripples (Trim) the In point of all clips 
on auto-select-enabled tracks that intersect the playhead to the 
position of the playhead.

Shift-] Trim End. Resizes (Selection) or ripples (Trim) the Out point of all clips 
on auto-select-enabled tracks that intersect the playhead to the 
position of the playhead.

Shift-Command-[ Ripple Trim Start. Regardless of whether Selection or Trim mode is 
enabled, always ripples the In point of clips on auto-select-enabled 
tracks that intersect the playhead to the position of the playhead.

Shift-Command-] Ripple Trim End. Regardless of whether Selection or Trim mode is 
enabled, always ripples the Out point of clips on auto-select-enabled 
tracks that intersect the playhead to the position of the playhead.

IMPORTANT:  While the Slip, Roll, and Slide tools will change the sync relationship of 
the clips you’re adjusting with a matching soundtrack, the rest of the Timeline won’t be 
affected. Using the Ripple tool can alter the overall sync relationship of large portions 
of your timeline and its matching soundtrack, so you should use it with extreme care.
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Trimming Using Timecode Entry
You can also use absolute or relative timecode entry to trim clips and edits. What is trimmed 
depends on the selection you’ve made prior to entering timecode. If you want to use timecode 
to trim the selection forward relative to its current position, be sure to type an equal sign or plus 
(= or +) before the timecode value; to trim the selection backward relatively, type minus (–) 
before the timecode value.

�� To roll an edit: Select the center of an edit point, enter a timecode value, and 
press Return.

�� To ripple an edit: Select either the outgoing or incoming half of an edit point, enter a 
timecode value, and press Return.

�� To slip a clip: Select a clip, and press S if necessary to switch to Slip mode, enter a 
timecode value, and press Return.

�� To slide a clip: Select a clip, and press S if necessary to toggle to Slide mode, enter a 
timecode value, and press Return.

How to Enter Timecode Values
When entering timecode, type each pair of hour, minute, second, and frame values from left to 
right, with a period representing a pair of zeros for fast entry. The numbers you enter appear in 
the Timecode field at the upper left-hand corner of the Viewer with focus. When you’re finished 
typing, press the Return key to execute the Timecode command. The rules for timecode entry 
are as follows:

�� The right-most pair of timecode values (or period) you enter is always the 
frame number.

�� A period to the left or to the right of any number you type is considered to be a pair 
of zeroes. 

�� A single period between two numbers is considered to either be a single zero or 
ignored if it’s between two pairs of numbers.

�� Any untyped pairs of values to the left of what you enter are assumed to be whatever 
those values were prior to the timecode you entered; this makes it easy to type partial 
timecode values even when the Timeline starts at hour one. 

�� It’s not necessary to enter colons or semicolons. 

Absolute timecode is entered simply by typing in a timecode value. So long as no clips or edit 
points are selected when you press the Return key, the playhead will move to that timecode 
value. If an edit point or clip is selected, those will be moved or trimmed to the corresponding 
timecode value, if possible.
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Here are some examples of absolute timecode entry using this method:

Original TC Value User-Typed Value New TC Value

01:10:10:10 15245218 15:24:52:18

01:10:10:10 2.. 01:02:00:00

01:10:10:10 15 01:10:10:15

01:10:10:10 12 01:10:10:12

01:10:10:10 1.2 01:10:01:02

01:10:10:10 115.. 01:15:00:00

01:10:10:10 23... 23:00:00:00

Relative timecode is entered by starting the timecode value with a plus (+) or minus (–). Adding 
a plus results in the value you type being added to the current timecode value for purposes of 
offsetting the playhead or moving a selection. Adding a minus will subtract the value you type 
from the current timecode value.

Here are two examples of  relative timecode entry:

+20.	 00:00:20:00 is added to the current timecode value.

-5	 00:00:00:05 is subtracted from the current timecode value.

Commands to Make Selections and Trim
A series of commands in the Trim menu make it fast to automatically select the In or Out point of 
the clip that’s nearest to the current position of the playhead, and go into either Selection or 
Trim mode in preparation for resizing or ripple trimming that edit point. These commands are:

�� Select Nearest Edit to Resize In

�� Select Nearest Edit to Resize Out

�� Select Nearest Edit to Ripple In

�� Select Nearest Edit to Ripple Out

�� Select Nearest Edit to Roll

�� Select Nearest Clip to Move

�� Select Nearest Clip to Slip

�� Select Nearest Clip to Slide

These commands are similar to using the Edit Selection (V) or Clip Selection (Shift-V) keyboard 
shortcuts along with those for choosing the Selection (A) or Trim tool (T) both at once, to get 
you ready for trimming in the way that you want. However, they have the added benefit of, in 
some cases, letting you specifically choose the In or Out points of the clip nearest the current 
position of the playhead. These commands don’t have keyboard shortcuts by default, but if you 
prefer this way of working, you can assign them to keyboard shortcuts of your choosing using 
the Keyboard Mapping panel of the User Preferences.
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Trimming Clips in the Source Viewer
Additionally, you can double-click a clip in the Timeline to open it into the Source Viewer for 
trimming. When the Selection tool is selected, you can drag the In and Out markers, or use the 
playhead and I and O keyboard shortcuts to resize that clip in the Timeline. With the Trim tool 
selected, you can ripple the In and Out points of the clip.

A Timeline clip being ripple-resized by opening it into the 
Source Viewer dragging its In point using the Trim tool
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You can slip the contents of the clip by holding the Shift key down and dragging either the In or 
Out point.

A Timeline clip being slipped by opening it into the Source 
Viewer and Shift-dragging its In point using the Trim tool

Ripple Editing Rules
Ripple operations are the only trim functions that change the duration of the overall Timeline, 
and that can potentially alter the sync relationship between multiple clips on different tracks. 
This makes them incredibly useful, but it’s important to understand which parts of the Timeline 
will move as part of a ripple operation, and which parts won’t.

The following operations ripple the Timeline:

�� Ripple deleting a clip or gap (Forward-Delete)

�� Ripple cutting a clip (Shift-Command-X)

�� Rippling one or more edits or gaps using the Trim tool (press T to choose the Trim tool)

�� Using the Extend Edit (E), Trim Start (Shift-[), or Trim End (Shift-]) commands 
in Trim mode

�� Using the Ripple Start (Command-Shift-[) or Ripple End (Command-Shift-]) commands 
in any mode

�� Performing an Insert Edit (F9) or Ripple Overwrite (Shift-F10) edit

�� Using the Retime controls to speed up or slow down a clip in Trim mode

�� Using the Change Speed dialog with the Ripple Sequence checkbox turned on

�� Changing clips in a Take Selector with the Ripple control enabled

During a ripple edit, superimposed clips with an In point that’s to the left of the edit point or clip 
being rippled are not moved. This can be seen in the previous example via the audio clip at the 
bottom of the Timeline, which stays in place even as the clips on track V1 and A1 are rippled. All 
clips with In points to the right of the edit point or clip being rippled move left to follow the trim 
operation you’re making.

NOTE: To open a match frame of a clip that’s part of an edited sequence into the 
Source Viewer using the mouse, hold the Option key down while double-clicking a 
clip in the Timeline.
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Before Ripple

After Ripple

The rules of timeline rippling illustrated. All clips with In points to the left of Subclip B (the clip being 
rippled) are left in place (area in blue), while all clips to the right of the edit being rippled are moved by 
the duration of the ripple operation (in red)

This simple rule means that, if you’re in the habit of building sequences of clips from left to 
right, long overlapping superimpositions such as titles, graphics, and music clips will stay in 
place while you’re rippling various clips within a montage that you’re editing in relation to these 
longer clips.

However, there’s one exception to this rule. It is often the case that split edits, where linked 
audio and video are cut at different places, creates a situation where the audio In point of a pair 
of linked audio and video items precedes a video In point that you want to ripple. In other 
words, the audio In point extends to the left of the video In point, which ordinarily would trigger 
the rule that clips with edit points to the left of a rippled edit point  won’t be moved, which 
would throw the audio and video of this item out of sync. In this case, you probably want to 
maintain sync, so all items that are linked to a clip being rippled always ripple along with it, even 
if they do have In points that extend to the left of the edit point being rippled.
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Using Auto Select Controls 
to Control Trimming
The Auto Select buttons on each track in the Timeline control a host of different operations, but 
while they’re deceptively powerful, they’re also among the most misunderstood controls of the 
Timeline. When a track’s Auto Select control is on, clips on that track are automatically included 
in three different types of operations:

�� Operations that affect clips intersecting the position of the playhead

�� Operations that affect clips intersecting a region defined by timeline In and Out points

�� Operations that ripple clips to the right of an affected clip on the Timeline

When a track’s Auto Select control is off, clips on that track are ignored by those same 
categories of operations, unless you manually select one or more clips or edit points.

The next three sections go into detail on how the Auto Select buttons help you control the 
trimming operations described in this chapter, particularly when it comes to operations that 
ripple the Timeline, and the kinds of “playhead-targeted” trim operations described later in this 
chapter. For more information on using the Auto Select controls to define selections and control 
other editing operations, see Chapter 17, “Editing Basics.”

Using Auto Select to Control Which Clips are Trimmed
One of the principal uses of the Auto Select controls is to let keyboard shortcut-driven editors 
choose which specific clips on which tracks will be affected by an operation that would 
otherwise affect every superimposed clip at the position of the playhead or encompassed by In 
and Out points set in the timeline. 

For example, if multiple clips are superimposed in V1, V2, and V3, and A1, A2, and A3, all six tracks 
have their Auto Select controls turned on, and you park the playhead over one of them and use 
the Trim End command in Selection mode, then all six superimposed clips will be trimmed.

Trimming all clips at the position of the playhead
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However, if you only want to trim the clip in track V3, then you can solo the Auto Select control 
of V3 by Option-clicking it, and then when you use the Trim End command, the clip on V3 is the 
only one that’s trimmed, the other clips are ignored.

Trimming only the clip in V3 by soloing the V3 auto select controls

Using Manual Selections to Control 
Which Clips Are Trimmed
It’s important to know that manual selections you make in the Timeline that highlight specific 
clips always take precedence over whatever the Auto Select controls are set to. For example, if 
Auto Select is turned on for tracks V1, V2, and V3, but you’ve selected a clip on track V1, only 
the selected clip will be still be affected by whatever operation you decide to perform. For 
example, if you use Trim End, the clip on track V1 will be affected.
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Manual selection of a clip on track V1 overrides 
the auto select controls on all tracks

Using Auto Select to Control Which Tracks Are Rippled
Each track’s Auto Select control is also used to control how trimming and editing operations 
that ripple the Timeline affect timelines with multiple tracks and superimposed clips. Using Auto 
Select controls, you can turn off rippling on specific tracks, while leaving it on for others. 

For ease of use, you’ll typically want to leave Auto Select on for all tracks when rippling clips, to 
ensure that all the parts of your timeline stay in sync with one another. However, when the 
occasion requires, the Auto Select controls provide the option to suspend rippling on specific 
tracks while allowing rippling on others.

The rules are simple:

�� Tracks with Auto Select enabled: Ripple editing or ripple deleting affects all clips to 
the right of the clip or clips on that track being trimmed.

Before and After, clip to the right of Clip T on tracks V2, V1, A1, and A2 are rippling because those 
track’s Auto Select controls are enabled
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�� Tracks with Auto Select disabled: Rippling is disabled on these tracks.

Before and After, clip to the right of Clip T on tracks V1 and A1 are rippling because 
those tracks’ Auto Select controls are enabled, but clips on tracks V2 and A2 aren’t 
rippling because those tracks’ Auto Select controls are disabled

Another set of rules govern what happens when you select clips or edits for trimming 
on tracks with Auto Select disabled: 

�� Selected Tracks with Auto Select turned off with an edit selection: If you select the 
outgoing or incoming half of an edit on a track that has Auto Select off, the result will be 
a resize operation. Ripple deleting clips leaves a gap.

Before and After, clips to the right of Music Cue 03 on tracks V1, V2, A1, and 
A2 are rippling because Auto Select is enabled on those tracks, but because 
the clip being trimmed on track A3 has Auto Select disabled, it doesn’t ripple, 
instead resizing to open up a gap
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Trimming Multiple Edits or Clips at Once
DaVinci Resolve lets you select multiple edit points or clips for certain trimming operations, 
making it possible to trim multiple edits and clips at the same time. In simple cases, this makes it 
easy to resize, ripple, slip, and slide several superimposed clips at the same time, which is a real 
convenience, or you can select the In point of every title generator in a credit sequence at once 
in preparation for shortening or lengthening them all at once. In more complicated cases, this 
lets you create more complicated trimming scenarios, such as multi-track asymmetric trimming, 
to quickly take care of difficult tasks.

No matter how ambitious a trim operation you want to set up, the procedure is exactly the same 
as for an ordinary trim operation. Just make sure you follow these three general steps, and 
you’ll be good:

1	 Choose Selection mode, and select the edit points or clips you want to trim. To make 
multiple selections, click once to select the first item, then Command-click each 
subsequent item you want to add to the selection. You can select as many clips and/or 
edit points on as many tracks as you like.

2	 To ripple, slip, or slide the entire selection at once, choose Trim mode. To resize or 
move each selected item at once, continue using Selection mode.

3	 Use the mouse, keyboard shortcuts, or timecode entry to execute the trimming 
operation, just as you would if a single edit point or clip were selected.

The following sections describe each of the special-case multi-selection trim operations that 
are possible, along with each one’s special rules and limitations.

Resizing and Rolling Multiple Edit Points
You can resize or roll multiple edit selections at once. In this way, you can adjust the edit points 
of multiple superimposed clips all together. Trimming multiple edit points essentially lets you 
“gang” them so that all selected edits move together as one.

To resize multiple clips at once, select the left (outgoing) or right (incoming) half of each edit 
point you need to adjust, then use the Selection tool to drag those edit points to resize them all.

To roll multiple clips at once, select every edit point you need to adjust right at the center, so 
that both the incoming and outgoing halves of each edit point are selected, then use either the 
Selection or Trim tools to drag those edit points to roll them all.

Rippling Multiple Edit Points
It’s also possible to select multiple incoming or outgoing edit points on either superimposed 
video tracks, or on the same video track, in order to ripple them all at once. A good example of 
when you’d want to ripple multiple clips on the same track is if you’ve got an end credit 
sequence of fourteen text generators, and you’d like to shorten the entire sequence by a 
particular amount. This example can be seen below. 

NOTE: You cannot combine ripple and roll operations at the same time.
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When you ripple trim multiple edits on the same track, how many frames are trimmed in a 
particular trim depends on what method you use to do your trimming. 

�� If you use use the Trim tool via dragging in the Timeline, then you can choose to 
ripple the entire selection of edits by an arbitrary duration, for example, shortening or 
lengthening the entire selection by 8 frames. To do this, DaVinci Resolve performs your 
multi-selection trim operation one edit at a time, removing a frame at a time from each 
selected edit from the left to the right as you trim, until either you stop the operation, 
or every single selected edit has had a frame removed, at which point DaVinci Resolve 
begins trimming the second frame from each selected edit from the left to the right, and 
then the third, and so on, until you stop trimming. Working this way, you can use the 
mouse to trim any number of clips to fit into any duration. 

�� You can also choose to ripple each selected edit by the same amount, for example 
removing 3 frames from each of the selected edits, all at once. To do so, hold the 
Command key down while dragging selected edits with the Trim tool, or use Dynamic 
JKL trimming, or trim by entering relative timecode values, or use the nudge keys 
(period and comma). 

To ripple trim multiple edits on the same track: 

1	 Click the Trim tool, and drag a bounding box in the Timeline to select all forty-
nine edits. 

2	 Press the U key to select the incoming half of each selected edit. 

3	 Use whichever trimming method you prefer to ripple the sequence to be shorter or 
longer. Dragging using the Trim tool lets you trim by an arbitrary number of frames, 
while holding the Command key down while dragging with the Trim tool, using 
timecode entry to trim, using the comma and period nudge keys, or using Dynamic JKL 
trimming lets you trim every selected edit by the same number of frames 

(Before) Selecting fourteen incoming credits edit points, (After) Trimming them all at once

In the following example, the incoming edit of three clips in the following montage are selected 
and simultaneously rippled using the Trim tool. Notice that each overlapping clip ripples along 
with the nearest selected edit that’s to the left of it; this means that the superimposed clip in 
track V2 and the audio clip in track A4 ripples along with the third selected edit, while the audio 
clip in track A2 ripples along with the second selected edit. Since the audio clip in track A3 
starts to the left of the first selected edit, it does not ripple.
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(Before) Selecting three incoming edit points, (After) Trimming them all at once

Asymmetric Trimming
Asymmetric resize or ripple trimming can also be done to multiple clips, with one selection per 
track allowable on as many tracks as you require. To asymmetrically trim two or more clips, 
select an outgoing edit point on one track, and then Command-click an incoming edit on 
another track. 

Selecting opposite outgoing video and incoming audio edit points 
in preparation for performing an asymmetric ripple trim

To select the outgoing video edit of one clips and the incoming audio edit of the next clip in 
preparation for making a split edit, you can Option-click the outgoing video edit to suspend 
linked selection, and then Command-click the incoming audio edit to add it individually to the 
selection. Now when you drag, nudge, or use timecode to trim, each selected edit point will 
move in the opposite direction.
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Dragging to perform an asymmetric ripple trim to create a 
split edit using the Trim tool

Starting in version 12, you can also do asymmetric trims to multiple edits in the same video and/
or audio track. There are two compelling reasons for doing so:

Select the outgoing half of an edit point (the left side), then Command-click to select the 
incoming half of the same edit point (the right side) separately. This will not perform a roll edit, 
but will allow you to either use the Selection tool to resize both edit points away from each 
other to create a gap, or use the Trim tool to ripple both sides of the edit to shorten both clips 
while tightening up the Timeline at the same time.

Before and After ripple trimming both the incoming and outgoing 
halves of an edit to shorten the duration of both clips at once

You can also select the In and Out points of a clip in the Timeline at the same time, and use the 
Trim tool to ripple both the beginning and end of the clip closer to the center, shortening the 
clip while preserving the content in the middle, while tightening up the Timeline. 
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Before and After ripple trimming both the In and Out points of a clip at the same time, shortening the 
clip by removing heads and tails, and preserving the action in the middle

In short, you can use nearly any combination of edit selections you need to simultaneously trim 
multiple clips in the same track, in multiple tracks, whatever you need to do to save time. 
Furthermore, asymmetric trimming can be done in either Selection or Trim mode, either to open 
and close gaps, or to move edit points to overlap one another to create split edits.

Slipping Multiple Clips
You can simultaneously slip any number of selected clips (so long as they have handles) on any 
combination of tracks by selecting the clips you want to slip, then choosing the Trim tool, and 
dragging their name bars or using the comma and period keys to nudge the selection.

Dragging to slip multiple selected clips at once
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Sliding Multiple Clips
Starting in version 12, you can select as many clips as you like in preparation for a slide 
operation. If you select multiple contiguous clips, they slide together as one.

(Before) Selecting four clips to slide, (After) All four clips slid to the right using the mouse

Keyboard Trimming During 
Looped Playback
A great technique for editors who like to do precision trimming using the Nudge commands is 
the ability to enable looped-playback so that the Play Around command (Forward Slash) will 
loop continuously around the edit point you’re trimming as you nudge one or five frames at a 
time to fine tune the cut.

To trim while looping:

1	 Move the playhead near the edit point you want to trim, and press V to select it.

2	 Press the U to choose which side of the edit you want to select in order to ripple or roll 
it, and/or Option-U to choose whether you want to trim video+audio, the video only, or 
the audio only.

3	 Press Command-Forward Slash (/) to enable looped playback.

4	 Press Forward Slash (/) to play around the current selection. With looping on, playback 
will continue until you stop it. Pre-roll and post-roll can be changed in the Edit panel of 
the User Preferences.

5	 During looped playback, press the comma (,) and period (.) keys to trim the selection 
back or forward by a single frame, or Shift-comma and Shift-period to trim the selection 
in 5 frame increments.

6	 When you’re finished, press the Space Bar or K key to stop playback.

TIP: When holding down the Shift key while nudging to do a “fast nudge,” the duration 
of the nudge is customizable in the Editing panel of the User Preferences. By default 
it’s five frames, but you can set it to whatever you want.
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Dynamic JKL Trimming
One of DaVinci Resolve’s most interactive trimming features is the ability to dynamically resize, 
ripple, roll, slip, slide, or move selected edit points and clips using the JKL transport control 
keyboard shortcuts. This means that you can make an appropriate selection in the Timeline 
(edit points to resize, ripple or roll, or clips to slip or slide) then trim them during playback, while 
monitoring audio and watching the video.

Trimming while viewing the selected clip or edit point playing back has the advantage of letting 
you get emotionally involved in what you’re watching, as well as experiencing the timing of a 
clip as it plays, in order to help you get a better feel for how, exactly, you need to trim a 
particular cut. 

While you’re dynamically trimming, you see the same two-up or four-up display, the same 
Timeline overlays, and the same dynamically updating Timeline that appear when you use the 
Trim tool with the mouse. The only difference is that you’re trimming while your program plays.

There are two methods of doing dynamic trimming:

�� Quick Trim: You can select one or more edit points or clips, and immediately trim it 
by pressing Command-J or Command-L to trim back or trim forward. This is a fast way 
of dynamically trimming, but you can only trim forward and backward at 100 percent 
speed or greater.

�� Turning on Dynamic Mode: If you want to do more detailed work, you can press the W 
key to enable Dynamic mode (or choose Trim > Dynamic Trim Mode), at which point you 
are in a special mode where the JKL shortcuts only trim the current selection, whatever 
it happens to be. However, this mode also gives you additional options for controlling 
which part of the selection, in the case of multiple selection trims, you want to monitor 
for audio/video playback.

Quick Trimming
If you’re in a hurry and you can accomplish the trim you want via real time or faster playback, 
then pressing the Command key while using the J or L keyboard shortcuts lets you dynamically 
trim any selection in the Timeline, with audio/video playback.

To dynamically trim using Command-J or Command-L:

�� To dynamically roll an edit: In either Selection or Trim mode, select the center of one 
or more edit points, and hold the Command key down while using J or L to move the 
selection around.

�� To dynamically ripple an edit: Choose Trim mode, select the outgoing or incoming half 
of one or more edit points, and hold the Command key down while using J or L to move 
the selection around.

�� To dynamically resize an edit: Choose Selection mode, select the outgoing or 
incoming half of one or more edit points, and hold the Command key down while using 
J or L to move the selection around.

�� To dynamically move a clip: Choose Selection mode, select one or more clips, and 
hold the Command key down while using J or L to move the selection around.

TIP: If nothing is selected while you’re in Dynamic Trim mode, JKL simply plays through 
the Timeline, as usual.
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�� To dynamically slip or slide a clip: Choose Trim mode, select one or more clips to slip, 
or a single clip to slide, press S to toggle between Slip or Slide modes, then hold the 
Command key down while using J or L to execute either slip or slide operations.

If you’re trimming multiple selections, you can control which edit point you monitor during the 
trim operation by positioning the playhead at one of the selected edit points.

Trimming in Dynamic Mode
If you want to also have the option of trimming in slow motion or frame by frame, in addition to 
trimming at 100% or greater playback speeds, then you’ll need to enable Dynamic mode.

To use dynamic mode to dynamically trim one or more selected clips or edits:

1	 Press W to enter Dynamic mode. The word Dynamic and Slip or Slide (depending on 
what mode you’re in) appears in the toolbar and the playhead turns yellow to let you 
know you’re in Dynamic Trim mode, in which all you can do is trim.

Dynamic appears in the toolbar to let you know you’re in 
Dynamic mode, followed by either Slip or Slide depending 
on what mode you’re in

2	 Choose the type of operation you want to perform by selecting either Selection mode 
(A) or Trim mode (T):

�� In Selection mode, you can dynamically resize or roll edits, and move or slip clips. 
�� In Trim mode, you can dynamically ripple or roll edits, and slip or slide clips.

3	 Make a selection that’s appropriate to the trim operation you need to accomplish. 
Select edit points to resize, ripple or roll, or select clips that you want to slip or 
slide (using the S key to toggle between slipping and sliding). You can also select 
combinations of multiple clips to trim.

4	 If you have selected multiple edit points, then you can use the Left and Right arrow 
keys in Dynamic mode to move the playhead to the selected edit point you want to 
monitor while trimming. If the playhead isn’t on a selected edit point, then it will jump to 
the nearest selected edit point once trimming commences.

5	 Use any combination of the JKL keyboard shortcuts to initiate playback and trimming, 
including:

��  J+K or K+L to trim in slow motion, with slow motion audio playback
�� Pressing K while tapping J or L to trim a frame at a time
�� Pressing J or L to trim with real time playback
�� Pressing J or L repeatedly to trim in fast-reverse or fast-forward, at a variety of speeds

As you dynamically trim, all audio clips in all audio tracks will play back as they cross 
the playhead, so you can hear your entire mix as you’re trimming.

TIP: When you’re finished with a dynamic trim operation and you want to see how that 
edit plays, you can press the Forward Slash key (/) to play around the current selection 
to quickly preview that section of the Timeline.
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6	 After you’ve made a trim, you can press the Spacebar to initiate Play Around Current 
Selection to see how that trim plays. In Dynamic Mode, the spacebar only executes 
a Play Around Current Selection operation, rather than play forward. What is played 
by Play Around Current Selection depends on what is selected; a selected edit plays 
around just that edit, a selected clip plays around the whole clip, multiple clips or edits 
play around the total selection, including the current Pre-Roll and Post-Roll settings in 
the Editing panel of the User Preferences.

7	 When you’re finished, press W again to toggle Dynamic mode off.

You always want to be sure to turn Dynamic mode off when you’re done, because otherwise 
using JKL will continue trimming selections, instead of playing the Timeline.

Trim Operations that are 
Targeted Using the Playhead
The following series of Trim editing commands let you trim clips and edits in different ways 
using the position of the playhead to guide the result.

Trim Start and Trim End
The Trim > Trim Start (Shift-[) and Trim End (Shift-]) commands let you move the In or Out point of all 
clips that intersect the playhead as either a ripple operation (in Trim mode) or a resize operation 
(in Selection mode). You do not need to make a selection to use Trim Start and Trim End, making 
these commands fast to use in the right situation. A classic use of Trim End is when you have 
several superimposed clips of different lengths that you want to either start or end at the 
same time.

Trim Start resizes or ripples (depending on what mode you’re in) all clips that intersect the 
playhead, so that each clip’s In point is moved to the current playhead position. 

Before and After a Trim Start operation, all clips 
that intersect the playhead are trimmed
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Trim End resizes or ripples intersecting clips so that each intersecting clip’s Out point is moved 
to the current playhead position.

Before and After a Trim End operation, all clips that intersect the playhead 
are trimmed; clips that don’t intersect the playhead are not affected

Clips that don’t intersect the playhead are not affected. Furthermore, you can exclude clips on 
specific tracks from this operation by disabling the auto-select controls on those tracks.

Resize, Ripple, and Roll Start and End Commands
Another set of commands in the Trim menu lets you combine the Trim Start and Trim End 
functions with the act of choosing either Selection or Trim mode, and the ability to resize, ripple, 
or roll, all with single commands.

�� Resize Start to Playhead

�� Resize End to Playhead

�� Ripple Start to Playhead (Command-Shift-[)

�� Ripple End to Playhead (Command-Shift-])

�� Roll Start to Playhead

�� Roll End to Playhead

Just as with Trim Start and Trim End, these commands use the Timeline Auto Select controls to 
determine, of all clips intersecting the playhead, which clips on which tracks to trim. Many of 
these commands don’t have keyboard shortcuts by default, but if you prefer this way of 
working, you can assign them to keyboard shortcuts of your choosing using the Keyboard 
Mapping panel of the User Preferences.
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Slip and Slide Playhead to In and Out Commands
Yet another set of commands in the Trim menu lets you either Slip or Slide a clip from the frame 
at the current position of the Playhead to the In or Out point of that clip.

�� Slip Playhead to In

�� Slip Playhead to Out

�� Slide Playhead to In

�� Slide Playhead to Out

Just as with Trim Start and Trim End, these commands use the Timeline Auto Select controls to 
determine, of all clips intersecting the playhead, which clips on which tracks to trim. These 
commands don’t have keyboard shortcuts by default, but if you prefer this way of working, you 
can assign them to keyboard shortcuts of your choosing using the Keyboard Mapping panel of 
the User Preferences.

Extend Edits
The Extend Edit command (choose Trim > Extend Edit, or press E) lets you resize or ripple one 
or more selected edit points or clips. Unlike Trim Start and Trim End, it doesn’t matter if the 
playhead intersects clips when doing an Extend edit. 

Extend Editing Edit Points
Make one selection per track of any combination of In or Out points, and press the E key to 
move those edit points to the current position of the playhead. 

Before and After a multi-track extend edit performed in selection mode

TIP: The Slip Playhead to In command functions identically to using the Extend edit 
while the playhead intersects a selected clip.
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In Trim mode, selected edit points will ripple instead of resizing affected clips. However, to 
simplify multi-track extend edit operations when using the Trim tool, the lowest numbered video 
track with auto-select enabled defines the amount by which the extend edit will ripple the rest 
of the Timeline; all selected edit points on other tracks are simply resized to the position of 
the playhead.

Before and After a multi-track extend edit performed in Trim mode; you can see that the lowest 
numbered track with a selection defines how far the Timeline will be rippled

Extend Editing to Slide Clips
You can also use the Extend edit command to slide the contents of a single selected clip using 
either the Selection or Ripple tools. Simply select a clip, position the playhead over the frame of 
that clip you want to slip to the In point of that clip’s position in the Timeline, and press E to 
perform the slip. You can even do this during playback if you want to watch the clip play and 
press E to slip that frame back when the moment feels right.

Using the Extend edit to Slip a clip in the Timeline, the red marker shows that the 
frame at the playhead is slipped back to the In point of that clip in the Timeline



456

U
si

ng
 T

ra
ns

iti
o

ns
 

P
ar

t 
3 

–
 2

4

Chapter 24

Using Transitions 
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Using Transitions
Transitions are the connective tissue binding together moments requiring a more significant 
way of changing from one image to the next than a simple cut. This chapter shows the many 
ways you can add and edit transitions in your program.

This chapter covers the following topics:

Working With Transitions	 458

Adding and Editing Transitions	 458

Adding Transitions When There’s Not Enough Handles	 460

Adding Transitions By Dragging to Create Overlap	 460

Transition Properties in the Inspector	 461

Using Transition Curves	 462

Organizing Transitions	 463

Changing the Standard Transition	 464

DaVinci Resolve Transitions	 464

OpenFX Transitions	 469
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Working With Transitions
Transitions provide another way of bridging the change from one clip to another, and are often 
used to indicate a change in time or location when changing scenes. DaVinci Resolve supports 
a variety of transitions ranging from various forms of the traditional cross-dissolve to different 
types of wipes, allowing for great flexibility when finishing creative edits. In addition, DaVinci 
Resolve supports third-party OpenFX transitions that you install on your system. Transitions are 
applied at edit points, and appear as editable objects in the Timeline.

Video and audio transitions in the Timeline

The default transitions that come with DaVinci Resolve appear within the Toolbox panel of the 
Effects Library, while OpenFX transitions appear within the OpenFX panel.

Adding and Editing Transitions
The following procedures describe how to work with add and edit transitions in the Timeline 
using both the mouse and keyboard shortcuts.

Methods of adding transitions using the mouse:

�� To add a transition by dragging it from the Effects Library: Drag a video transition 
from the Effects Library to an edit point in the Timeline so that it’s centered at, ends at, 
or starts at the edit point. If there is no overlap between the heads and tails of the two 
clips, you may not be able to add a transition where you want.

�� To add a transition using the Effects Library contextual menu: Select one or more 
edit points (one per track), then right-click a video transition in the Effects Library and 
choose Add to Selected Edit Points. That transition will be added to every selected edit 
point at once.

The Transition contextual menu in the Effects Library
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To add a transition using the Edit Point contextual menu: Right-click any edit point between clips 
with overlapping handles, and choose one of the four durations available for the Standard 
Transition; the available choices are quarter-second, half-second, one second, and two 
seconds, expressed in frames at whatever the current frame rate of the Timeline is.

The Transition contextual menu for an edit in the Timeline

Methods of adding transitions using keyboard shortcuts:

�� To add a video+audio transition using the keyboard: Select one or more edit points 
using the Selection tool, or move the playhead near an edit you want to select and 
press V to select it, then press Command-T  (Timeline > Add Transition) to add the 
standard transition. Transitions are added using the “Standard transition duration” as 
specified in the Editing panel of the User Preferences, which defaults to one second, or 
however long the overlapping handles of the selected edit point allow.

�� To add a video or audio-only transition using the keyboard: Select one or more 
edit points, and press Option-T (Timeline > Add Video Only Transition) to add only a 
video transition, or Shift-T (Timeline > Add Audio Only Transition) to add only an audio 
transition. Transitions are added using the “Standard transition duration” as specified 
in the Editing panel of the User Preferences, which defaults to one second, or however 
long the overlapping handles of the selected edit point allow.

�� To add a transition with specific alignment using the keyboard: Select an edit, press 
the U key to choose the start, center, or end of the edit, then press Command-T. 
The standard transition will be added with its alignment based on the edit selection; 
selecting the start of the edit places a transition that ends on the edit; selecting the end 
of the edit places a transition that starts on the edit, and choosing the center of the edit 
places a transition that is similarly centered.

Methods of moving and duplicating transitions:

�� To move a transition from one edit to another: Select a transition, then drag it to 
another edit point.

�� To copy a transition from one edit to another: Select a transition, then option-drag it to 
another edit point.

Methods of altering transitions in the Timeline:

�� To change a transition’s type: Drag a different transition from the Effects Library onto 
the current one in the Timeline.

�� To change a transition’s duration: Drag the beginning or end of the transition in the 
Timeline to be longer or shorter symmetrically about the current edit. Alternately, you 
can double-click any transition to open it in the Inspector, and set a new duration in 
seconds or frames.

�� To change a transition’s alignment: Right-click a transition in the Timeline and choose 
a new method of alignment from the contextual menu. Alternately, you can double-
click any transition to open it in the Inspector, and choose a new option from the 
Alignment pop-up.

�� To remove a transition: Select a transition in the Timeline and press the Delete key. 
Or, right-click a transition in the Timeline and choose Delete from the contextual menu.
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Adding Transitions When 
There’s Not Enough Handles
If the outgoing and incoming overlapping handles at a given edit point don’t have enough 
frames to fit the standard transition duration, and you try to add a transition by selecting one or 
more edit points and pressing Command-T, or by right-clicking an edit point and using the 
transition options in the resulting contextual menu, then you’ll be presented with a dialog that 
gives you three choices:

�� Trim Clips: You can automatically trim the incoming and outgoing sides of each 
selected edit point to create the overlap needed for adding the standard transition.

�� Skip Clips: Don’t add transitions to the selected edit points that lack the 
appropriate overlap.

�� Cancel: Cancel the operation entirely.

Adding Transitions By Dragging 
to Create Overlap
There’s another method you can use to create transitions that makes it easy to create 
transitions while you’re doing drag-and-drop editing by simply overlapping the beginning and 
end of two clips where you want a transition to appear. Just press and hold the Option and Shift 
keyboard modifiers together while you drag a clip or edit to create overlap with another clip. 
You can do this in three ways:

�� Select the In or Out point of a clip, then press and hold Option-Shift down and drag the 
selected edit point to overlap a neighboring clip where you want to create a transition.

Creating a transition by Option-Shift-Dragging an 
edit point to create an overlap between two clips

�� Select a clip, then press and hold Option-Shift down and drag the entire clip to overlap 
a neighboring clip where you want to create a transition.

Creating a transition by Option-Shift-Dragging a whole clip 
to create an overlap between it and another clip
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�� Hold the Option-Shift keys down while you drag a clip from the Media Pool to overlap a 
clip that’s already in the Timeline.

Creating a transition by Option-Shift-Dragging a clip from 
the Media Pool to overlap a clip in the Timeline

Transition Properties in the Inspector
Double-clicking a transition in the Timeline opens that transition’s properties in the inspector. 
Each transition has the following properties you can edit.

�� Duration: The duration of the transition, shown in both seconds and frames.

�� Alignment: A pop-up that lets you choose the transition’s position relative to the 
edit point it’s applied to. Your choices are “End on Edit,” “Center on Edit,” and 
“Begin on Edit.”

�� Video Transition style: A pop-up that lets you change the type of transition; you can 
choose from among all of the transitions that come with DaVinci Resolve by default.

�� Audio Transition style: If an audio transition is simultaneously selected, presents 
a pop-up that lets you change the type of audio transition; you can choose from 
among all of the audio transitions that come with DaVinci Resolve by default. For 
more information about Audio Transitions, see Chapter 25, “Working with Audio in the 
Edit Page.”

Additional properties that are specific to each type of transition appear in another group below. 
Since the Cross Dissolve transition is the most common transition used, its properties will be 
shown as an example.

�� Style: The different Dissolve transitions (Cross Dissolve, Additive Dissolve, etcetera) 
expose this pop-up that lets you choose different ways for the outgoing clip to 
blend into the incoming clip during the dissolve. There are six different options to 
choose from:

Video: A simple linear dissolve; the outgoing clip fades out as the incoming 
clip fades in.

Film: A logarithmic dissolve, simulating film dissolves as created by an optical printer.

Additive: The outgoing and incoming clips are cross faded using the Additive 
composite mode. As a result, the transition seems to brighten at the halfway point.

Subtractive: The outgoing and incoming clips are cross faded using the Subtractive 
composite mode. As a result, the transition seems to darken at the halfway point.

Highlights: The outgoing and incoming clips are cross faded using the Lighten 
composite mode. The lightest parts of each clip are emphasized during this transition.

Shadows: The outgoing and incoming clips are cross faded using the Darken 
composite mode. The darkest parts of each clip are emphasized during this transition.
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�� Start Ratio: Defines the percentage of completion for the transition at its first frame, 
from 0 to 100 percent. Setting the Start Ratio to anything but 0 results in the transition 
immediately appearing at a more fully cross-dissolved state from the very first frame.

�� End Ratio: Defines the percentage of completion for the transition at its last frame. 
Setting the End Ratio to anything but 0 results in the transition never fully dissolving to 
the incoming shot at its last frame.

�� Reverse: Reverses the transition. This parameter is disabled for Dissolve transitions.

�� Ease: A pop-up that lets you apply non-linear acceleration to the beginning, ending, 
or overall duration of a transition. The result is to add inertia to the transition from the 
outgoing clip to the incoming clip, and providing a gentler change from each clip into 
and out of the transition.

In: The outgoing clip lingers as the beginning of the transition dissolves more slowly 
than the end.

Out: The outgoing clip fades away more quickly, as the beginning of the transition 
dissolves more quickly than the end.

In & Out: Both the outgoing and incoming clips make slower transitions at the 
beginning and end of the dissolve, but the very center of the transition is faster 
as a result.

Other types of transitions display properties that are specific to that transition’s particular effect. 
These are described at length in the following section.

Using Transition Curves
You can create even more highly customized transition effects using the transition curve 
associated with each transition you add to the Timeline. Clicking the button at the bottom-right 
corner of a transition in the Timeline reveals a Keyframe Editor, and clicking the Curve Editor 
button in the Keyframe Editor track for the transition reveals the Transition Curve Editor.

A Transition Curve opened underneath a Cross Dissolve transition

The Transition Curve Editor works identically to the Curve Editor you can access from any clip, 
except instead of using the curve to animate image transforms, you use the curve to retime the 
transition. Combined with eased or bezier keyframes at the beginning and end of a transition 
curve, you can create transitions that slowly start and quickly end, quickly start and slowly end, 
or any variation your project requires.
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Methods of editing a Transition Curve:

�� To change the interpolation of a control point: Click the control point you want to edit, 
and then click one of the four bezier interpolation buttons in the Curve Editor title bar. 
Adding bezier handles to a transition control point lets you create an eased transition. If 
you chose an option from the Ease pop-up of the Transition Properties in the Inspector, 
one or both of the transition curve keyframes may already be set to bezier.

�� To adjust a bezier handle: Drag the bezier handle in any direction to alter the curve. 
Whenever you customize bezier handles on a Transition curve, the Ease pop-up of the 
Transition Properties in the Inspector changes to Custom.

�� To add a new control point to a curve: Option-click anywhere on a curve to add a new 
control point.

�� To drag a control point on a curve: Click any control point and drag left or right to 
retime it, and up or down to change the value of the control point. Once you begin to 
move the pointer, the control point is constrained in that direction.

�� To delete a control point from a curve: Right-click a keyframe and choose Delete 
Selected from the contextual menu. You cannot delete the last two control points of a 
transition curve.

�� To turn a curve on and off: Clicking the green dot at the upper left-hand corner of the 
Keyframe Editor lets you turn a transition curve’s effect on and off, without disabling the 
transition. When you turn the keyframes off, the transition defaults to a linear transition 
with no easing.

Organizing Transitions
While DaVinci Resolve provides a wide variety of transitions by default, most editors typically 
only use a subset of these in their day-to-day work. Also, it’s typical to save customized versions 
of a particular transition in order to reuse that specific set of transition settings over and 
over again.

To set a transition or other effect as a favorite in the Effects Library: 

Move the pointer over any transition, and click the star button when it appears to set 
that transition as a favorite. Click any transition’s star to “un-favorite” it. Favorites are 
displayed in the Favorites area of the Effects Library bin list.

To save a Transition Preset for future use:

1	 Add a transition to the Timeline, then double-click it to open it in the Inspector to adjust 
its settings to be the way you need it to be.

2	 (optional) if necessary, open the transition’s Curve Editor and set the type of curve you 
want the transition to have. A customized transition curve will be saved inside of that 
transition’s preset.

3	 Right-click on the transition you want to save, and choose “Create Transition Preset.” 

4	 Type a name for the Transition Preset in the dialog that appears, and click OK. That 
transition is saved to the bottom of the Toolbox Video Transitions area, where you can 
apply it just like any other transition.
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Changing the Standard Transition
Different projects may require different transitions be used as the Standard Transition. 
DaVinci Resolve gives you several tools for dealing with this.

To change the Standard Transition:

Right-click any transition or effect and choose “Set as Standard Transition.” The 
standard transition appears with an orange indicator to the left of its name in the 
Effects Library.

The Effects Library open, showing starred transitions that have been favorited, 
and the standard transition with an orange indicator to the left of its name

To change the standard transition duration:

Open the Editing panel of the User Preferences, and change the “Standard transition 
duration” setting (there are controls for setting the duration in either Seconds or 
Frames). Click Save when you’re finished.

DaVinci Resolve Transitions
The following are transitions that are available within DaVinci Resolve by default, along with the 
parameters that are available for each of them from the Inspector:

Audio Transitions:

Cross Fade +3/–3/0 dB: An audio-only transition that lets you fade from one audio clip 
to another. Three different crossfades let you choose the power of the actual transition 
from one level to the other.

Video Transitions:

�� Additive Dissolve: Style lets you choose what type of cross dissolve you want; 
choices include: Video, Film, Additive, Subtractive, Highlights, Shadows. Start Ratio 
lets you adjust how far along the transition is when it first begins. End Ratio lets you 
adjust how far the transition gets at the very end. The Reverse checkbox reverses the 
direction of the transition.
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�� Arrow Iris: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Offset to center lets you alter the center 
point at which this transition is positioned. Feather is a checkbox that, when turned 
on, uses the Border slider to determine the amount of feathering at the edge of the 
transition. 

Box mode lets you choose one of the following presets:

�� Arrow Head Up

�� Arrow Head Bottom

�� Arrow Head Left

�� Arrow Head Right

�� Band Wipe: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned 
on, uses the Border slider to determine the amount of feathering at the edge of the 
transition. Preset lets you choose one of the following presets:

�� Horizontal

�� Vertical

�� Horizontal Bilinear

�� Vertical Bilinear

�� Barn Door: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned 
on, uses the Border slider to determine the amount of feathering at the edge of the 
transition. Box mode lets you choose one of the following presets:

�� Barn Door Vertical

�� Barn Door Horizontal

�� Blur Dissolve: Horizontal/Vertical Strength sets how much blur is performed in the X 
and Y dimensions during the course of this transition. Start Ratio lets you adjust how 
far along the transition is when it first begins. End Ratio lets you adjust how far the 
transition gets at the very end. The Reverse checkbox reverses the direction of the 
transition.

�� Box: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned 
on, uses the Border slider to determine the amount of feathering at the edge of the 
transition. Box mode lets you choose one of the following options:

�� Upper Left

�� Upper Right

�� Lower Left

�� Lower Right

�� Left Center

�� Top Center

�� Right Center

�� Bottom Center

�� Center Wipe: Color sets the color of the border, if there is one. Border sets the width 
of the border, in pixels, with 0 creating no border. Angle specifies the angle of the wipe 
as it emerges from the middle of the screen. Feather is a checkbox that, when turned 
on, uses the Border slider to determine the amount of feathering at the edge of the 
transition.
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�� Clock Wipe: Color sets the color of the border, if there is one. Border sets the width 
of the border, in pixels, with 0 creating no border. Angle specifies the starting angle 
of the wipe as it spins around the center of the screen. The Clockwise checkbox sets 
the direction of the clock wipe. Feather is a checkbox that, when turned on, uses the 
Border slider to determine the amount of feathering at the edge of the transition.

�� Cross Dissolve: Style lets you choose what type of cross dissolve you want; choices 
include: Video, Film, Additive, Subtractive, Highlights, Shadows. Start Ratio lets you 
adjust how far along the transition is when it first begins. End Ratio lets you adjust how 
far the transition gets at the very end. The Reverse checkbox reverses the direction of 
the transition.

�� Cross Iris: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Offset to Center identifies the center 
point at which the cross wipe begins, as X and Y coordinates on the screen. Feather 
is a checkbox that, when turned on, uses the Border slider to determine the amount of 
feathering at the edge of the transition.

�� Diamond Iris: Color sets the color of the border, if there is one. Border sets the width 
of the border, in pixels, with 0 creating no border. Offset to Center identifies the center 
point at which the diamond-shaped wipe begins, as X and Y coordinates on the screen. 
Feather is a checkbox that, when turned on, uses the Border slider to determine the 
amount of feathering at the edge of the transition.

�� Dip to Color Dissolve: Start Ratio lets you adjust how far along the transition is when 
it first begins. End Ratio lets you adjust how far the transition gets at the very end. The 
Reverse checkbox reverses the direction of the transition. Color lets you choose what 
color the dissolve dips to at the midpoint.

�� Edge Wipe: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Angle specifies the angle of the wipe 
as it moves across the screen. Feather is a checkbox that, when turned on, uses the 
Border slider to determine the amount of feathering at the edge of the transition.

�� Eye Iris: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned 
on, uses the Border slider to determine the amount of feathering at the edge of the 
transition.

�� Heart: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Offset to Center identifies the center point 
at which this circular wipe begins, as X and Y coordinates on the screen. Feather is 
a checkbox that, when turned on, uses the Border slider to determine the amount of 
feathering at the edge of the transition.

�� Hexagon Iris: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Offset to center lets you alter the center 
point at which this transition is positioned. Feather is a checkbox that, when turned 
on, uses the Border slider to determine the amount of feathering at the edge of the 
transition. Box mode lets you choose one of the following presets:

�� Hexagon

�� Hexagon Rotate

�� Non-Additive Dissolve: Start Ratio lets you adjust how far along the transition is when 
it first begins. End Ratio lets you adjust how far the transition gets at the very end. The 
Reverse checkbox reverses the direction of the transition.

�� Oval Iris: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Offset to Center identifies the center 
point at which this circular wipe begins, as X and Y coordinates on the screen. Oval 
Ratio changes the aspect ratio of the oval, making it either wider or taller. Feather is 
a checkbox that, when turned on, uses the Border slider to determine the amount of 
feathering at the edge of the transition.
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�� Pentagon Iris: Color sets the color of the border, if there is one. Border sets the width 
of the border, in pixels, with 0 creating no border. Offset to center lets you alter the 
center point at which this transition is positioned. Feather is a checkbox that, when 
turned on, uses the Border slider to determine the amount of feathering at the edge of 
the transition. Box mode lets you choose one of the following presets:

�� Pentagon Up

�� Pentagon Down

�� Push: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned 
on, uses the Border slider to determine the amount of feathering at the edge of the 
transition. Box mode lets you choose one of the following presets:

�� Push Left

�� Push Right

�� Push Up

�� Push Down

�� Radial Wipe: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned 
on, uses the Border slider to determine the amount of feathering at the edge of the 
transition.

�� Slide: Direction determines whether or not the incoming clip slides in or the outgoing 
clip slides out. Color sets the color of the border, if there is one. Border sets the width 
of the border, in pixels, with 0 creating no border. Feather is a checkbox that, when 
turned on, uses the Border slider to determine the amount of feathering at the edge of 
the transition. 

Box mode lets you choose one of the following presets:

�� Slide, Left-Right

�� Slide, Right-Left

�� Slide, Bottom-Up

�� Slide, Top-Down

�� Slide, Top-Left

�� Slide, Bottom-Right

�� Smooth Cut: A special-purpose transition designed to make short jump cuts in the 
middle of a clip less noticeable. This is done by using optical flow processing to match 
the same features on either side of a cut in order to automatically morph a subject 
from one position to another over the duration of the transition. This effect works 
best on clips such as sit-down interviews and close-up head shots with a minimum of 
background and subject motion, and where the subject’s position on either side of the 
cut is not significantly different. A good example of when Smooth Cut is effective is 
when you’re cutting pauses, partial repeats, filler sounds such as “um” or “you know,” 
or other speech disfluencies out of an interview clip to tighten the dialog, and you want 
to eliminate the little “jump” that occurs at the cut without having to cut away to b-roll. 
Applying a short two or four frame Smooth Cut transition to the edit can make this kind 
of edit invisible, as long as the speaker doesn’t change position significantly during 
the cut. The more motion there is in the background of the shot, and the more the 
speaker changes position, the harder it will be to get a useful result using Smooth Cut. 
Although the default duration for any transition is one second, you’ll find that Smooth 
Cut transitions work much better when they’re short; 2-6 frame Smooth Cut transitions 
often work best to disguise jump cuts.
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�� Spiral Wipe: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned 
on, uses the Border slider to determine the amount of feathering at the edge of the 
transition.

�� Split: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned 
on, uses the Border slider to determine the amount of feathering at the edge of the 
transition.

�� Star: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Offset to Center identifies the center point 
at which this circular wipe begins, as X and Y coordinates on the screen. Feather is 
a checkbox that, when turned on, uses the Border slider to determine the amount of 
feathering at the edge of the transition.

�� Triangle Iris: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Offset to center lets you alter the center 
point at which this transition is positioned. Feather is a checkbox that, when turned 
on, uses the Border slider to determine the amount of feathering at the edge of the 
transition. 

Box mode lets you choose one of the following presets:

�� Triangle Up

�� Triangle Bottom

�� Triangle Left

�� Triangle Right

�� Triangle Left: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned 
on, uses the Border slider to determine the amount of feathering at the edge of the 
transition.

�� Triangle Right: Color sets the color of the border, if there is one. Border sets the width 
of the border, in pixels, with 0 creating no border. Feather is a checkbox that, when 
turned on, uses the Border slider to determine the amount of feathering at the edge of 
the transition.

�� Venetian Blind Wipe: Color sets the color of the border, if there is one. Border sets the 
width of the border, in pixels, with 0 creating no border. Repeat specifies how many 
“blinds” appear within the wipe effect. Angle specifies the angle of this multi-wipe 
effect. Feather is a checkbox that, when turned on, uses the Border slider to determine 
the amount of feathering at the edge of the transition.

�� X Wipe: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned 
on, uses the Border slider to determine the amount of feathering at the edge of the 
transition.
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OpenFX Transitions
If you’ve installed one or more sets of OpenFX plug-ins on your DaVinci Resolve workstation, 
any transitions within those sets will appear in the OpenFX panel of the Effects Library.

OpenFX Transitions in the Effects Library
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Chapter 25

Working with 
Audio 
in the Edit Page 



471

W
o

rk
in

g
 w

ith
 A

ud
io

 in
 t

he
 E

d
it 

P
ag

e
 

P
ar

t 
3 

–
 2

5

Working with Audio in the Edit Page
DaVinci Resolve has a solid set of features for editing, mixing, and mastering audio in your 
programs right in the Edit page. Whether you’re adjusting synced audio for dailies, finessing the 
levels of an edited project you’re assembling, mixing a program for output, or importing and 
laying in audio mix files from the sound designer to output for mastering, DaVinci Resolve has 
Level, Pan, and Channel Assignment controls to control your audio output for both monitoring 
and delivery, automated fader recording at both the track and clip level for mixing, and VST and 
Audio Unit audio filter support for mastering audio tracks and channels using industry-standard 
noise reduction, compression, EQ, and other filters. And, if all that’s not enough for you, you can 
export to Pro Tools in the Delivery page to hand off your program and its audio in a state ready 
for further work.

When you’ve finished doing the editorial audio work in your program, and you want to really drill 
into your program’s audio for detailed audio editing and mixing, you can use the audio-specific 
tools of the Fairlight page. For more information, see Chapter 62, “Using the Audio Page.”

This chapter has the following topics:

Audio in the Edit vs. Fairlight Pages	 473

Compatible Audio Formats	 473

Assigning Audio Channels in the Media Pool	 473

Editing Audio Into the Timeline	 476

Editing Audio Using the Source Viewer	 476

Simultaneous Audio Waveform Display in the Source Viewer	 476

Using Multi-Channel Timeline Tracks	 477

Editing Audio Clips Into the Timeline	 478

Changing Audio Clip Attributes After Editing	 479

Displaying Waveforms in the Timeline	 480

Editing Audio In the Timeline Using In and Out Points	 481

Audio Settings in the Inspector	 483

Setting Clip Levels 	 483

Adjusting Audio in the Inspector	 483

Adjusting Audio in the Timeline	 483

Adjusting Clip Levels Using Keyboard Shortcuts	 484

Clip EQ	 485

Master EQ Controls	 485

Graphical EQ controls	 486

Bands 1 and 4	 486

Bands 2-3	 486
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5Keyframing Audio	 487

Curve Editor Controls for Clip Audio	 487

How to Add and Adjust Audio Keyframes	 487

Audio Fade Handles	 488

Audio Crossfades	 489

The Audio Mixer	 490

Audio Mixer Controls	 491

Disabling Track Audio vs. Muting Tracks	 491

Displaying Audio Meters	 491

Using Audio Filters	 492

Installing Audio Filters	 493

The Fairlight Page	 494

Pro Tools Export	 494
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Audio in the Edit vs. Fairlight Pages
While the Fairlight page provides dedicated audio editing and mixing capabilities that are 
suitable for sweetening the audio of your program once it’s been edited, the Edit page has 
extensive audio capabilities of its own. This enables editors to edit and refine audio clips, set 
levels, and do simple mixes as they assemble the program in the first place. However, once 
things have been edited together, you’re meant to go freely back and forth between the Edit 
and Fairlight page as you refine your work, using whichever environment is most suitable for the 
task at hand.

Compatible Audio Formats
DaVinci Resolve is compatible with WAVE, Broadcast WAVE, AIFF, MP3, AAC (M4A), CAF 
(macOS only), MTS and QuickTime containers using the AC3 audio format, and Enhanced AC-3 
(macOS and Windows) at sample rates including 32, 44.1, 48, 88.2, 96, and 192 kHz.

Assigning Audio Channels 
in the Media Pool
When you first import audio into the Media Pool, it’s a good idea to make sure that whatever 
channels those files contain are assigned correctly before you start editing clips into the 
Timeline. In other words, you want to make sure that stereo files are set to be stereo clips, that 
5.1 and 7.1 files are set to be surround clips, and that multi-channel files are set to expose 
however many channels you want to edit separately in your program. Clip channel assignments 
are made in the Audio panel of the Clip Attributes window.

This is particularly important when clips have more than two channels of audio. For example, 
production sound recordists might record three, six, or even more audio channels, 
corresponding to a variety of microphones on set along with mixdown tracks. In this case, you 
need to define how many of these channels you want to play, and how many items you want to 
appear in the Timeline. 

Mono, stereo, 5.1, and 7.1 clips are handled automatically, but multi-channel clips needing 
custom assignments in the Media Pool should be remapped as necessary using Clip Attributes, 
so that DaVinci Resolve can more easily place incoming audio clips into the correct track of the 
Timeline. You can alter the clip attributes for clips one at a time, or for multiple selected clips at 
once. For more information on these settings, see Chapter 10, “Modifying Clips and 
Clip Attributes.”

Each clip with audio has the following options in the Audio panel of the Clip Attributes window:

The controls available for defining tracks and channels
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�� Channel Format: Defines the relationship between audio tracks and audio channels. 
Select Mono, Stereo,  5.1, 7.1, or Adaptive as appropriate for your clip. The selected 
channel format determines how many default channels appear in the Source Channel 
list below. For multi-channel production audio, Adaptive is probably the best choice.

�� Audio Tracks: Defines how many audio items will appear in the Timeline when this clip 
is edited. Each audio track can be edited independently, if necessary, with separate In 
and Out points.

�� Audio Channels: Defines how many audio channels appear within each track.

How you handle audio in your timeline is up to you. In the case of production audio consisting 
of five channels, four for different microphones plus one mixdown channel, you might use Clip 
Attributes to map all channels to a single track, muting all channels except for the mixdown 
channel.

The Channels controls in the Audio panel of the Clip Attributes window

With this mapping, this audio clip exposes only one item in the Timeline.

A single audio channel exposed in the Timeline

Alternately, you might elect to set these clips up with five separate audio tracks with a 
single audio channel each, in order to expose each channel separately in the Timeline for 
independent editing.
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The Channels controls in the Audio panel of the Clip Attributes window

Editing such a clip into the Timeline results in five linked audio items appearing on five separate 
audio tracks, each of which can be edited separately in the Timeline.

Each channel exposed as a separately editable clip in the Timeline
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Editing Audio Into the Timeline
A separate set of audio tracks contain all of the audio that you edit into the Timeline, as well as 
any stand-alone audio files that might have been imported along with an AAF or XML files.

Editing Audio Using the Source Viewer
Opening an audio-only clip into the Source Viewer, or opening a clip with both video and audio 
and setting the Viewer to Audio Waveform results in a split view, with the complete waveform of 
the entire source clip shown in the top half, and a zoomed-in view of the waveform in the 
bottom half that can be set to zoom from 1x to 50x from the Zoom menu at the upper left-hand 
corner of the Source Viewer. This view makes it easy to drag the box at the top to find the 
section of audio you need relative to the entire clip, and yet still place In and Out points with 
great precision using the scrubber bar below.

This view shows every channel within each track of the current clip.

An audio clip opened into the Source Viewer

You can add markers and set In and Out points for audio clips just as you would for any other 
clip, in preparation for editing.

Simultaneous Audio Waveform Display in the Source Viewer
It’s also possible to edit using audio waveforms even when the Source Viewer is set to Source. 
Two options in the Option Menu let you see a superimposed audio waveform running along the 
bottom of the Viewer, over the video of the currently selected clip.

�� Show Current Frame Audio Waveform: Shows a zoomed-in section of audio that 
scrolls as you play the clip. Useful for seeing dialog and music cues as you play 
through a clip.

�� Show Full Clip Audio Waveform: Shows the audio waveform for the entire source 
media of that clip. The section of audio from the In to Out points you’ve set in the 
Source Viewer are highlighted. Useful for using the audio waveform to navigate 
throughout that clip using the waveform as a reference.
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The Source Viewer with “Show Current Frame Audio Waveform” enabled, 
displaying the audio waveform along the bottom of the image

Using Multi-Channel Timeline Tracks
Multi-channel audio tracks are extremely convenient when you’re dealing with clips that are 
stereo, 5.1, 7.1, or have an arbitrary number of channels that were recorded in the field, as you 
can fit all of these channels as a single clip into a single track, that will be correctly mapped to 
your project’s outputs, and that can be edited conveniently as a single item in the Timeline.

However, there are different types of audio tracks just like there are different types of audio 
clips: Mono, Stereo, 5.1, and Adaptive. While you can edit any kind of audio clip into any kind of 
audio track, all audio channels in excess of the number of audio channels enabled by a 
particular timeline track will be muted. For example, you’re allowed to edit a six-channel 
Adaptive audio clip into a Mono audio track, but only the first channel will play because of the 
way that track is mapped to the mixer outputs.

Because of this, it’s a good idea to organize your timeline such that all clips appear on tracks 
that can accommodate the number of channels they have.

Defining Timeline Audio Track Channels at Creation
When you first create a new audio track, you have to choose what kind of audio track it will be. 
Right-clicking in the bottom audio portion of the Timeline track header reveals a contextual sub-
menu that lets you create one of three different kinds of audio tracks.

�� Mono: Holds a single channel.

�� Stereo: Holds stereo left and right channels. Stereo tracks can be panned.

�� 5.1: Holds the six channels corresponding to a 5.1 surround mix. For broadcast, SMPTE 
specifies Left, Center, Right, Left Surround, Right Surround, and LFE. For cinema 
distribution these tracks are ordered Left, Right, Center, LFE, Surround Left, Surround 
Right, and LFE.

�� 7.1: Holds the eight channels corresponding to a 7.1 surround mix. For broadcast, 
SMPTE specifies Left, Center, Right, Left Surround, Right Surround, LFE, Back Surround 
Left, and Back Surround Right. For cinema distribution these tracks are ordered Left, 
Right, Center, LFE, Left Surround, Right Surround, Back Left Surround, and Back 
Right Surround.
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�� Adaptive: Capable of holding up to 24 audio channels. An adaptive audio track can 
hold clips with different combinations of channels, up to the maximum number of 
channels allowed within that track. The number of channels allowable on a particular 
Adaptive track is user-definable (1–24) at the time that track is created. If you edit a clip 
with more channels into an Adaptive track that was created to hold fewer channels, the 
extra channels are muted.

 Four audio tracks with each type of audio track shown. From the 
top down, Mono, Stereo, 5.1, Adaptive

Changing How Many Channels an Audio Track Has
If you had set up your timeline with one kind of audio track, but you discover you actually need 
a different kind, you can change any audio track’s type at any time. Just right-click anywhere in 
that audio track’s timeline header, and choose an option from the Change Track Type To 
submenu of the contextual menu.

Contextual menu for changing audio track types

Editing Audio Clips Into the Timeline
When you edit a video clip with accompanying audio, or an audio-only clip, into the Timeline, 
what you see depends on how the audio’s internal tracks and channels were defined in the 
Media Pool, using Clip Attributes.

If you’ve defined a clip to expose multiple channels of audio via multiple tracks, you exchange 
the convenience of managing multiple channels of audio as a single item for the freedom to 
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individually edit each channel of audio separately, as individual clips in the Timeline. 
For example, if you’ve been given a multi-channel recording that consists of a two boom 
microphones, two separate lavaliere microphones, and a mix-down track that were recorded 
simultaneously, you can use the Audio Panel of the Clip Attributes window to set that clip’s 
audio up as 5 channel Adaptive audio with 5 tracks containing one channel each. Editing this 
into the Timeline, you end up with five separate audio items appearing in five tracks.

Editing a multi-channel production recording as five separate tracks of audio

This way, when you edit that clip into the Timeline, each audio channel appears as its own clip 
in its own audio track of the Timeline, which can be separately edited so you can edit the scene 
to isolate the best dialog from each microphone.

Editing multi-track audio to isolate the best dialog from each microphone

Changing Audio Clip Attributes After Editing
It’s best to make decisions about which audio tracks and channels are assigned prior to 
beginning editing. This is because once you’ve edited a clip into a timeline, you can’t use the 
Clip Attributes window to edit how many Audio Tracks and Audio Channels are assigned or 
exposed. 
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However, you can use Clip Attributes to change which channels are assigned and/or muted 
within the available Tracks and Channels. For example, if you’re editing clips that have five 
channels of source audio (channels 1 and 2 are a stereo mix and channels 3 through 5 are three 
different microphones), you may have set your synced source clips to have one audio track and 
five audio channels, with channels 3-5 muted. Later you have a few clips that would sound 
much better if you only used channel 4, which is the isolated lavaliere microphone for that actor, 
so you can select those clips and use the Audio panel of Clip Attributes to mute all channels but 
channel 4.

If, for whatever reason, you need to expose more audio tracks in the Timeline than you 
originally set an audio clip to use, you can do the following.

To re-edit an audio clip to expose more audio tracks than were originally available:

1	 Right-click the clip you want to change the audio track mapping of in the Timeline, and 
choose Find in Media Pool from the contextual menu.

2	 Right-click that clip in the Media Pool and choose Clip Attributes from the contextual 
menu.

3	 Open the Audio panel of the Clip Attributes dialog, and choose how many audio tracks 
and audio channels you want to set that clip up with. Click OK.

4	 Once that’s done, edit the changed audio clip from the Media Pool to the Timeline 
to replace the original clip using whichever method makes sense.

Displaying Waveforms in the Timeline
The Timeline View options palette lets you turn Audio Waveform display on and off via a 
checkbox. If the audio waveform is turned off, then all audio channels are minimized.

The Audio Waveform display option in the 
Timeline View pop-up

While a single averaged audio waveform representing all the channels in that clip is shown by 
default, you can switch any clip to seeing each individual waveform in a vertical stack by 
right-clicking any audio clip and choosing Display Individual Audio Channels.

Enabling the display of multiple channel waveforms in the Timeline
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Whenever you cut an audio clip, you cut all audio channels with it. Audio channels that are 
embedded within a single track cannot be individually edited.

Editing Audio In the Timeline 
Using In and Out Points
Audio clips can be edited using all of the commands and tools available for video clips. 
However, it’s good to know that one of the most common techniques of editing audio in 
other environments is available in DaVinci Resolve, and that is the ability to identify a range of 
audio to cut, copy, or delete using Timeline In and Out points, so that you can easily eliminate, 
move, or duplicate partial sections of audio without having to use the Razor Edit or Split Clip 
commands.

To delete a section of audio using In and Out points:

1	 Set In and Out points in the Timeline to identify the range of audio you want to 
eliminate. If necessary, turn off the auto select controls of tracks to omit overlapping 
audio clips you don’t want to delete from this operation.

Setting In and Out points to identify a range of audio to delete

2	 Press the Backspace key to delete the section of audio and leave a gap, or press the 
Forward Delete key to delete the section of audio and ripple the Timeline to close 
the gap.

Deleting the audio using the Backspace key to leave a gap
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To copy a section of audio using In and Out points:

1	 Set In and Out points in the Timeline to identify the range of audio you want to copy. 
If necessary, turn off the auto select controls of tracks with overlapping audio you don’t 
want to copy; you can Option-click the auto-select control of the audio track you’re 
copying from to solo it, and you can Shift-click any video track’s auto-select control 
to turn them all off. In this example, we’re copying some background ambience to 
continue building an ambience track.

Setting In and Out points to identify a range of audio to copy

2	 Press Command-C to copy that section of audio.

3	 Press Option-X to clear the Timeline In and Out points, and move the playhead to 
where you want to paste the copied section of audio.

4	 Press Command-V to paste the copied audio. If you’re looping a section of audio, you 
can paste many times to loop what you’ve copied.

Pasting the background ambience several times to loop it
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Audio Settings in the Inspector
Each clip has some simple audio-related parameters in the Audio panel of the Inspector.

�� Volume: Each clip has a single volume control that corresponds to the volume overlay 
over each audio clip.

�� Equalizer: Each clip also has a four-band EQ, complete with low-pass, high-pass, and 
parametric settings for fine tuning and problem-solving audio issues at the clip level.

Additionally, when you apply other audio plug-ins from the Audio FX panel of the Effects 
Library, additional parameters and controls are exposed (covered towards the end of this 
chapter).

Setting Clip Levels 
Each audio clip, or audio item in the case of audio clips with linked audio on multiple tracks, has 
its own Volume level. This means that audio clips with multiple channels share a common 
Volume setting. There are several ways you can adjust these levels simply.

Adjusting Audio in the Inspector
Each clip has individual Level parameters that are accessible in the Audio panel of the Inspector 
when one or more audio clips are selected.

The Volume and Pan parameters available for 
audio clips in the Inspector

Selecting an audio clip in the Timeline and adjusting its Volume or Pan only alters that clip, 
which lets you set basic levels for individual clips in your program. The Volume control affects 
every channel within that clip simultaneously. 

If you select multiple clips in the Timeline, then adjusting the Volume or Pan sliders or virtual 
sliders for all of them simultaneously will make a relative adjustment to all of the clips, 
preserving their offsets from one another. If you want to set all clips to the same level, then 
making a numeric adjustment will set all selected clips to the same absolute level.

Adjusting Audio in the Timeline
Each clip (or item) of audio in the Timeline has a Volume overlay that lets you set that clip’s level 
by simply dragging it up or down with the pointer. This overlay corresponds to the Volume 
parameter in the Inspector.



484

W
o

rk
in

g
 w

ith
 A

ud
io

 in
 t

he
 E

d
it 

P
ag

e
 

P
ar

t 
3 

–
 2

5

Dragging a Volume overlay to adjust the clip level

If you want to adjust the Pan of that clip in the Timeline, you need to click the Curve Editor 
button at the bottom right-hand corner of the audio clip, which opens the Audio Curve Editor. 
You can then use the Parameter pop-up at the upper left-hand corner of the Curve Editor to 
turn on the Pan checkbox and select the Pan overlay. This overlay can then be dragged up or 
down to adjust the pan of the clip.

Showing the Pan overlay in the Curve Editor

The Audio Curve Editor can also expose curves for the various parameters of the clip-based EQ 
that’s available.

Adjusting Clip Levels Using Keyboard Shortcuts
You can also adjust the Volume of selected clips using keyboard shortcuts, even while the 
Timeline is playing. There are several ways you can set this up.

�� To adjust just one clip: Select that clip, and choose Clip > Increase Audio Level 1dB 
(Option-Command-Plus) or Clip > Decrease Audio Level 1dB (Option-Command-Minus).

�� To adjust any clip at the position of the playhead: Turn on Timeline > Selection 
Follows Playhead (Command-W) so that whichever clip intersects the playhead 
becomes selected, and then choose Clip > Increase Audio Level 1dB (Option-
Command-Plus) or Clip > Decrease Audio Level 1dB (Option-Command-Minus).
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�� To adjust multiple clips all together: Select all of the clips you want to adjust, all 
at once, and choose Clip > Increase Audio Level 1dB (Option-Command-Plus) or 
Clip > Decrease Audio Level 1dB (Option-Command-Minus). If the clips you select 
have differing Volume levels, these differences will be maintained as you make 
your adjustments.

Clip EQ
Each audio clip in the Timeline has a four band equalizer that has both graphical and numeric 
controls for boosting or attenuating different ranges of frequencies within that clip, before it 
even gets to the EQ built into the mixer. Each band has controls for the filter type (Bell, Lo-Shelf, 
Hi-Shelf, Notch), Frequency, Gain, and Q-factor (sharpness of the band), with the available 
controls for each band of EQ changing depending on the filter type.

When a channel strip’s EQ is enabled, the EQ button displays the equalization curve that’s 
being applied. This indicator cannot be adjusted; you must open the EQ window to make 
modifications.

The channel strip’s EQ indicator, (Left) EQ is at detente, (Right) EQ is adjusted

Master EQ Controls
The Equalizer window has the following overall controls:

�� Enable button: Turns the overall EQ effect off and on, without resetting the controls.

�� Reset button: Resets all controls of the EQ window to their defaults.

TIP: An additional pair of commands in the Clip menu, Increase/Decrease 
Audio Level 3 dB, are available, but unmapped to keyboard shortcuts by 
default.
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Graphical EQ controls
A graph at the top shows a curve with handles that correspond to each of the enabled EQ bands 
listed below. You can drag any numbered handle to boost or attenuate the range of frequencies 
governed by that band, using whatever type of equalization that band has been set to.

The EQ graph with user-draggable handles

Dragging the numbered handles on this graph in turn modifies the parameters of the 
corresponding band, and changing each band’s parameters will also alter the EQ graph, which 
serves the additional purpose of providing a graphical representation of the equalization being 
applied to that track.

Bands 1 and 4
The outer two sets of band controls let you make high-pass and low-pass adjustments, if 
necessary.

�� Band enable button: Turns each band of EQ on and off.

�� Band filter type: Bands 1 and 6 can be switched among four specific filtering options 
for processing the lowest or highest frequencies in the signal. These include (from top 
to bottom) Hi-Shelf, Hi-Pass, Lo-Pass, and Lo-Shelf.

�� Freq: Adjusts the center frequency of the EQ adjustment.

�� Gain: Adjusts the amount by which the affected frequencies are affected. Negative 
values attenuate those frequencies, while positive values boost those frequencies.

Bands 2-3
The middle two sets of band controls let you make a wide variety of equalization adjustments.

�� Band enable button: Turns each band of EQ on and off.

�� Band filter type: Bands 2–5 can be switched among four different filtering options 
(from top to bottom) Lo-Shelf, Bell, Notch, and Hi-Shelf.

�� Frequency: Adjusts the center frequency of the EQ adjustment.

�� Gain: Adjusts the amount by which the affected frequencies are affected. Negative 
values attenuate those frequencies, while positive values boost those frequencies.

�� Q Factor: Adjusts the width of affected frequencies. Lower values include a wider 
range of frequencies, higher values include a narrower range of frequencies.
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Keyframing Audio
There are two ways you can keyframe audio in the Edit page. You can use each audio clip’s 
Volume Curve in the Timeline, or you can use the keyframe controls in the Inspector to animate 
the Volume parameter of individual clips as you would any other clip attribute, fading the level 
up or down, panning from left to right, or dynamically changing any one of a host of 
filter controls. 

For more information on keyframing in the Inspector, see Chapter 31, “Keyframing.” 
Any keyframes you create using the Keyframe controls of the Inspector automatically appear on 
the Volume Curve of that audio clip in the Timeline.

Curve Editor Controls for Clip Audio
Each audio clip in the Timeline appears with a Curve control overlaid on top of it, that by default 
starts out completely flat. Similar to such controls found in other applications, the Level Curve 
lets you alter each clip’s volume, either overall, or dynamically using keyframes.

Volume curves adjusting the level of a clip’s audio in the Timeline

Additionally, you can click any clip’s Audio Curve Editor button, at the bottom right-hand corner 
of each audio clip, to open an audio-specific Curve Editor with which you can keyframe not just 
Volume, but Pan, and the parameters of any audio filters you might have applied to that clip.

The button for opening an  
audio clip’s Curve Editor 

A pop-up at the upper left-hand corner of the Audio Curve Editor lets you choose which audio 
parameters you want to expose for editing and keyframing. This includes the individual 
parameters of any audio filters you’ve applied to that clip, which appear in submenus 
corresponding to each filter you’ve applied. When you’re finished using the clip Audio Curve 
Editor, you can click the close button at the bottom right of the audio clip to hide it.

How to Add and Adjust Audio Keyframes
Mixing audio by adding and adjusting individual keyframes can be a fast and effective way of 
balancing clip levels with one another, fixing level problems within a particular clip, or even 
creating simple mixes (although the mixing capabilities of the Fairlight page are considerably 
more robust). When manually editing any audio parameter curve, you can use the following 
procedures.
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Methods of adjusting different audio curves using the pointer:

�� To adjust any curve segment: Position the pointer between any two keyframes, 
directly on top of the curve segment you want to raise or lower, and when the move 
cursor is displayed, click and drag up to raise the level, or down to reduce the level.

�� To add keyframes to the level curve: Hold the Option key down and click the curve 
to place a keyframe at that frame. You must add at least two keyframes to create an 
automated change in volume.

�� To adjust any keyframe: Move the pointer over a keyframe so that the four-way 
cursor appears, and then click and drag in the intended direction of adjustment, 
either vertically to change the volume of the clip at that frame, or horizontally to move 
the keyframe to a different point in time. Once you start dragging a keyframe into 
a particular direction, keyframe movement is constrained in that direction until you 
release that keyframe.

�� To change the interpolation of a keyframe: Click the keyframe you want to edit, and 
then click one of the four bezier interpolation buttons at the top of the Curve Editor.

�� To adjust a bezier handle: Drag the bezier handle in any direction to alter the curve.

�� To delete keyframes: Select any keyframe on a curve, and press the Delete key to 
make it disappear.

Audio Fade Handles
When you position the pointer directly over an audio clip, a pair of Audio Fade handles appear 
at the In and Out points. Dragging each of these handles towards the center of the clip lets you 
fade in the clip volume at the beginning of the clip, and fade out the clip volume at the end of 
the clip.

Audio Fade handles at either end of an audio clip

Once you’ve created a fade effect, you can adjust the curve of the fade by dragging the handle 
that appears right on top of the fader curve. Dragging the handle up and down affects the angle 
of the curve, and dragging the handle left and right affects the shape of the curve. In this way, 
you can create all manner of fade effects.

NOTE: When you import a Final Cut Pro X project, the fade handles for each clip 
automatically import as well.
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Adjusting the curve of the fade

Fade effects can be created and edited on both the Edit and Fairlight pages.

Audio Crossfades
You can add Cross Fade transitions to any edit point between two overlapping audio clips, the 
same way you’d add video transitions, by dragging and dropping from the Effects Library, by 
right-clicking an edit and choosing an option from the contextual menu, or by selecting an audio 
edit point and choosing Timeline > Add Audio Only Transition (Shift-T).  

Cross Fade transitions fade the volume of the outgoing clip down while simultaneously fading 
the volume of the incoming clip up, letting you create a smooth aural transition between two 
audio clips.

An audio Cross Fade transition applied between two clips

You can double-click a Cross Fade transition to open it into the Inspector, revealing the 
following parameters:

�� Duration: The duration of the transition, shown in both seconds and frames.

�� Alignment: A pop-up that lets you choose the transition’s position relative to the 
edit point it’s applied to. Your choices are “End on Edit,” “Center on Edit,” and 
“Begin on Edit.”

�� Transition style: For Cross Fade transitions, there is only one style available.

�� Fade In/Fade Out levels: There are three options that affect the incoming and outgoing 
halves of the Cross Fade effect independently. 0dB applies a linear fade. +3dB applies 
a boosted curve; when applied to both Fade In and Fade Out, this can compensate 
for diminished levels in the middle of a Cross Fade. -3dB applies an attenuating curve, 
which deliberately lowers the level of the Cross Fade.

Crossfades can be created and edited on both the Edit and Fairlight pages.
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The Audio Mixer
The Audio Mixer on the Edit page is a simplified version of the Mixer on the Fairlight page, 
designed to provide a streamlined set of graphical controls you can use to set basic track 
levels, pan stereo audio, and mute and solo tracks, while you work.

To open the Audio Mixer, do one of the following:

Click the Mixer button on the interface toolbar.

The Audio Mixer exposes a set of channel strips with controls that correspond to the tracks in 
the Timeline, one for each track, plus (by default) a Main 1 that lets you adjust the overall level of 
the mix. Each channel strip’s controls affect the level and panning of every single clip on 
that track.

The Audio Mixer, with four channel strips 
corresponding to the four tracks in the Timeline

NOTE: You cannot record automation in the Edit page. Comprehensive mixing controls 
with full automation recording are found in the Fairlight page.
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Audio Mixer Controls
Each track’s channel strip has the following controls:

�� Track Color: Each track can be differently color-coded to help you keep organized. 
These colors also appear in the timeline track header and the Fairlight page.

�� Track Number: The number of the timeline audio track corresponding to each channel 
strip appears here.

�� Pan control: Lets you pan a Mono channel’s audio from left to right, or invert a Stereo 
channel’s left and right audio channels, or do surround mixing.

�� Name: The name of the audio track that channel strip corresponds to. If you’ve edited 
the audio track names in the Timeline, those names will appear here. Double-clicking a 
channel strip names toggles between your custom track name and the number of each 
audio track in the Timeline. You can also choose whether or not to show track names in 
the Mixer by choosing View > Use Track Names in Audio Mixer.

�� Solo: Mutes all tracks other than ones that are soloed.

�� Mute: Disables that audio track.

�� dB: Shows you the volume, in decibels, that track is currently set to.

�� Fader: Each track’s vertical fader can be dragged with your mouse or other pointing 
device to adjust the volume of that track and perform automation recording. Dragging 
up increases volume, dragging down decreases volume.

�� Audio meters: Audio meters to the right of each fader display the audio volume of 
all channels on that track during playback. Each channel strip has individual meters 
corresponding to the number of channels that track has been set to accommodate. 

Disabling Track Audio vs. Muting Tracks
When you use the mute or solo controls of the Audio Mixer, track audio is disabled during 
playback. However all muted (or non-soloed) tracks are re-enabled for output to tape or 
rendering as file-based output when you use the controls in the Deliver page. If you want to 
disable tracks for output, you can use the Enable Track button, in the track header of the 
Timeline in the Edit page or the Deliver page, to turn any tracks off that you don’t want to output.

Displaying Audio Meters
Clicking the Mixer button in the interface toolbar of the Edit page opens up the Mixer by default, 
but you can choose Audio Meters from the Mixer’s Option menu to display simple audio meters 
to the right of the Timeline that let you monitor the level of the Master mix during playback. 
The audio meters are capable of displaying however many channels you’ve defined as your 
output format.
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Using Audio Filters
On Mac OS X and Windows, DaVinci Resolve supports the use of third-party VST audio 
plug-ins. On Mac OS X, DaVinci Resolve supports Audio Unit (AU) audio plug-ins. Once you 
install these effects on your workstation, they appear in the  Audio FX panel of the Effects 
Library. 

Audio filters in the Effects Library

Audio plug-ins let you apply effects to individual audio clips or entire tracks worth of audio, to 
add creative qualities such as echo or reverb, or to take care of mastering issues using noise 
reduction, compression, or EQ.

Methods of applying Audio Filters to clips in the Edit Page:

�� To apply an audio filter to a clip: Drag any filter from the Audio FX panel of the Effects 
Library onto the clip in the Timeline you want to apply it to.

�� To apply an audio filter to multiple clips: Select all of the clips you want to apply an 
audio filter to, then drag any filter from the Audio FX panel of the Effects Library onto 
any of the selected clips.

To edit a clip’s audio filters:

Select that clip and open the Inspector. All audio filters applied to that clip appear 
under the volume and pan controls, with that filter’s controls appearing directly in the 
Inspector.

Many VST and Audio Unit audio filters have a custom user interface that makes it much easier 
to manipulate that filter’s controls. These can be opened from within DaVinci Resolve.
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The custom audio filter interface for Izotope RX4

To expose a filter’s custom controls: 

Click the Custom Control button (the button to the right of the trash can). The custom 
controls appear in a floating window. When you’re finished adjusting the custom 
controls, close the window.

The button for opening a filter’s custom control

Methods of working with audio filters in the Inspector:

�� To disable or re-enable a filter: Click the toggle button at the far left of each filter’s 
title bar.

�� To remove a filter: Click the Trash Can button.

Once applied to a clip or track, audio filters can also be keyframed or automated just like 
volume and pan settings, to create dynamic audio effects that change over time.

Installing Audio Filters
VST effects aren’t installed in a standard location, so it may sometimes be necessary to add a 
newly installed directory of VST plug-ins that you’ve just installed on your system. To help you 
deal with this, the Audio Plugins panel of the System Preferences window has a list that lets you 
manually add and remove VST plug-in directories, if necessary. 

Once you’ve added one or more VST directories to the list, a second list underneath shows all 
audio plug-ins that are available within these directories. Each plug-in on the list has a 
checkbox that shows whether or not it’s currently enabled. Any VST plug-ins that cause DaVinci 
Resolve to crash while loading them during startup will be automatically disabled. You can use 
this list to see which plug-ins have been disabled, for troubleshooting purposes, and to 
reenable such “blacklisted” plug-ins, by turning their checkboxes back on.
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The Fairlight Page
The audio controls of the Edit page are geared more towards simple mixing to have sensible 
levels as you work putting a program together. For comprehensive audio sweetening, mixing, 
automation, and mastering controls, the Fairlight page is only one click away.

Pro Tools Export
It bears mentioning that, if the audio editing, mixing, and effects capabilities of DaVinci Resolve 
aren’t enough for you to take care of the audio in your program, you can export an AAF with 
audio and a reference movie to Pro Tools using the Deliver page. The resulting media can be 
handed off to a Pro Tools-based audio facility to be worked on by a dedicated team of audio 
specialists, who will most likely output a stereo or 5.1 mix file that you can then reinsert in the 
Timeline you’re using to master the final output of your program.

For more information on exporting in the Deliver page, see Chapter 73, “Using the 
Deliver Page.”
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Chapter 26

Media 
Management 
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Media Management
Media Management in DaVinci Resolve refers to operations that let you copy, move, or 
transcode the media that’s linked to clips in your timeline, with the option to eliminate unused 
media in the process. Even though Media Management is only available in the Media page, it’s 
very typical that it be used to consolidate media from an edited timeline, or from a project 
nearing completion, so it’s presented here in the editing section.

What is Media Management in DaVinci Resolve?	 497

File Formats Compatible with Media Management	 497

Using Media Management	 498

Options in the Media Management Window	 501

Options for Transcode Only	 502

File Naming When You Consolidate Media	 502
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What is Media Management 
in DaVinci Resolve?
If you’ve edited a program within DaVinci Resolve, you can use the Media Management 
command to take care of a variety of tasks, including but not limited to:

�� Moving all clips used in a project to a specific storage location.

�� Creating a duplicate of your project’s clips that eliminates unused media in preparation 
for handing the media off to another facility.

�� Transcoding all clips in a timeline to another format while eliminating unused heads and 
tails.

For example, if you’re preparing to export a project to hand off to another DaVinci Resolve user 
somewhere else, or even an XML or AAF to give to someone using a completely different NLE 
or finishing application, you can use Media Management in DaVinci Resolve to consolidate and 
relink the media used by the timeline you’re handing off, so the exported project or timeline 
references a smaller set of media.

Even if you’re not handing a project off, if you’ve ingested an enormous amount of source media 
into a project, and after the majority of the editing decide that you want to create a consolidated 
set of the media you’re using in order to lighten the project’s load in the Media Pool, you can 
create a duplicate of the media to reconform to, omitting unused clips and trimming the unused 
heads and tails of the clips you are using in the process.

But Media Management isn’t just useful for projects you’ve edited in DaVinci Resolve. 
For example, if you’re importing a project from another application and you’ve been given an 
enormous amount of source media to conform to, you may be hesitant to copy all of it to your 
accelerated storage volume, since (a) most of it is probably unused by the project file you’ve 
been given, (b) it’ll take forever to copy from the cheap USB 2 hard drive they’ve given you, and 
(c) it will clog up your local storage, taking valuable space away from other projects. In this case, 
you can use the Media Management to copy a reduced set of media files consisting of only the 
clips used in the current timeline of the Edit page.

File Formats Compatible 
with Media Management
No matter what you use if for, Media Management is designed to work with all video formats 
that are have decode support within DaVinci Resolve, and is capable of outputting a few more 
formats than the Deliver page can. Compatible formats include but are not limited to:

�� QuickTime

�� MXF

�� R3D

�� Image-based raw media formats including CinemaDNG raw and Alexa raw

�� DPX, EXR, JPEG 2000, TIFF, Cineon, and other compatible image sequence formats

�� AVI

The “trim unused media” options of the Copy or Move operations are not compatible with clips 
that use codecs employing temporal compression, such as H.264, or for any format for which 
DaVinci Resolve lacks encoding support. If you’re trying to trim media in a Media Management 
operation for a project containing untrimmable media formats, the full media files will be moved 
or copied, instead.
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Using Media Management
Using Media Management is simple. 

To media manage clips and timelines in a project you’ve created:

1	 Select the items you want to media manage, either clips or one or more Timelines.

2	 Choose File > Media Management, and the Media Management window appears.

Media Management Window

3	 Choose the scope of the Media Management operation, shown at the top of the 
window. You can choose to affect the Entire Project, only one or more Timelines, or 
only Clips. What you had selected prior to opening the Media Management window 
affects the scope that is selected when you open this window, but it doesn’t limit to 
operation to only the selected items. So, if nothing was selected in the Media Pool, 
then “Entire Project” is automatically highlighted. If any clips were selected, then 
“Clips” is highlighted automatically. If any Timelines were selected, then “Timelines” is 
highlighted. However, if for whatever reason the wrong option is highlighted, you need 
only click the option you want to select it instead.

Media Management scope options
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4	 Next, choose which operation you want to perform:

�� Copy: Creates duplicates of all media associated with clips or timelines at 
the destination.

�� Move: Relocates all media associated with clips or timelines to the destination, 
removing it from the original locations.

�� Transcode: Creates duplicates of all media associated with clips or timelines in a 
new format that you specify; all transcoded clips are written to the same destination.

Media Management operations

5	 Click the Browse button and use the File Destination dialog to choose a location for 
the managed media to be written. The file path of this location appears in the Media 
Destination field.

6	 Choose the options associated with the operation you selected. If you choose to 
media manage Timelines, then a Timeline Selection option lets you choose which 
Timelines you want to include in this operation. Additional options for advanced users 
can be revealed by clicking “More options.” The current size of the selected media is 
listed below, alongside an estimate of the size of the media after the operation you’ve 
selected. Depending on which options you select, the estimate may be larger or 
smaller, but this will show you if you need to change the selected options to achieve a 
more desirable final size.

Media Management options shown for copying trimmed 
media from a specific timeline

7	 When you’ve finished choosing options, click Start. A progress bar appears 
showing you how long the operation will take.

The following workflow illustrates how you can use Media Management to cut down the amount 
of media you need to deal with when you’re conforming a project imported from elsewhere, and 
you’ve been given far more media then you actually need, because you only need what’s 
actually in the timeline you’re importing.

To use Media Management to create a consolidated duplicate of 
media for a project you’re conforming:

1	 Connect the portable drive containing the media to be conformed to your workstation.

2	 Import the AAF or XML project file you were given into the Edit page, and conform it to 
the media on the portable drive you connected in step 1. You’re only doing this to identify 
what clips you need to Media Manage, not because you’ll be working off that volume.
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3	 Choose File > Media Management. The Media Management window appears.

4	 Choose Timelines at the top of the window, and then open the Timeline selection 
section and turn on the checkbox of the timeline you want to consolidate the media for.

5	 Click the Browse button and choose the volume you want to write the 
consolidated media to.

6	 Choose the following options for consolidating the media. For this operation, you’ll want 
to enable:

�� Click the Browse button, and choose the accelerated storage volume you’re using for 
all media you’re using with DaVinci Resolve.

�� Choose the “Timelines” Media Management scope, if it’s not selected already, to 
manage all media from the selected timeline.

�� Choose “Copy” to make a duplicate of the media from the portable storage volume to 
your accelerated storage.

�� Choose “Copy and trim used media keeping 12 frame handles” if you’re comfortable 
with 12 frame handles.

�� Open More Options and turn on “Consolidate multiple edit segments into one media 
file” if you don’t mind having larger media files that preserve the relationship of what 
clips come from which single media files. This can make grading simpler later on.

�� Turn on “Relink to new files” to automatically relink the timeline you’ve selected to the 
new media that’s being generated.

The Consolidate dialog lets you choose how and where to copy the 
trimmed media (the Timeline Selection options are scrolled offscreen)

7	 When you’re done choosing these settings, click Start. A progress bar appears showing 
you how long the operation will take.

A subset of media used by that timeline is copied to the specified directory, and is 
automatically relinked to the timeline and clips in the Media Pool. You are now ready to 
continue working on the project.
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Options in the Media 
Management Window
The different Media Management operations offer different options.

�� Copy/Move/Transcode all media: (Not available for Timelines) Choosing this option 
copies the full amount of source media for every single clip in the project.

�� Media Destination: Click the Browse button to choose a destination to which to copy 
the managed media. To create a new directory, right-click a Volume icon in the File 
Browser list, choose New Folder, type a name into the resulting dialog, and click OK.

�� Timeline selections: If you’ve selected the Timelines mode of media management, you 
can open the Timeline Selection controls and turn on the checkbox by each timeline 
with media you want to include.

�� Copy/Move/Transcode all media: Copies all media available to that operation.

�� Copy/Move/Transcode only used media files: Only copies media files for clips that are 
used in a timeline, and copies them in their entirety.

�� Copy/Move/Transcode and Trim used media keeping x frame handles: Only copies 
media files that are used in a timeline, but eliminates unused heads and tails except for 
user-specified handles.

�� Consolidate multiple edit segments into one media file: (found by opening more 
options) This option only becomes available if you’ve selected “Copy and trim used 
media…” If multiple clips in a timeline come from the same media file, then a single 
consolidated media file will be generated that contains all frames from all of these 
clips, along with whatever additional frames lie between them. Even though this 
option results in more media being copied or moved, it’s extremely useful if you’re 
consolidating media that you want to grade using the automatic grade linking of remote 
versions, as this preserves the original relationship between each Timeline clip and the 
source media file it’s from.

�� Preserve folder hierarchy after x levels deep:  (more options) Retains a user-specified 
depth of the original directory structure used by a clip’s corresponding source 
media file, recreating it when rendering new files for output. The number you select 
determines how many levels of subdirectories DaVinci Resolve will automatically create 
within the currently specified “Render job to” directory to match the path used by the 
source files. Defaults to 0, which creates no matching subdirectories. The number of 
path levels is defined relative to the head of each media file path.

�� Relink to new files: (Appears for the Copy operation only) Relinks the selected clips 
and/or timelines to the new media you’ve created by copying, wherever you’ve copied 
it to.

�� Delete unused media: (Appears for the Move operation only) Moves all unused media 
to your file system’s trash when you perform a Move operation. It’s up to you to do the 
final deletion of the media being discarded, so proceed with caution.
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Options for Transcode Only
The following options appear in the “More Options” area only when Transcode is the selected 
Media Management operation.

�� Video format: Choose the video format to which you want to transcode. The format you 
select determines which codecs and other options will be available to choose from.

�� Codec: A pop-up menu listing every codec that’s available for the currently selected 
Video Format.

�� Compression quality: Disabled for certain formats. Lets you choose the level of 
compression quality that’s used, if available.

�� Render at source resolution: A checkbox that lets you transcode each clip at the frame 
size of the original media file, rather than at the shared resolution selected below.

�� Resolution: A pop-up menu lets you choose a specific resolution to transcode to.

�� Frame rate: Depending on the frame rate of the original media files, this pop-up menu 
lets you choose a compatible frame rate that you can transcode to. For example, 
if the source media frame rate is 24 fps, you can choose between 23.98 and 24 in 
this pop‑up.

�� Audio format: Choose the audio format you want to transcode all audio channels to.

�� Render: Choose how many audio channels you want to transcode. You can also 
choose “Same as source” if you want to transcode each clip with the same number of 
channels as its source media file.

�� Audio bit depth: Choose the bit depth that you want to transcode the audio to.

File Naming When You 
Consolidate Media
When you’re media managing clip-based formats like QuickTime or MXF, if the “Trim Used 
Media” option is on, and the “Consolidate Multiple Edit Segments Into One Media File” 
checkbox is off, then timelines that use multiple clips derived from the same media file will 
generate multiple trimmed media files. To prevent these files from overwriting one another, 
additional characters are appended to each trimmed media file coming from the same source; 
which characters are used depends on the video format.

�� For DPX files, _0, _1 

�� For R3D files, _S000.RDC, _S001.RDC

�� For QuickTime files: _S000.mov, _S001.mov


